Contents

Introduction 7

About Parallels Workstation ................................................................. 7
What's New in This Version ................................................................. 8
About This Guide ............................................................................. 8
Getting Help .................................................................................. 9

Parallels Virtual Machines 10

Virtual Machine Technology Overview ........................................... 10
Intel Virtualization Technology (VT-x) and AMD-V Support .......... 11
Virtual Machine Hardware ............................................................... 12
Supported Guest Operating Systems ............................................. 13
Virtual Machine Files ..................................................................... 15
Support of Virtual and Real Disks .................................................... 16
   Hard Disk Images ........................................................................ 16
   CD/DVD Discs and Images ......................................................... 17
   Floppy Disks and Floppy Disk Images ........................................ 17

Installing Parallels Workstation 18

System Requirements .................................................................... 18
   Hardware Requirements .......................................................... 18
   Software Requirements .......................................................... 19
Installing Parallels Workstation in Windows ................................. 20
   Parallels Workstation for Windows: Step-by-Step Installation .... 20
   Starting Parallels Workstation ............................................... 26
   Activating Parallels Workstation in Windows .......................... 26
   Uninstalling Parallels Workstation in Windows ...................... 27
Installing Parallels Workstation in Linux ...................................... 27
   Parallels Workstation for Linux: Step-by-Step Installation ....... 28
   Starting Parallels Workstation ............................................... 29
   Activating Parallels Workstation in Linux ............................... 29
   Uninstalling Parallels Workstation in Linux ............................ 32

Updating Parallels Workstation 33

Updating Parallels Workstation in Windows .................................. 33
   Auto-Updating Parallels Workstation in Windows ................. 34
   Update Wizard in Windows ..................................................... 34
Updating Parallels Workstation in Linux .................................... 38
   Auto-Updating Parallels Workstation in Linux ..................... 39
   Update Wizard in Linux ....................................................... 39
   Installing an Update ............................................................ 43
# Contents

## Interface Basics
- Main Window ................................................................................................................... 46
- Startup Options Dialog ........................................................................................................ 47
- Property Page ..................................................................................................................... 49
- Console View ..................................................................................................................... 51
- Configuration Editor ......................................................................................................... 53
- Toolbar ................................................................................................................................ 54
- Status Bar .......................................................................................................................... 54
- Text Size ............................................................................................................................. 55
- About Parallels Workstation Window .................................................................................. 56
- Making Screen Shots ......................................................................................................... 58

## Creating a Virtual Machine
- Creating Virtual Machine Configuration ............................................................................. 59
  - New Virtual Machine Wizard .......................................................................................... 59
  - Typical Configurations ...................................................................................................... 62
  - Creating Typical Virtual Machine .................................................................................... 63
  - Creating Custom Virtual Machine ................................................................................... 65
- Installing Guest OS ............................................................................................................. 72
  - Installing a Guest Operating System ................................................................................ 73
  - Reinstalling or Upgrading the Guest OS ........................................................................... 74
- Configuring X Window System in FreeBSD Guest OS ......................................................... 75
- Installing Parallels Tools ..................................................................................................... 76
  - Parallels Tools Overview .................................................................................................. 77
  - Parallels Tools Availability .............................................................................................. 78
- Installing Parallels Tools in Windows Guest OS ................................................................. 79
- Installing Parallels Tools in Linux Guest OS ...................................................................... 82
- Installing Solaris Network Driver ....................................................................................... 83
- Installing OS/2 and eComStation Tools ............................................................................. 85
- Upgrading Parallels Tools .................................................................................................. 86
- Uninstalling Parallels Tools in Windows Guest OS ............................................................ 87
- Uninstalling Parallels Tools in Linux Guest OS ................................................................. 88

## Running a Virtual Machine
- Overview ............................................................................................................................. 90
- Selecting and Opening Virtual Machine ............................................................................. 91
- Starting a Virtual Machine ................................................................................................. 91
- Capturing and Releasing the Keyboard and the Mouse ...................................................... 93
- Shutting Down and Resetting Virtual Machine .................................................................. 94
- Pausing Virtual Machine .................................................................................................... 95
- Suspending and Resuming Virtual Machine ...................................................................... 95
- Switching Virtual Machine to Full Screen Mode ............................................................. 96
- Keyboard Shortcuts in Virtual Machine ............................................................................ 97
- Running a Virtual Machine inFullscreen Mode ................................................................. 98
- Changing Configuration at Runtime .................................................................................. 98
  - Overview ........................................................................................................................ 99
  - Connecting CD/DVD-ROM Drive .................................................................................... 100
  - Connecting Floppy Drive ............................................................................................... 100
  - Connecting Network Adapter ....................................................................................... 101
  - Connecting Serial or Parallel Ports ............................................................................... 102
  - Connecting Sound Device ............................................................................................. 102
  - Connecting USB Devices ............................................................................................... 103
  - Parallels Tools for Windows ........................................................................................... 104
  - Clipboard Synchronization Tool Options ........................................................................ 105
Cloning a Virtual Machine ................................................................. 178
Deleting a Virtual Machine ............................................................... 181
Using Shared Folders ........................................................................ 184
  Setting Up a Shared Folder .............................................................. 184
  Viewing Shared Folders in Guest OS ............................................... 186

Using Parallels Image Tool ................................................................ 187
  Overview ..................................................................................... 187
  Starting Parallels Image Tool ......................................................... 188
  Creating an Image of a Real Hard Disk .......................................... 189
  Modifying an Existing Hard Disk Image ........................................ 193
    Increasing a Hard Disk Image ................................................... 196
    Converting a Plain Disk into an Expanding Disk ......................... 197
    Converting an Expanding Disk into a Plain Disk ....................... 199
    Defragmenting an Expanding Disk ......................................... 201
  Creating Images of Floppy Disks .................................................. 203
  Creating Images of CD/DVD Discs .............................................. 208

Troubleshooting and Limitations ....................................................... 213
  Getting Technical Support .......................................................... 213
  Reporting a Problem to Parallels Team ....................................... 214
  Problems with Networking Inside a Virtual Machine .................... 216
  Installing Ubuntu Linux 6.0.6 Server ......................................... 216
  Problem with Connecting USB Devices in Linux Primary OS ......... 217
  Configuring Display for Full Screen Mode .................................. 218
  Third-Party Virtual Machines and Parallels Network Adapter ........ 219
  Problem with Printing ............................................................. 219
  SoftICE Keyboard Problem ..................................................... 220
  Initializing Swap File Problem .................................................. 220

Index ......................................................................................... 221
CHAPTER 1

Introduction

In This Chapter

About Parallels Workstation ................................................................. 7
What's New in This Version ................................................................. 8
About This Guide ................................................................................ 8
Getting Help ...................................................................................... 9

About Parallels Workstation

Parallels® Workstation is a powerful, easy-to-use, and cost-effective desktop virtualization solution. It enables the user to create completely networked, totally secure independent virtual machines on a single physical computer.

Parallels Workstation is empowered by a lightweight hypervisor, a thin layer of software that "works" between the host computer’s hardware and the primary operating system. The lightweight hypervisor controls some of the host computer's hardware resources, which results in dramatically more stable, secure, and higher-performing virtual machines.

Parallels Workstation sophisticated virtualization engine enables each virtual machine to operate similarly to a physical computer. Each virtual machine has its own set of virtual hardware: processor, RAM, floppy, CD and DVD drives, I/O devices, and hard disk. See the Virtual Machine Hardware (page 12) topic for the full list of Parallels virtual machine devices.

Intel virtualization technology (VT-x) is fully supported by Parallels Workstation. See Intel Virtualization Technology (VT-x) and AMD-V Support (page 11) for details.

Parallels Workstation has a set of special tools that enhance the performance and functionality of the guest operating system: mouse synchronization tool, clipboard synchronization tool, and others. See Parallels Tools Overview (page 77) for the full list of tools and their descriptions.

Parallels Image Tool Installed along with Parallels Workstation enables the user to modify images of virtual hard disks and to create images of real hard disks, CD/DVD discs and floppies.
What's New in This Version

New Guest OSes Support

Now Parallels Workstation officially supports the following guest operating systems:

- Ubuntu® Linux 5.0.4, 6.06, 7.04
- CentOS 2, 3, 4, 5

AMD Virtualization™ technology support

Parallels Workstation provides significantly improved AMD Virtualization™ (AMD-V) technology support.

Parallels Tools for Linux Guest OSes

To ensure a better integration between your primary and guest OS, Parallels Workstation provides a set of tools for Linux guest OSes that includes Dynamic Resolution Tool, Mouse Synchronization Tool and Time Synchronization Tool. See Parallels Tools for Linux (page 112) for details.

New Linux Kernels Support

Parallels Workstation supports the new Linux kernels v2.6.20 and v2.6.22.

About This Guide

This Guide is aimed at a wide range of users who want to use Parallels Desktop to create, configure and run Parallels virtual machines.

Notation Conventions

The table below presents the conventions used in this Guide.

<table>
<thead>
<tr>
<th>Fonts</th>
<th>This font</th>
<th>Used for buttons, options, menus and menu commands, windows, and dialog boxes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>This font</td>
<td>Used for keys, paths, and folder names.</td>
<td></td>
</tr>
<tr>
<td><strong>This font</strong></td>
<td>Used for console commands in Linux and Windows.</td>
<td></td>
</tr>
<tr>
<td>This font</td>
<td>Used for tips, glossary items and options or modes mentioned in the text.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type Styles</th>
<th>Note</th>
<th>Used to emphasize the message.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Warning.</strong></td>
<td>Used to warn you about possible data loss.</td>
<td></td>
</tr>
</tbody>
</table>
### Abbreviations used in text

In the present guide the following abbreviations are used:

- **OS** is used instead of *operating system* in some long sentences where using it will not change the meaning of the sentence.
- **VM** is used instead of *virtual machine* in some long sentences where using it will not change the meaning of the sentence.

### Definitions

**Primary operating system** (primary OS): In this Guide this term is used to refer to the operating system that controls the I/O devices of the computer and that is loaded when the physical computer is turned on, that is, Mac OS X.

**Guest operating system** (guest OS): The term is used to refer to an operating system that runs under the virtual machine control.

### Getting Help

Parallels Workstation offers several options for accessing necessary information:

- Parallels Workstation User Guide. This document contains extensive information about the product, its usage and troubleshooting. You can access the Guide from the Parallels Workstation Help menu or use its PDF version available from the Parallels Workstation folder. The default location is `C:\Program Files\Parallels\Parallels Workstation\`.
- Context-sensitive help. You can open a help page for the active window by pressing F1.
- Parallels web site (http://www.parallels.com). Explore the Support web page that includes product help files and FAQ section.
Parallels Virtual Machines

This chapter provides specifications for Parallels virtual machines, briefly describes the virtualization technologies used, lists the types of files used by virtual machines and explains their usage. The chapter also includes the list of supported guest operating systems.

In This Chapter

Virtual Machine Technology Overview ................................................................. 10
Intel Virtualization Technology (VT-x) and AMD-V Support ............................ 11
Virtual Machine Hardware .................................................................................... 12
Supported Guest Operating Systems ................................................................. 13
Virtual Machine Files .......................................................................................... 15
Support of Virtual and Real Disks ....................................................................... 16

Virtual Machine Technology Overview

Virtual machine technology allows users to:

- Create a virtual machine, each with a set of standard virtual hardware.
- Install any operating system in the virtual machine no matter what operating system is installed on your computer. The guest operating system and its applications are isolated inside this virtual machine and share physical hardware resources with the primary operating system.
- Have multiple guest operating systems (OSes) and their applications simultaneously running on a single physical computer. Switching between operating systems does not require rebooting.
- Consolidate and virtualize a computing environment, reduce hardware costs, lower operating expenses, and increase productivity.
Intel Virtualization Technology (VT-x) and AMD-V Support

Intel VT-x Support

Intel® Virtualization Technology (Intel® VT) is a set of hardware enhancements to Intel server and client platforms that provides a foundation for new and improved software-based virtualization solutions. An extended set of processor instructions allows tasks previously realized programmatically to be performed on a hardware level, thus reducing virtualization overhead and improving virtual machine performance, security and stability. To learn more about Virtualization Technology see the Intel web site (http://www.intel.com/technology/platform-technology/virtualization/index.htm).

Intel Virtualization Technology is fully supported by Parallels Workstation. If Parallels Workstation detects a VT-enabled CPU, support is automatically turned on. VT-x support can be manually disabled or enabled in the VM Flags (page 121) section of the General Options tab in Configuration Editor. If you run a guest OS with VT-x enabled, the Virtualization mode flag in the About Parallels Workstation screen shows Intel VT-x. See the More Information (page 57) section of the About Parallels Workstation window.

AMD-V™ Support

AMD Virtualization™ (AMD-V) technology is a hardware-based technology that helps enable servers to reach higher levels of efficiency and utilization by assisting virtualization software to run multiple operating systems and applications on a single physical AMD Opteron™ processor-based server.

The AMD-V technology is fully supported by Parallels Workstation. AMD-V support can be manually disabled or enabled in the VM Flags (page 121) section of the General Options tab in Configuration Editor. If you run a guest OS with AMD-V enabled, the Virtualization mode flag in the About Parallels Workstation screen shows AMD-V. See the More Information (page 57) section of the About Parallels Workstation screen.
Virtual Machine Hardware

Each VM contains the following virtual hardware:

- CPU Intel Pentium or AMD.
- Generic motherboard compatible with Intel i815 chipset.
- RAM up to 1500 MB.
- VGA and SVGA with VESA™ 3.0 support.
- 1.44 MB floppy disk drive mapped to a physical drive or to an image file.
- Up to four IDE devices. Each device may be either a virtual hard disk drive (from 20 MB up to 128 GB each, mapped to an image file), or a CD/DVD-ROM drive (mapped to a physical drive or to an image file).
- Ethernet virtual network card compatible with RTL8029. Parallels Workstation supports bridging to wireless network adapters.
- Up to four serial (COM) ports (mapped to real port, pipe or output file).
- Up to three parallel (LPT) ports (mapped to physical port, printer or output file).
- two-port USB 1.1 controller;
- AC'97-compatible sound card. Sound recording is supported.
- generic PC keyboard.
- PS/2 wheel mouse.

In the current version of Parallels Workstation real hard disks or partitions cannot be used as virtual hard disks in Parallels virtual machines.
Supported Guest Operating Systems

The current version of Parallels Workstation officially supports the following guest operating systems:

**Microsoft® Windows:**
- Windows Vista™ Ultimate, Enterprise, Business
- Windows Server® 2003 Standard Edition SP0, SP1
- Windows Server 2003 Enterprise Edition SP0, SP1
- Windows Server 2003 Web Edition SP0, SP1
- Windows XP Professional SP0, SP1, SP2
- Windows XP Home SP0, SP1, SP2
- Windows 2000 Professional Edition SP4
- Windows 2000 Server SP4
- Windows 2000 Advanced Server SP4
- Windows NT® Workstation 4.0 SP6
- Windows NT Server 4.0 SP6
- Windows ME
- Windows 98
- Windows 95
- Windows 3.11
- Windows 3.1

**Linux:**
- Red Hat® Enterprise Linux WS4, WS3, ES4, ES3, AS4, 5
- Red Hat Linux 9, 8, 7.3
- Debian® Linux 4, 3.1
- Fedora™ 8, 7; Fedora Core Linux 5, 4, 3, 6, 7
- SUSE® Linux 10.2, 10.1, 10, 9.3, 9.2, 9.1, 9.0
- Mandriva™ 2007
- Ubuntu® Linux 5.0.4, 6.06, 7.04, 7.10
- Xandros Linux 4.0
- CentOS 2, 3, 4, 5

**FreeBSD® Guest Operating Systems:**
- FreeBSD 5.4, 5.3, 4.5, 4.1

**OS/2® and eComStation™ Guest Operating Systems:**
- OS/2 Warp 4.5, 4, 3
• eComStation 1.2, 1.1

**Sun Solaris® Guest Operating Systems:**
• Solaris 10, 9

**MS-DOS® Guest Operating Systems:**
• MS-DOS 6.22
Virtual Machine Files

Hardware configuration for each virtual machine is defined in a special configuration file with .pvs extension. It contains all the information about virtual devices used by the virtual machine and files connected to those devices. A virtual machine has at least two files: a configuration file and a hard disk image file. Generally, there may be more files: a file for each additional virtual hard disk and output files for virtual ports. As an exception, virtual machine may have only one file, configuration file - such a virtual machine can be started from a Live CD.

The following table describes the types of files that virtual machines may have:

<table>
<thead>
<tr>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.pvs</td>
<td>This is a virtual machine configuration file. One configuration file defines one virtual machine. Configuration file is generated by the New Virtual Machine Wizard (page 59) when the virtual machine is created. One instance of Parallels Workstation can run only one configuration file, that is only one virtual machine. To run several virtual machines, you should launch several instances of Parallels Workstation.</td>
</tr>
<tr>
<td>.hdd</td>
<td>This is a virtual hard disk of a Parallels virtual machine. One virtual machine may have one or several virtual hard disks. One virtual disk can be connected to different virtual machines. There are two formats of virtual disks: plain and expanding. Both have the same extension. Images of hard disks created as the result of data migration from real hard disks may be used as virtual hard disks. For more information about virtual hard disks see the Hard Disk Images topic (page 16).</td>
</tr>
<tr>
<td>.sav</td>
<td>This file is created when you suspend a virtual machine. This file contains the state of the guest OS and its applications at the moment when the suspend was invoked. See Suspending/Resuming Virtual Machine (page 95) for more information.</td>
</tr>
<tr>
<td>.iso</td>
<td>This file contains an image of a CD or DVD. Operating systems process .iso image files as CD/DVD discs. More information about .iso images is given in the CD/DVD Real Discs and Images (page 17) topic.</td>
</tr>
<tr>
<td>.fdd</td>
<td>This file contains an image of a floppy disk created by Parallels Workstation. .fdd image files are processed by an operating system as a floppy disks. More information about .fdd images is given in the Floppy Disks and Disk Images (page 17) topic.</td>
</tr>
<tr>
<td>.txt</td>
<td>Serial and parallel ports can be emulated via output .txt files. See Serial Port Options (on page 133) and Parallel Port Options (on page 134).</td>
</tr>
</tbody>
</table>
Support of Virtual and Real Disks

This section provides all the information about the types of disks that can be used by Parallels virtual machines.

Hard Disk Images

The current version of Parallels Workstation does not support using physical hard disks or partitions. Parallels Workstation can work only with virtual hard disks stored as .hdd files.

You can create a new virtual hard disk for the virtual machine. The size of a virtual disk can be set within this range: 20 MB -128 GB.

Format of The Virtual Disk

A virtual hard disk may be in one of two formats: plain or expanding.

plain A plain disk has the same size from the moment it is created. The guest OS operates a bit faster on plain disk. A plain disk can be converted to expanding disk with the help of Parallels Image Tool.

expanding An expanding disk is small initially and grows as you add applications and data to the virtual machine. The disk size specified when the disk is created is the maximum size to which the disk can grow. Using expanding disks saves space on the hard disk of your computer. Expanding disk can be converted to plain disk with the help of Parallels Image Tool. See also the Maintaining Virtual Hard Disks topic.

Disk format is set when you create a hard disk image. If you need to change the format after the virtual disk is created, use Parallels Image Tool (page 193).

Virtual disks of both formats are saved as .hdd files; however, the structures of disk files are different. You can see the format of the virtual disk displayed in Configuration Editor: in the disk format field on the Advanced (page 127) tab of Hard Disk Options.
CD/DVD Discs and Images

Parallels Workstation can use real CD/DVD discs and .iso images of CD/DVD discs. Images in this format can be created by many applications, particularly, by Parallels Image Tool (page 187), that is installed along with Parallels Workstation.

Parallels Workstation can read ISO images of discs created by many third-party applications.

The current version of Parallels Workstation has no limitations on using multi-session CD/DVD discs. Virtual machine can play back audio CDs (no limitation on copy-protected discs).

If your computer has a writable CD/DVD-ROM drive, you can use it to burn CD or DVD discs in a virtual machine.

Floppy Disks and Floppy Disk Images

Parallels Workstation virtual machines can use real floppy disks, or images of floppy disks. A floppy disk image used by Parallels Workstation has the .fdd format.

- To create a blank .fdd image, use the Recreate button on the Floppy Options (on page 125) tab in Configuration Editor.
- To create a .fdd image of a real diskette, use Parallels Image Tool (page 187).

You may also use images of floppy disks created by WinImage® or VMware® applications. These images are files with the .img and .ima extensions.
CHAPTER 3

Installing Parallels Workstation

This chapter lists the system requirements and provides all the information required to install Parallels Workstation in Linux or Windows operating systems.

In This Chapter

System Requirements............................................................................................................ 18
Installing Parallels Workstation in Windows........................................................................ 20
Installing Parallels Workstation in Linux ............................................................................. 27

System Requirements

Before installing Parallels Workstation, please make sure that the computer where you want to install and run it meets the hardware and software requirements provided in this chapter.

Hardware Requirements

Parallels Workstation hardware requirements are listed in the following table:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>700 MHz 32-bit or 64-bit processor with IA-32 compatibility (Intel Pentium or AMD Athlon).</td>
</tr>
<tr>
<td></td>
<td>1.5 GHz or faster is recommended.</td>
</tr>
<tr>
<td></td>
<td><strong>Note.</strong> To run Parallels Workstation on 64-bit platform you must have a 32-bit primary OS installed.</td>
</tr>
<tr>
<td>System Memory</td>
<td>768 MB of RAM minimum.</td>
</tr>
<tr>
<td></td>
<td>1 GB recommended for all other guest OSes.</td>
</tr>
<tr>
<td>Free Hard Disk Space</td>
<td>25 MB required for Parallels Workstation package.</td>
</tr>
<tr>
<td></td>
<td>10 GB or more is recommended for each virtual machine.</td>
</tr>
<tr>
<td>Video Card</td>
<td>8-bit SVGA display adapter.</td>
</tr>
<tr>
<td></td>
<td>16-bit color depth or higher is recommended.</td>
</tr>
<tr>
<td>Optical Drive</td>
<td>CD-ROM and/or DVD-ROM drive.</td>
</tr>
<tr>
<td>Network Device</td>
<td>Ethernet adapter.</td>
</tr>
</tbody>
</table>
Software Requirements

Parallels Workstation can be successfully installed on any of the following operating systems:

**Microsoft Windows Operating Systems:**
- Windows Vista Ultimate, Enterprise, Business
- Windows Server 2003 Standard Edition SP0, SP1
- Windows Server 2003 Enterprise Edition SP0, SP1
- Windows Server 2003 Web Edition SP0, SP1
- Windows XP Professional SP2
- Windows XP Home SP2
- Windows 2000 Professional Edition SP4
- Windows 2000 Server SP4

You should have Internet Explorer version 5.0 or higher installed on your computer.

**Linux Operating Systems:**
- Fedora Core Linux 4 stock 2.6.11-1.1369_FC4
- Fedora Core Linux 3, 5, 6, 7
- Red Hat Enterprise Linux WS4 stock 2.6.9-5
- Red Hat Enterprise Linux AS4 stock 2.6.9-5
- Red Hat Enterprise Linux ES4 stock 2.6.9-5
- Red Hat Enterprise Linux 5
- Red Hat Linux 9 stock 2.4.20-8
- Debian Linux 3.1 stock 2.6.8-2-386
- SUSE Linux 10.0 stock 2.6.13-15
- SUSE Linux 9.3 2.6.11.4-20a
- SUSE Linux 9.2 stock 2.6.8-24.11
- SUSE Linux 9.1 stock 2.6.4-52
- SUSE Linux 9.0 stock 2.4.21-69
- Mandriva Linux 10 stock 2.6.3-7
- Mandriva Linux 9.2, 2007
- Ubuntu Linux 5.0.4, 6.06, 7.04, 7.10
- Xandros Linux 4.0
- CentOS 2, 3, 4, 5

In Linux operating systems make sure the following software packages are installed:
- Sources of currently installed kernel (if you didn't install the kernel manually, then install kernel-sources package from your distribution);
- glibc [glibc]
- gcc [gcc], ld [binutils] (included in any development package)
- X Window System including
- `xf86vidmode` extension (for full screen mode only)
- `XKB` extension (for keyboard national layouts and `leds` support)
- Qt 3.0.5 library multithreaded [qt3]

**PAE Support**

The current version of Parallels Workstation supports up to 4 GB PAE (Physical Address Extension). If your processor supports more than 4 GB PAE:

- In Windows primary OS, on the first startup of a virtual machine you will be prompted to create a new configuration with 4 GB PAE in `boot.ini`.
- In Linux primary OS, kernel PAE settings should be changed manually.

See Troubleshooting (page 91) in Starting a Virtual Machine topic.

---

**Installing Parallels Workstation in Windows**

This section contains complete information on installing Parallels Workstation on any of the supported Windows OSes.

**Parallels Workstation for Windows: Step-by-Step Installation**

**Preparing for installation**

If you purchased a boxed version of Parallels Workstation:

- Insert Parallels Workstation CD into the optical drive of your computer, and keep the CD sleeve with the activation key on it handy.

If you purchased the program from Parallels Online store (http://www.parallels.com/en/buyonline), or downloaded a trial version, make sure that you have a permanent or trial activation key, and:

- Locate the `Parallels-Wst-2.2.xxxx-Win.exe` file and open it.

**Step-by-Step Installation**

**Note:** You must have Administrator rights to install Parallels Workstation in a Windows operating system.

1. In the Installation wizard Welcome window, click **Next**.
2. In the **License Agreement** window use either the `PageDown` key or the `DownArrow` ↓ key on your keyboard to read the entire agreement. Select **I accept the terms of the license agreement**, and click **Next**.
You may print the license agreement for your records using the Print button.

3 If you are re-installing or updating Parallels Workstation, proceed to step 4. In other cases you will see the Customer Information window.

In the Customer Information window, enter your Activation key, and specify the User Name. Click Next. The Company Name field is optional. To skip the activation, click the Activate later button. You can activate the product when it is installed by choosing Activate Product from the Help menu.

To purchase a permanent activation key in the Parallels online store click the Buy button. Click Next.

To get a trial activation key, you need to register on the Parallels web site. To register on the Parallels web site, click the Register on Site button.
Note. The **Customer Information** dialog box may not appear if you reinstall Parallels Workstation.

4 In the **Choose Destination Location** dialog box specify the folder where Parallels Workstation will be installed, and click **Next**. If you do not want to install to the default folder, click the **Change** button to specify another one.
Note. Parallels Workstation must be installed on the boot volume.

5 In the Select Program Folder dialog box specify the name for the Parallels Workstation folder as it will appear in the Windows Start menu, and click Next. The folder is named Parallels by default.
6 In the **Select shortcuts** dialog box, specify which Parallels Workstation shortcuts you want to create, and click **Next**.

![Select shortcuts dialog box]

- Check **Create the application shortcut on the Desktop**
- Check **Put the application shortcut on the Quick Launch panel**

7 In the **Ready to Install the Program** dialog box, click **Install** to start the Parallels Workstation installation or click **Back** to return to the previous steps.

![Ready to Install the Program dialog box]

- Click **Install** to begin the installation
- If you want to review or change any of your installation settings, click **Back**. Click **Cancel** to exit the wizard.
If your Windows system is configured to warn you each time an unsigned driver is installed, you will see the following message:

![Parallels Workstation installation message]

Click **OK** to disable the unsigned driver warnings during Parallels Workstation installation. They will be re-enabled later when the installation is complete.

If your system is configured to block the unsigned drivers installation, you will receive the similar message prompting you to allow installation of these drivers. Click **OK**. Otherwise, Parallels Workstation cannot be installed at all.

You can see the installation progress shown in the **Setup Status** dialog box.

When Parallels Workstation is installed, the following dialog box appears. Click **Finish** to exit the installer.

![Parallels Workstation installation completed]

If you want to view the Readme file, select the **I want to view Readme file** option. To complete the installation, click **Finish**.
Starting Parallels Workstation

To start Parallels Workstation in Windows:

- From the Windows Start menu, choose Programs --> <Parallels Folder Name> --> Parallels Workstation, where <Parallels Folder Name> is the folder in the Windows Start menu that you specified for Parallels Workstation during the installation.

You can also start Parallels Workstation by double-clicking its icon on the desktop, or by clicking its icon in the Quick Launch panel, if you have added these shortcuts during the installation.

When you start Parallels Workstation for the first time, you will be prompted to decide whether you'd like to perform regular automatic checks for updates or not. See Auto-Updating Parallels Workstation in Windows (page 34) for more information about the auto-update feature.

Activating Parallels Workstation in Windows

If you didn't enter the activation key during the installation or if your trial activation key has expired, perform the following actions:

1. From the Help menu in the Parallels Workstation window choose Activate Product.

2. In the Activate Product window, type your activation key in the Activation key field, and click Activate. You may also specify your name and the company name in the User Name and Company Name fields. By default, the information is taken from the Windows operating system. These fields are optional.

3. If you entered a valid activation key, the following message will be displayed: "Parallels Workstation has been activated successfully. Thank you!" Now that your copy of the Parallels Workstation is activated, you may use all of its features and capabilities.
If You Activated with a Permanent Key

After you have activated your copy of Parallels Workstation with a permanent activation key, you will be prompted to register the next time you start Parallels Workstation.

Click the Register button to open the user registration online form in your Web browser. Please provide your contact information if you want to receive notifications about our new updates and products. Registration is optional.

Uninstalling Parallels Workstation in Windows

Uninstalling Parallels Workstation does not delete any files that have been created using Parallels Workstation, such as configuration files, virtual hard disks, CD disc .iso images, floppy .fdd images, and serial or parallel port output files.

Note: You must have Power User or Administrator rights to uninstall the Parallels Workstation in a Windows primary operating system.

The procedure may be slightly different in different Windows versions. To remove Parallels Workstation follow these steps:

1. Open the Windows Start menu, select Control Panel, select Add /Remove Programs, and then select Parallels Workstation.
2. Click the Remove button to begin uninstalling.
3. Click Yes when prompted: "Do you want to completely remove the selected application and all of its features?"
4. The wizard asks whether you want to remove the activation information or keep it.

   If you choose to keep it, you will not be asked to enter an activation key next time you install Parallels Workstation.

Installing Parallels Workstation in Linux

This section describes installing Parallels Workstation in Linux primarily operating systems and all the related operations.
Parallels Workstation for Linux: Step-by-Step Installation

Notes: 1. Make sure that the required packages and libraries listed in the software requirements (page 19) for the Linux primary OS are installed on your system.

2. To install Parallels Workstation in a Linux operating system, you need root privileges.

Preparing for installation

If you purchased the boxed edition of Parallels Workstation:

- Just insert the CD and keep the CD sleeve with the activation key handy.

If you purchased the program from Parallels Online store (http://www.parallels.com/en/buyonline), or downloaded a trial version, make sure that you have a permanent or trial activation key. Depending on what file types your system supports, download the RPM, or DEB, or TZG package respectively.

Step-by-Step Installation

1. Launch the Terminal program.

   Note: To enter (or issue) a command you must type a command and press the Enter key.

2. To gain root privileges enter the following command:

   su

   Enter the password for the root account when prompted.

3. If .rpm is supported in your system:

   - Locate the file Parallels-2.2.xxxx-lin.i386.rpm.
   - To start installing Parallels Workstation, issue the following command:

     rpm -i Parallels-2.2.xxxx-lin.i386.rpm

     Proceed to step 7.

4. If .deb is supported in your system:

   - Locate the file Parallels-2.2.xxxx-lin.deb.
   - To start installing Parallels Workstation, issue the following command:

     dpkg -i Parallels-2.2.xxxx-Lin.deb

     Proceed to step 7.

5. If both .rpm and .deb are not supported in your system:

   - Locate file Parallels-2.2.xxxx-lin.tgz and extract it into any existing directory:

     tar -xzf Parallels-2.2.xxxx-lin.tgz -C <directory name>

   - Go to the directory where you unpacked the .tgz file and issue the next command:

     cd parallels-2.2.xxxx-lin

   - Run the following command
Installing Parallels Workstation

6 After the installation completes, run the post-installation script. Issue the following command:

    ./install.sh

7 When prompted, press Enter on the keyboard.

8 Read the license agreement scrolling it by pressing Spacebar on your keyboard. To accept the agreement, type "y" or "yes" (in either upper or lower case) and press Enter.

9 The Parallels Workstation setup program configures, compiles and installs the drivers. You will be informed about the successful completion.

10 To exit the Terminal, issue the command:

    exit

You can now run Parallels Workstation.

Troubleshooting

If you receive a "Can not configure!" or "Can not compile!" message (note that you should have kernel sources installed), you can view log file and try to fix problem yourself. The log file is named: /usr/lib/parallels/comp.log.<log number>.error

If you can not fix the problem yourself, please send the log file and problem description to reports@parallels.com. We will assist you as soon as possible.

Starting Parallels Workstation

To start Parallels Workstation in Linux:

- Log in, launch the Terminal program and enter the command n the command line:

    parallels

When you start Parallels Workstation for the first time, you will be prompted to decide whether you want to perform regular automatic checks for updates or not. See Auto-Updating Parallels Workstation in Linux (page 39) for more information about the auto-update feature.

Activating Parallels Workstation in Linux

You cannot work with Parallels Workstation until you activate it with an activation key. For how to get an activation key see below in this topic.

To activate Parallels Workstation in Linux do the following:

1 Click Help in the Parallels Workstation main menu and select Activate Product.

2 In the Activate Product dialog box, fill in the following fields:

   - In the Activation key field type the activation key. When the field is not blank, the Activate button becomes enabled.
Specify your name and name of your company in the User Name and Company Name fields. These fields are optional.

3 Click the Activate button. If you have entered a valid activation key, the following confirmation message will be displayed: "Parallels Workstation has been activated successfully. Thank you!"

Now, your copy of the Parallels Workstation is activated and you may use all of its features and capabilities.

Registering your copy of Parallels Workstation

After you have activated your copy of Parallels Workstation with a permanent activation key, the next time you start Parallels Workstation, you will be asked to register.

Click the Register button to open the online user registration form in your Web browser. Provide your contact information if you want to receive emails about new updates and products.
Getting an Activation Key

If you already have an activation key, skip this section.

To get a trial activation key:

1. Choose Activate Product from the Help menu.
2. In the Activate Product dialog box, click the “obtain a free trial activation key” link.
3. In the User Registration window, specify your e-mail and your name if you want to receive news from Parallels by e-mail. These fields are optional.
4. Click the Register button to send this information to Parallels. You will receive a free trial activation key by email.

Alternatively, you may register on the Parallels web site. Click the Register on site button.

To get a permanent activation key:

1. Click Help in the menu and select Activate Product.
2. In the Activate Product dialog box, click the “purchase a permanent activation key” link to open the Parallels Online Store where you can purchase the key.
Uninstalling Parallels Workstation in Linux

Uninstalling Parallels Workstation does not delete any files that have been created using Parallels Workstation, such as configuration files, virtual hard disks, CD disc .iso images, floppy .fdd images, and serial or parallel port output files.

**Note:** To uninstall Parallels Workstation in a Linux primary operating system you need *root* privileges.

To uninstall Parallels Workstation in Linux:

1. If `.rpm` is supported in your system, enter the following command:
   ```bash
   su -c "rpm -e Parallels"
   ```
   Enter the *root* password when prompted.

2. If `.deb` is supported in your system, enter:
   ```bash
   su -c "dpkg -r Parallels"
   ```
   Enter the *root* password when prompted.

3. If both `.rpm` and `.deb` are not supported in your system:
   - In the **Terminal**, run the following command:
     ```bash
     su
     ```
   - To gain *root* privileges. Enter the password to the *root* account when prompted.
     - Go to the installation directory and run
     ```bash
     ./uninstall.sh
     ```
   - Leave the *root* account by entering the following command
     ```bash
     exit
     ```
This chapter discusses how to update Parallels Workstation in both Windows and Linux primary operating systems.

In This Chapter

Updating Parallels Workstation in Windows ............................................................... 33
Updating Parallels Workstation in Linux ................................................................. 38

---

Updating Parallels Workstation in Windows

Update procedure in Windows primary OS consists of the following steps:

1. Getting to know about a new update.

   We recommend that you use the auto-update feature of Parallels Workstation to be informed when a new update is available. See Auto-Updating Parallels Workstation in Windows (page 34).

   Alternatively, you may check for new updates using Update Wizard or you may check the Parallels web site.

2. Downloading and installing Parallels Workstation update.

   There are two ways to download an update:

   - Using the Update Wizard.

     If you use the auto-update feature, it informs you when the update is available and launches the Parallels Update Wizard for downloading.

     If you do not use the auto-update feature, you can start Parallels Update Wizard manually. See Update Wizard in Windows (page 34).

     After you download the update using Update Wizard, it will start the installation automatically.

   - Manually from the Parallels web site.

     If you have downloaded the update manually, start the installation. See Parallels Workstation for Windows: Step-by-Step Installation (page 20).
Auto-Updating Parallels Workstation in Windows

Parallels Workstation includes an auto-update feature. It may be configured to perform checks automatically. When starting Parallels Workstation for the first time, you are prompted to decide whether you want to automatically check for updates every week. We recommend that you use this feature.

Parallels Workstation will regularly access the Parallels update web server and check if a later (than the one currently installed) version is available. By default, checking for updates is performed once a week, in background mode, that means that you will be notified only when an update is found. Then you get the following message: "A newer version of the Parallels Workstation is available. Do you want to start Parallels Update Wizard?" Click Yes to launch Parallels Update Wizard that will download the update and start the installation.

Requirements to Your Computer

To be able to use auto-update feature:

- your computer must be connected to the Internet.

Note. If you have a firewall and/or another antivirus software installed in your primary operating system, please configure them properly to allow Parallels Workstation to perform checks.

Configuring Auto-Update

You can specify the frequency of update checks, i.e. daily, weekly, or monthly, in the Automatically checks for update option on the Common (page 170) tab of the Preferences dialog box. Auto-update checks can be disabled by selecting Never for the same option. You can enable the auto-update feature later.

Update Wizard in Windows

Updates for Parallels Workstation for Windows can be downloaded using Parallels Update Wizard. The wizard accesses the Parallels update server, checks if a later version than the one currently installed is available, downloads the latest version (if any), and starts the installation. To use this feature, your primary operating system must be connected to the Internet.

To update Parallels Workstation:

1. Start the Parallels Update Wizard either by selecting Check for Updates in the Help menu, or by selecting All Programs -- > <Parallels Folder> -- > Check for Updates in the Windows Start menu.
2 In the Welcome dialog box click **Next** to proceed.

3 The wizard checks when your copy of the Parallels Workstation was last updated and displays the exact date and time of the update. Click **Next** to check for available updates.
4. Wait while the wizard is processing the information on the Parallels update server.

5. If the wizard can not find a more recent version than the one that is currently installed, it displays the following dialog box.

Click **Finish** to exit the wizard.
If the wizard finds a more recent version of Parallels Workstation, its build number is displayed in the following dialog box.

Make sure that the latest version is selected and click **Download**.

Wait while the wizard completes downloading. Select the **Install update** option, then the update installation will start automatically.
Before installing, make sure you closed all Parallels Workstation instances, and click the Finish button.

8 The Update Wizard launches the installation of the update. Setup program prompts you to confirm the replacing of the current version by the later one.

Click Yes.

When the installation is complete, click Yes to restart the computer.

---

### Updating Parallels Workstation in Linux

Update procedure in Linux primary OS consists of the following steps:

1 **Getting to know about a new update.**

   We recommend that you use the Auto-update feature of Parallels Workstation to be informed when a new update is available. See Auto-Updating Parallels Workstation in Linux (page 39).

   Alternatively, you may check for new updates by using Update Wizard or you may check the Parallels web site.

2 **Downloading Parallels Workstation update.**

   There are two ways to download an update:
   - Using the Update Wizard.
     
     If you use the Auto-update feature, it informs you when the update is available and launches the Parallels Update Wizard for downloading. If you do not use the Auto-update feature, you can start Parallels Update Wizard manually. See Update Wizard in Linux (page 39).
   - Manually from Parallels web site.

3 **Installing the update.**

   After you have downloaded the update, install it. See Installing an Update (page 43) topic for guidelines.

   If you need to install an earlier version of Parallels Workstation than the one currently installed, remove the program and install the required version.
Auto-Updating Parallels Workstation in Linux

Parallels Workstation includes an auto-update feature. When starting Parallels Workstation for the first time, you will get the message: "Parallels Workstation is configured to automatically check for updates every week. To do this your host computer should be connected to the Internet. You may choose another checking period or disable this feature in the Preferences/Common screen." We recommend you to turn this feature on, and you will be informed when Parallels Workstation updates are released.

Parallels Workstation will regularly access the Parallels updates web server to check if a later version than the one currently installed is available. By default, checking for updates is performed once a week, in background mode. That means you will be notified only when an update is found, you will get the following message: "A newer version of the Parallels Workstation is available. Do you want to start Parallels Update Wizard?" Click Yes to download the update.

Requirements to Your Computer

To be able to use auto-update feature:

- your computer must be connected to the Internet.

Note. If you have firewall and/or antivirus software installed in your primary operating system, they may display warnings when Parallels Workstation tries to access the Internet for update. Please configure them properly to allow Parallels Workstation to perform updating.

Configuring Auto-Update

You can specify the frequency of update checks, i.e. daily, weekly, or monthly, using the Automatically checks for update option on the Common (page 170) tab of the Preferences window. Auto-update checking can be disabled by selecting the Don't check value from the same drop-down list. You can enable the auto-update feature at any time.

Update Wizard in Linux

Parallels Workstation includes Parallels Update Wizard that assists in downloading updates. The wizard accesses the Parallels update web server to check if a later version than the one currently installed is available and downloads it. Update Wizard automatically selects the package suitable for your Linux primary OS.

To be able to use Parallels Update Wizard:

- Your Linux primary operating system must be connected to the Internet.

To download the update:


Parallels Update Wizard can be started automatically, by auto-update feature (see Auto-Updating Parallels Workstation in Linux (page 39)), or manually by one of the following methods:
- select **Help/Check for Updates** in the Parallels Workstation menu,
- in the **Terminal**, issue the command:

```
updatewizard
```

2. In the Welcome window click **Next** to proceed.
3 The wizard checks when your copy of the Parallels Workstation was last updated and displays the exact date and time of the update.

Click **Next**.

4 When the wizard gets build numbers of available updates, it compares them with the installed version.
If the wizard finds a more recent version of Parallels Workstation than the one currently installed, it displays the update in the following window.

Make sure that the latest version is selected and click **Download**.
The wizard downloads the update. When finished, the wizard displays the command(s) you should execute to install the update. Proceed to Installing an Update (page 43) to perform the installation.

**Note:** To update Parallels Workstation on a Linux computer, you need root privileges.

### Updating From an RPM Package

The update feature removes the version of Parallels Workstation currently installed on your computer and installs a new one.

To update Parallels Workstation, perform the following operations:

1. Launch the **Terminal** program.
2. Run the `su` command to gain root privileges for installation. Enter password to the root account when prompted.
3. Issue the following command to install the update:

   ```bash
   rpm -U ~/parallelsupdate/parallels-2.2.xxxx-lin.i386.rpm
   ```

   If you are trying to install an earlier version, you will get a warning. For the guidelines on installing an earlier version see the topic below in this chapter.
4. After the installation completes, run the post-installation script. Issue the following command:

```
parallels-config
```

5. When prompted, press Enter on the keyboard.

6. Read the license agreement up to the end, scroll it by pressing Spacebar on your keyboard. To accept the agreement, type Y and press Enter.

7. The Parallels Workstation Setup program configures, compiles and installs drivers.

8. After the process is complete, you can run the latest version of the Parallels Workstation.

9. In the Terminal, enter `exit` to leave the root account.

**Installing an earlier version of Parallels Workstation**

We describe the procedure for the primary OS that supports .rpm:

- perform steps 1-2 of the procedure described above;
- move to the directory where the installation package is located:

```
cd <installation directory>
```

- issue the following command to install the program:

```
rpm -U --oldpackage Parallels-2.2.xxxx-lin.i386.rpm
```

- perform steps 4-8 of the updating procedure.

**Updating From DEB and TGZ Packages**

To update Parallels Workstation in the primary OS that supports .deb or .tgz, perform the steps from the Parallels Workstation installation procedure that are related to your Linux primary system. See the Parallels Workstation for Linux: Step-by-Step Installation (page 28) topic.

**Troubleshooting**

If you receive a "Cannot configure!" or "Cannot compile!" message, make sure you have kernel sources installed. You can view the log file and try to fix problem yourself. The Log file is located: `/usr/lib/parallels/comp.log.<log number>.error`

If you can not fix the problem yourself, please send the log file and the problem description to reports@parallels.com. Parallels support team will assist you as soon as possible.
## CHAPTER 5

### Interface Basics

This chapter provides information about Parallels Workstation window and its controls.

#### In This Chapter

- **Main Window** .......................................................... 46
- **Startup Options Dialog** ............................................. 47
- **Property Page** .......................................................... 49
- **Console View** .......................................................... 51
- **Configuration Editor** ............................................... 53
- **Toolbar** .................................................................... 54
- **Status Bar** ............................................................... 54
- **Text Size** ................................................................. 55
- **About Parallels Workstation Window** ......................... 56
- **More Information** .................................................... 57
- **Making Screen Shots** ................................................. 58
Main Window

The Parallels Workstation window displays the title and configuration of an open virtual machine and a set of controls.

Parallels Workstation window can be displayed in two views:

1. If the virtual machine is not running, the main window displays the **Property Page**. See Property Page (page 49) to learn more about it.
2. When you start the virtual machine, the main window transforms into virtual machine **Console** (on page 51) window or Guest OS window that acts like a display of a computer. See the Console View (on page 51) to learn more about it.

Controls available in both Property Page and Console view are the following:

- **Parallels Workstation menu** - commands and options for the open virtual machine and for Parallels Workstation itself.
- **Toolbar** - buttons for starting, stopping, resetting, pausing the virtual machine and for switching main windows views.
- **Status bar** - icons depicting virtual devices connected to the virtual machine and their status.
Hiding Parallels Workstation Controls

You can hide some of the Parallels Workstation window components such as the toolbar and status bar.

To hide the toolbar/status bar:

- Choose **Toolbar/Status Bar** from the **View** menu.

You can make them visible at any time by selecting them in the menu again. The main window controls have check marks in the menu when they are visible.

---

Startup Options Dialog

The **Startup Options** dialog box appears when you start Parallels Workstation for the first time. The **Startup Options** dialog box helps you find the virtual machine you want to work with or lets you create a new one. You can also configure Parallels Workstation startup options in this dialog box.

Opening a Recently Used Virtual Machine

1. Select the virtual machine in the **Recently Used Virtual Machines** list. You will see the name and the path to the configuration file in the **VM Path** field.

2. Click **Open**.
When you start Parallels Workstation for the first time, the list of the recently used virtual machines is empty.

**Browsing Hard Disk for a Virtual Machine**

To open an existing virtual machine that is not in the **Recently Used** list:

1. Click the **Browse** button to locate the desired configuration file.
2. Click the **Open** button.

**Creating a New Virtual Machine**

1. Click the **New VM** button
2. Follow the wizard as described in the New Virtual Machine Wizard topic (page 59).

Alternatively:

1. Close the **Startup Options** dialog box by clicking the **Cancel** button.
2. A blank virtual machine will be open, and you may create a new virtual machine from scratch using Configuration Editor.

**Configuring Parallels Workstation Startup Options**

- Select the **Load recently used VM at startup** option if you want the last used virtual machine to be loaded and opened on Parallels Workstation startup.
- Select the **Show startup dialog** option if you want this dialog to appear when Parallels Workstation is started.

The same options are also present on the Common tab of **Preferences** window. Whenever you change these options in one of these windows, they are automatically changed in the second one.

For more details please refer to the Common Preferences topic (page 170).
Property Page

Microsoft Windows XP

**Configuration**
- **File Location**: C:\Documents and Settings\User\Start Menu\My Documents\Parallels Virtual Machines\winxp.pvs
- **Guest OS**: Windows XP
- **Acceleration**: High
- **Boot Sequence**: Auto Start
- **Hard Disk, Floppy, CD-ROM**: Off
- **Modified**: 2003.09.02 16:00:57
- **VM State**: Stopped

**Resources**
- **Memory**: 256 MB
- **Hard Disk 1**: 8000 MB; C:\Documents and Settings\User\Start Menu\My Documents\Parallels Virtual Machines\winxp.pvs
- **CD/DVD-ROM 1**: D:\WinXP_SP2.iso
- **Network Adapter 1**: Bridged Ethernet
- **Sound**: Playback enabled; Recording enabled
- **USB Controller**: AutoConnect On
Property Page appears whenever you open an existing virtual machine or create a new one.

The upper part of the page, **Configuration**, displays the virtual machine name, location of the configuration file, type of the guest operating system (regardless whether or not it is installed), acceleration level, last modification date, etc. These settings can be changed with the help of Configuration Editor. Click any of the links to open Configuration Editor (on page 118).

The **Resources** list shows all the devices connected to the virtual machine and their current options. To edit any device simply click the device name. Configuration Editor will open the tab related to that device.

At the bottom of the Property Page there are the following buttons:

- **New VM** button - for creating a new virtual machine.
- **Open** button - for browsing hard disk for a virtual machine to open.
- **Edit** button - for opening Configuration Editor.
- **Save** button - for saving an open virtual machine configuration after changes were made.

Parallels Workstation allows you to set the text size for the property page that fits you the best. See Text Size (page 55) for details.

**When the Guest OS is Running**

The Property Page remains available when the guest OS is running. You may open it to view the VM configuration. However, editing of the configuration is prohibited, the links and command buttons are disabled.
Console View
You interact with a running virtual machine via its Console window (Guest OS window) that appears in the main Workstation window once you start the virtual machine.

When the guest operating system is running, all toolbar buttons and many of the menu commands become enabled. You can switch between the Console and the Property Page views.

To switch to the Property Page while in the Console view, do one of the following:

- click the **Property Page View** button on the toolbar,
- select **Console View** from the **View** menu.

To return to Console view while in the Property Page view, do one of the following:

- click the **Console View** button,
- select **Console View** from the **View** menu.

**Full Screen Mode**

Guest operating system console can be displayed in full screen mode with the Parallels Workstation menu, toolbar, and status bar being hidden. For detailed information see Switching Virtual Machine to Full Screen Mode (on page 96).

**Console Screen Shots**

You can make screen shots of the console window while the virtual machine is running. See Making Screen Shots (on page 58) for details.
Configuration Editor

Configuration Editor helps you edit a virtual machine configuration. It is available only when the virtual machine is stopped. Configuration of a suspended virtual machine cannot be edited.

To open Configuration Editor do one of the following:

- Open the Property Page and click the **Configuration**, or **Resources** link, or any device link.
- On the Property Page click the **Edit** button at the lower part of the window.
- Choose **Edit Configuration** from the **File** menu.

Configuration Editor window consists of two panes. The left pane contains the **Resources** list. Selecting the device in the list opens the device options tab in the right pane.

Clicking the **Add** button at the bottom of the left pane opens the Add Hardware Wizard, and clicking the **Remove** button deletes the selected device or the option from the **Resources** list. For more detailed information refer to the Adding New Devices to VM topic.

To save changes in the configuration you must exit the Configuration Editor and click the **Save** button at the lower part of the Property Page.
Toolbar

The toolbar is located to the right of the Parallels Workstation window and has the following buttons:

- Start the virtual machine. See Starting Virtual Machine (on page 91).
- Stop the virtual machine. See Shutting Down and Resetting Virtual Machine (on page 94).
- Reset a virtual machine. See Shutting Down and Resetting Virtual Machine (on page 94).
- Pause the virtual machine. See Suspending/Resuming Virtual Machine (page 95).
- Switch the virtual machine to the full screen mode and back to window mode. See Switching Virtual Machine to Fullscreen Mode (on page 96).
- Switch the main window to Property Page view. See Console View (on page 51) and Property Page (page 49).
- Switch the main window to Console (Guest OS) window view.

Most of the toolbar buttons become enabled when you start the virtual machine. When the virtual machine is stopped, only the Power On button is enabled.

If you click a toolbar button, it becomes visibly pressed reflecting the current virtual machine state.

Status Bar

When the virtual machine is running, the status bar displays information about its devices statuses.

Each device (except memory) connected to the virtual machine is represented by an icon on the right side of the status bar.
The icons for the following devices appear on the status bar:

- hard disk
- CD/DVD-ROM
- floppy disk drive
- network adapter
- serial port
- parallel port
- sound device
- USB controller

When a device is used by any process, it is indicated by a coloured circle:

- by the green circle when reading is being performed,
- by the orange circle when writing is being performed.

To connect or disconnect the device at runtime (when the guest OS is running), right-click the device icon to open its context menu and select the command you need. The picture below shows the context menu for the CD/DVD-ROM drive.

The following devices have context menus: CD/DVD-ROM, floppy drive, network adapter, serial and parallel ports, a sound device, and USB. For more information please refer to the Changing Configuration at Runtime (page 98) section.

**Text Size**

Parallels Workstation provides options for adjusting text size of the Property Page.

Use the **Increase Text Size** and **Decrease Text Size** commands in the **Text Size** submenu of the **View** menu.

To restore the initial text size choose the **Reset Text Size** command.
The About Parallels Workstation window is displayed when you choose About Parallels Workstation from the Help menu. It provides the information about your copy of Parallels Workstation, licensing information and support information.

Parallels® Workstation for Windows
Version 2.2 Build 2055 Beta (01.09.2006)

Parallels is a registered trademark of Parallels Software International, Inc. This product is based on a technology that is the subject matter of a number of pending patent applications.

Licencing Information:
This is an active copy of Parallels Workstation. It is licensed to Name,
Name of the company

Support Information:
Technical support page: http://www.parallels.com/support
Licensing Information

- Shows the activation status and the name of the person whom this copy is licensed to.

Support Information

- Contains the contact information of the Parallels technical support group.

Buy Online and Evaluate buttons

- present at the bottom of the window if you did not activate your copy of the product or if you used a trial activation key. See Activating Parallels Workstation in Windows (page 26) or Activating Parallels Workstation in Linux (page 29) for the details.

More Info button

- opens the window with more detailed license information and a list of special features used by the virtual machine.

More Information

![Application Details]

License Status:

- **User Name** and **Company Name** fields contain the information that you entered in the Activate Product window.
- **Product ID** displays the identification number of your copy of Parallels Workstation.
- **Validity period** shows the period during which your license is valid.
- **Primary OSes** lists the primary operating systems for which you can use the product according to the license.
- **Terminal Services** lists the primary operating systems allowed to access Parallels Workstation remotely.

Note: The same license information is displayed in the Activate Product window.
Virtual Machine Special Features:

On this list you can see what special features the virtual machine uses at runtime. When the virtual machine is stopped, the list shows that all features are off.

- **Virtualization mode** shows the virtualization mode or acceleration level.

  If you work on an Intel VT-enabled processor, and hardware virtualization support is activated on the VM Flags (page 121) tab of the **General Options**, then there will be: **Intel VT-x**. This line shows **AMD-V**, when you work on an AMD-V processor, and hardware virtualization support is activated on the VM Flags (page 121) tab of the **General Options**. See Intel Virtualization Technology (VT-x) and AMD-V Support (page 11) for a description of both types of hardware virtualization.

  If the VM is running without hardware acceleration, the virtualization mode line indicates the acceleration level. All guest OSes, except Windows NT/2000/XP/2003, run in **Software mode 0**. Windows NT/2000/XP/2003 starts with **Software mode 0**, then switch to **Software mode 1** and **Software mode 2** in case the **Acceleration Level** setting (on the VM Flags (page 121) tab of the **General Options**) is set to **High**.

- **Remote session** indicates if Parallels Workstation is executed on a remote server.

Making Screen Shots

Parallels Workstation allows you to make screen shots of the guest operating system window when the guest OS is running. Click **Console Screenshot** in the **VM** menu. Type or select a name and a folder to store the screen shot file. Parallels Workstation saves screen shots as **.bmp** files in Windows primary OS and as **.png** files in Linux primary OS.
CHAPTER 6

Creating a Virtual Machine

This chapter discusses different ways of creating a new virtual machine. All of them include the following steps:

- creating a virtual machine configuration,
- installing a guest operating system,
- installing Parallels Tools.

The procedure of creating virtual machines is the same in all supported primary operating systems.

In This Chapter

Creating Virtual Machine Configuration ................................................................. 59
Installing Guest OS ................................................................................................. 72
Installing Parallels Tools ....................................................................................... 76
Uninstalling Parallels Tools in Windows Guest OS .............................................. 87
Uninstalling Parallels Tools in Linux Guest OS .................................................... 88

Creating Virtual Machine Configuration

This section discusses what is a virtual machine configuration and how to create it with the help of New Virtual Machine Wizard.

New Virtual Machine Wizard

A new virtual machine configuration can be created with the help of New Virtual Machine Wizard.

To open New Virtual Machine Wizard

1  Open Parallels Workstation.

2  Click the button or choose New VM from the File menu.
3 The **Welcome** window of the New Virtual Machine Wizard appears.
The wizard can create a virtual machine with three types of configurations: **Typical**, **Custom**, and **Blank**. Regardless of what type is selected, you can later edit the virtual machine configuration to add or to remove virtual devices and to change their options. Refer to the Editing Virtual Machine Configuration (on page 118) topic.

**Typical Configuration**

Typical virtual machine is created with a configuration typical for the chosen guest operating system. See the Typical configurations (page 62) topic for more details. When creating a typical virtual machine you have to specify the following:

- the type and version of the guest operating system that will be installed;
- the name of the virtual machine;
- the name for the virtual machine’s configuration file and a folder to store it.

You can later change the settings and add new devices or remove unnecessary ones using Configuration Editor.

**Custom Configuration**

When creating a custom virtual machine, you can:

- choose the type and version of the guest operating system to be installed;
- specify the amount of RAM the virtual machine will use;
- choose the disk size and format if you want to create a new one;
- specify name and location of an existing virtual disk of any format;
- choose not to add a hard disk at all;
- select the type of networking in the virtual machine;
- define a name of the virtual machine;
- the name for the virtual machine’s configuration file and a folder to store it.

The CD/DVD-ROM drive, floppy drive, and sound device (with exceptions for some guest OSes) are added automatically. Serial ports are added for OS/2 guest OS. You can add necessary devices later with the help of Configuration Editor.

**Blank Configuration**

Blank virtual machine has only memory in its configuration. Such virtual machine can be used with a Live CD. Devices can be added to blank configuration with the help of Configuration Editor.
Typical Configurations

A typical virtual machine includes the following virtual hardware:

- memory
- a hard disk drive
- a floppy disk drive
- a CD/DVD-ROM drive
- a network adapter
- a sound device (except for FreeBSD and MS-DOS configurations)
- a USB controller (in Windows 98/ME/2000/XP/2003 and in all of the Linux typical configurations)

The typical configuration for OS/2 includes a serial port.

The amount of memory and hard disk size vary for different guest OSes. The following table contains the memory amounts and hard disk sizes for different guest operating systems. The virtual hard disk for typical virtual machines is always created in expanding format (page 16).

<table>
<thead>
<tr>
<th>RAM, MB</th>
<th>HDD size, GB</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Creating Typical Virtual Machine

To create a typical virtual machine:


2. In the **Welcome** dialog box select the **Skip Introduction** next time option if you want to skip this dialog box next time you run the wizard. Click **Next**.
3. Make sure the **Create a typical VM** option is selected. Click **Next**.

![New Virtual Machine Wizard](image)

4. Specify the type and the version of the guest operating system you want to install in the new virtual machine. Click **Next**.

![New Virtual Machine Wizard](image)

5. Specify a name for the virtual machine. The name must have less than 50 characters.
In the **Configuration file** field the default path and name for the configuration file are shown. The default folder for Parallels virtual machines can be specified on the Common tab of the Preferences window. You may specify other than the default folder to store the configuration file. You may type directly into the field or use the **Browse [...]** button to locate a folder.

Click **Finish** to creating your new virtual machine, or click **Back** to change settings on the previous steps.

After you click **Finish**, the new configuration is generated, and its Property Page is displayed.

**Creating Custom Virtual Machine**

1. Open Parallels Workstation. Click the **New VM** button on the Command Button panel or choose **New VM** from the **File** menu. The **Welcome** window of New Virtual Machine Wizard will appear. Click **Next**.
2. In the **Select virtual machine configuration** window select the **Create a custom VM configuration** option. Click **Next**.

3. In the **Select guest OS** window specify the type and the version of the guest operating system you want to install in a new virtual machine. Click **Next**.
4 In the **Specify memory size** window set the amount of RAM for the new machine. We strongly recommend that you allocate no more than the half of the physical RAM available on your computer. To set memory value use slider, spin buttons, or type a value directly into the field. You can choose any value from 4 to 1500 MB. The memory amount must be specified in multiples of 4 MB. Click **Next**.

5 In the **Select action type** window choose whether you want to create a new virtual hard disk, use an existing one, or not to add any disk at all. Click **Next**.

If you selected to use an existing hard disk image, proceed to the Step 8.
If you decided not to add any disk at all, proceed to Step 9.

6 If you selected to create a new virtual disk, specify its size and format. For information on disk formats refer to the Hard Disk Images (page 16) topic. Click Next.

7 In the Select an image file window specify a location to store the image of virtual disk, and the name of that image. To use the default location, just click Next.
The default location is specified on the Common tab (page 170) in the Preferences window. Files of a new virtual machine are automatically placed to a new folder, that is named in the following way: `<guest OS>.<number of the machine of the same version - 1>`. For instance, the first Windows 2000 virtual machine is placed to the `\win2000\` folder. The second Windows 2000 virtual machine is placed to the `\win2000.1\` folder, and so on.

To specify other than the default location use the Browse[...] button or make corrections directly into the field.

Click Next. The wizard prompts you to confirm the creating of new folder. Click Yes.

Proceed to the Step 9.
8 To use an existing hard disk image (the option selected in Step 5) specify its location. Use the Browse button to locate it or type the path and file name directly into the field.

![New Virtual Machine Wizard]

Click Next.

9 In the next window specify the type of networking for the new virtual machine.

Select Bridged Ethernet if you want to access the Internet inside the virtual machine.

Select Host-only Networking if don't want to access the outside network from your computer. See Networking in Virtual Machine (page 164) for detailed information about these types of networking.
If you do not have physical network interface card or do not need a network adapter in this virtual machine, select the **Networking is not required** option.

Click **Next**. If you have selected **Host-only Networking** or **Networking is not required** proceed to the Step 11 of the current instructions.

10 If you have selected **Bridged Ethernet** networking for the new machine, specify which real adapter should be connected to the virtual machine. Select one in the list and click **Next**.
In the Select virtual machine configuration file window specify a descriptive name for the virtual machine in the Virtual machine name field. The name must not exceed 50 characters.

In the Configuration file field, the default path and name for the configuration file is shown (the folder where the new virtual hard disk was saved is shown or the default folder specified in Preferences).

To select other than the default values, use the Browse button [...] or make corrections directly in the field.

Click Finish. If the folder does not exist, confirm the new folder creation. Click Yes.

New configuration file will be created and opened in the Parallels Workstation window.

Installing Guest OS

This section discusses how to install an operating system in a virtual machine.
Installing a Guest Operating System

Before you start the installation of the guest operating system, create the virtual machine configuration and connect the guest OS installation media to the virtual machine.

The following installation media can be used:

- CD/DVD-ROMs
- floppy disks
- ISO images of CD/DVD-ROMs
- FDD images of floppy disks

Some operating systems are distributed on ISO image files. Generally, the installation is performed faster if the image files are used.

ISO images of CD/DVD-ROMs and FDD images of floppy disks can be created with the help of Parallels Image Tool installed along with Parallels Workstation. For more information please refer to the Using the Parallels Image Tool (page 187) chapter.

Note: In Linux primary OS, you must have root privileges to access the physical CD/DVD-ROM or floppy drives of your host computer from inside the virtual machine.

General Steps

1. Start Parallels Workstation.
2. Create a virtual machine configuration for the specific guest OS or open an existing one.

To install from a physical CD/DVD or CD/DVD .iso image:

1. On the Property Page of the virtual machine click the CD/DVD-ROM drive link in the Resources list to open Configuration Editor.
2. On the CD/DVD-ROM Options tab make sure that the Enabled and the Connect at startup options are selected.
3. Connect the installation media.
   If you install from a real CD/DVD:
   - Select Use real CD/DVD-ROM and choose the real drive (to be used by the VM) from the CD/DVD-ROM Drives list.
   - Insert the installation CD/DVD disc into the appropriate drive of your computer.
   If you install from an .iso image file:
   - Select the Use image file option and specify the path to the .iso file in the Image File field.
4. Specify the IDE channel for the virtual CD/DVD-ROM drive, select 0:1 in the Connect to list.
5. Click the Save button at the bottom of the Configuration Editor window to save the virtual machine configuration.
6. Click the Power On button on the toolbar to start your virtual machine.
7 Follow the installation instructions for the operating system.

**To install from a physical floppy disk or an .fdd floppy image:**

1 On the Property Page of the virtual machine click on the Floppy resource to open Configuration Editor.

2 On the Floppy Options tab, make sure that the Enabled and the Connect at startup options are selected.

3 Connect the installation media.
   If you install from a real floppy disk:
   - Select Use real floppy and choose the real drive (to be used by the VM) from the Floppy Drives list.
   - Insert the installation floppy disk into the appropriate drive of your computer.
   If you install from an image file:
   - Select Use image file and specify the path to the .fdd file in the Image File field.

4 Click the Save button at the bottom of the Configuration Editor window to save the virtual machine configuration.

5 Start the virtual machine by clicking Power On on the toolbar.

6 Follow the installation instructions for the operating system.

---

**Reinstalling or Upgrading the Guest OS**

**Reinstalling the Guest OS**

First of all, with virtual machines, you don't have to re-install the guest OS, just create a new virtual machine, install the guest OS and delete the old machine after moving all the necessary data to the new one.

If nevertheless, you are going to install (or repair) the guest operating system on a virtual hard disk where the guest OS is already installed:

1 Change the booting sequence:
   - Open the Property Page of the virtual machine, click the Edit button in the lower part of the Page or select Edit Configuration from the File menu.
   - Open the Booting Options tab.
   - Set the boot sequence either to [CD-ROM, Hard Disk, Floppy] or to [Floppy, Hard Disk, CD-ROM] depending on the installation media you are going to use.

2 **Important!** Change the type of the guest OS on the General Options tab in Configuration Editor.

3 Save changes in configuration by clicking the Save button in the lower part of the Configuration Editor window or by choosing Save from the File menu.

4 Insert the CD with OS installation or connect the image of this CD.

5 Start the virtual machine.
6 Follow the Setup instructions.

During the installation, when the guest OS reboots for the first time:

- Stop the virtual machine, set [Hard Disk, Floppy, CD-ROM] sequence, save the settings, and start the guest OS.

**Upgrading the Guest OS**

If you want to upgrade an earlier version of Windows operating system for a later one in your virtual machine, follow the upgrade paths specified on the Microsoft web site. If there is no such official path you cannot upgrade the guest system. In the process of upgrading all data on the startup virtual disk will be lost.

**Warning.** If you have a Windows XP (Home or Professional edition) virtual machine you cannot "upgrade-in-place" the operating system to one of supported Windows Vista. Only "clean" upgrade is possible.

To upgrade a guest Windows OS:

1 Change the booting sequence:
   - Open the Property Page of the virtual machine, click the Edit button in the lower part of the Page or select Edit Configuration from the File menu.
   - Open the Booting Options tab.
   - Set the boot sequence either to [CD-ROM, Hard Disk, Floppy] or to [Floppy, Hard Disk, CD-ROM] depending on the installation media you are going to use.

2 Important! Change the type of the guest OS on the General Options tab in Configuration Editor.

3 Save changes in configuration by clicking the Save button in the lower part of the Configuration Editor window or by choosing Save from the File menu.

4 Insert the CD with upgrade or connect the image of this CD.

5 Start the virtual machine.

6 Follow the Setup instructions.

**Warning.** Even if the upgrade follows the existing official path, the upgrade can fail.

**Configuring X Window System in FreeBSD Guest OS**

If you want to use the X Window System graphic shell in a FreeBSD guest OS, you should configure it manually. Running automatic configuration command `X -probeonly` or `X -configure` may not work. The X Window System can be configured using `xorgconfig` text utility or `xorgcfg` graphical utility. You need root privileges to run them.

To start manual configuration:

1 Start the virtual machine. Log in as root.
Type one of the following commands in the command line:

```
xorgconfig
```

or

```
xorgcfg
```

**Note.** When configuring, please remember you are specifying video card, its memory and screen resolution for the virtual machine, not for the host computer.

1. For the virtual machine video card select *Generic VESA compatible.*
2. Select **4096K** of video memory (that is the default value for Parallels virtual machines). If you changed the amount of video memory for your virtual machine in Configuration Editor, select the current value.
3. When selecting screen resolution for a color depth, make sure that the selected resolution for a particular color depth does not require more memory than the virtual machine’s video card has. For **4096K** video card do not select resolutions greater than **800x600** for 16-bit color.

### Installing Parallels Tools

Parallels Workstation includes specially developed tools that help you use your virtual machines in the most comfortable and efficient way. The current version of Parallels Workstation is supplied with tools for the following guest operating systems:

- OS/2 and eComStation.
- Solaris. The PRL8029 driver for is available for Solaris guest OS, you should install it if you want the Solaris virtual machine to support networking.
- For other guest operating systems the PRL8029 network adapter driver is available.

For Windows operating systems starting Windows 2000, Tools are installed via the **Install Parallels Tools** command in the **VM** menu. Tools available for other operating systems must be installed manually.

Parallels Tools are located on the CD image **VMTOOLS.ISO**; the network drivers for OS/2 are also located on the floppy disk image - **VMTOOLS.FDD.** Both CD and floppy images can be found in the folder where Parallels Workstation was installed. By default, it is **C:\Program Files\Parallels\Parallels Workstation.**
Parallels Tools Overview

Clipboard Synchronization Tool

Clipboard Synchronization Tool synchronizes the guest OS clipboard and the primary OS clipboard, thus making the exchange of texts and pictures via clipboard possible. Currently, you can transfer only text up to 128KB in size.

If you enable Clipboard Synchronization Tool in each of your guest OSes, they will share the same clipboard with the primary OS.

In all the Windows guest OSes, this tool is installed automatically when you perform Parallels Tools installation. In OS/2 and eComStation you must install it manually.

Disk Compacting Tool

Parallels Workstation uses virtual hard disks of two types: plain and expanding. Expanding virtual disks grow in size as you work with them. Disk Compacting Tool cleans up unused space on an expanding virtual disk and reduces the size of that disk in the primary OS. See Compacting Virtual Disk (page 113) for guidelines on using this tool.

Note. This tool does not reduce the size of plain virtual disks.

Mouse Synchronization Tool

Mouse Synchronization Tool provides automatic capture of the mouse input each time the pointer goes over the guest OS window and automatic release of the mouse input when the pointer moves out of the guest OS window. This tool also makes pointer movements smoother.

Dynamic Resolution Tool

Dynamic Resolution Tool enables you to work with dynamic resolution. When you switch to Full Screen mode, the guest OS window resolution changes automatically.

Network Adapters and Drivers

Parallels Tools provide the following adapters:

- **Parallels Network Adapter.** This Ethernet driver for the RTL8029 adapter is specially developed for Parallels Workstation to improve network performance. We recommend that you install this driver whenever possible.

- **RTL8029.** The image of CD with Parallels Tools includes native Realtek™ drivers for the RTL8029 network adapter for many different operating systems, except Solaris. They are located in the \Drivers\Network\RTL8029 folder of the vmtools.iso CD image.

Some guest operating systems such as Windows 2000, provide an RTL8029 driver, whereas others like Windows 2003 and OS/2 do not include this driver at all.

Note. Unlike other guest OSes, a Solaris guest OS requires an RTL8029-compatible driver to support networking. Otherwise, networking will not be unavailable.
An RTL8029-compatible driver for Solaris was created by an independent developer and is distributed under the terms of BSD license. A slightly modified version of this driver is included into the Parallels Tools.

**Shared Folders Tool**

This tool is needed for a guest OS to view shared folders in the primary operating system. To learn more about shared folders, see Using Shared Folders (page 184).

**Sound Driver**

Parallels Tools package includes an AC'97 sound driver for those guest operating systems that do not have a standard AC'97 driver. Sound drivers for Windows XP/2003 are not included in the Parallels Tools pack, since these operating systems have sound drivers in their installations.

**Time Synchronization Tool**

Time Synchronization Tool enables you to configure time settings on your guest OS. With this tool you can:
- synchronize time between your host and guest OS
- set up and maintain time difference between your host and guest OS

For instructions on using the tool, see Time Synchronization Tool Options (page 106) for Windows guest OSes and Parallels Tools for Linux (page 112) for Linux guest OSes.

**Note.** If you installed other time synchronization software, stop it before installing Parallels Tools in order to avoid potential conflicts.

**Video Driver**

The best graphical mode available in Windows NT and Windows 2000 guest operating systems without this driver is 16-color VGA with 640x480 resolution. The video driver allows Parallels Workstation to use SVGA graphical modes in guest OS monitors.

In Windows XP/2003 the video driver is required for the mouse tool and is chosen automatically when you select the mouse tool installation.

**Note.** If you install the video driver, you will not be able to use VGA modes. To return to VGA, you must uninstall the Parallels Tools.

### Parallels Tools Availability

The table below shows what tools are available for different guest operating systems.

<table>
<thead>
<tr>
<th>Windows</th>
<th>OS/2, eCS</th>
<th>Solaris</th>
<th>Linux</th>
<th>other</th>
</tr>
</thead>
<tbody>
<tr>
<td>95, 98, NT, ME, 2000</td>
<td>XP, 2003</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Creating a Virtual Machine

<table>
<thead>
<tr>
<th>Feature</th>
<th>+</th>
<th>+</th>
<th>+</th>
<th>+</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipboard Synchronization Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time Synchronization Tool</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Dynamic Resolution Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Video Driver</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Mouse Driver</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Sound Driver</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Shared Folders Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk Compacting Tool</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Network Drivers:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Parallels Network Adapter Driver</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- RTL8029</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
</tbody>
</table>

### Installing Parallels Tools in Windows Guest OS

To install Parallels Tools in Windows guest OS do the following:

1. Make sure that the virtual machine configuration includes a CD/DVD-ROM drive and it is enabled.
2. Start your guest operating system and log in.
3. Select Install Parallel Tools from the Parallels Workstation VM menu.
5. In the Choose Destination Location window click Next to install Tools to the default folder. To select another folder use the Change button. Then click Next.
6. Choose between the complete setup and a custom one in the Setup Type window. The complete setup installs all of the tools available for your guest OS. If you select custom setup, the Select Components window prompts you to select the desired tools from the list of tools available for your guest OS.
7. Choose the program folder in the Select Program Folder window.
8. In the Check Setup Information window review the selected options. If they are correct, click Next to start the installation.
9. By default, a Windows operating system is configured to warn you every time an unsigned driver is installed. Parallels Tools installation wizard prompts you to temporarily disable these warnings.
When you receive the following message: "Parallels Tools installation contains a number of unsigned drivers. These drivers are required for proper functioning of Parallels Tools. Currently your system is configured to warn you every time an unsigned driver is installed. Do you want to receive these warnings during Parallels Tools installation?" click OK to disable the unsigned driver warnings during Parallels Tools installation. They will be re-enabled later when the installation is complete.

10 When the wizard finishes copying files, the **Installation Completed** window appears. In all of the Windows guest OSes, except Windows 98 and Windows NT, you must restart the virtual machine after the setup. Accept the selected option and click **Finish**. The virtual machine will be restarted.

**Note.** On Windows NT and Windows 98 guest OS, you will need to install some tools manually. For details, see Installing Sound Driver in Windows 98 (page 80) and Installing Parallels Tools in Windows NT (page 81).

### Troubleshooting When Installing Tools

Parallels Tools installation is invoked by Windows AUTORUN feature for CD/DVD-ROM drive. It is enabled by default, however, if you have disabled it manually, nothing happens after you select the **Install Parallels Tools** command. (Anyway, the `vmtools.iso` CD image will be connected to the virtual machine CD-ROM drive, although it is not visible to the user.) To solve this problem do one of the following:

- Enable AUTORUN function for CD-ROM drive in guest Windows.
- Start tools installation manually.

Open the contents of the `vmtools.iso` in Windows Explorer, find `PrlTools.exe` file, and start it.

### Troubleshooting when installing Tools

If, after you choose the **Install Parallels Tools** command from the **VM** menu, the installation of Parallels Tools doesn't start automatically, follow these steps:

1 Make sure that the `vmtools.iso` file is connected to the virtual machine CD-ROM drive.

2 Start Tools installation manually. For this, open the contents of the `vmtools.iso` in Windows Explorer, find `PrlTools.exe` file, and double-click it to start it.

### Installing Sound Driver in Windows 98

The Sound Driver for a Windows 98 guest OS must be installed manually after the general Parallels Tools installation is complete.

To install AC’97 Sound Driver in Windows 98:

1 Open the Control Panel. To do this, click the system **Start** menu, select **Settings**, and then **Control Panel**.

2 Double-click the System icon to open the System Properties window.
3 Select the Device Manager tab.

4 Locate the PCI Multimedia Audio Device in the hardware list. Select it and click the Properties button.

5 In the PCI Multimedia Audio Device Properties window click the Reinstall Driver button.

6 In the Update Device Driver Wizard select the Sound, video and game controllers item and click Next.

7 In the next window select the option: Display a list of all the drivers in a specific location, so you can select the driver you want, and click Next.

8 Then select the type of device and click the Next button.

9 In the next window click the Have Disk button. The Install From Disk window is opened, in the Copy manufacturer's file from: field type the following path "C:\Program Files\Parallels\Parallels Tools\Sound" and click OK.

10 In the Select Device window select the AC'97 Audio and click OK.

11 In the Update Device Driver Wizard window click Next. When prompted, insert the Windows 98 installation disc (or connect CD-ROM image file) and specify the path to it in the Copy files from field. Click OK. After the wizard finishes copying the files, click Finish in its window.

12 Close the windows with AC'97 audio properties and system properties.

13 Restart the virtual machine if prompted.

**Installing Parallels Tools in Windows NT**

To install Parallels Tools in Windows NT:

- Perform the installation procedure described in the Windows Tools Installation (on page 79) topic. Install Clipboard Synchronization and Mouse Synchronization Tools only.
- Perform these specific steps for installing the Video Driver and Sound Driver:

**Video Driver Installation**

To install the Video Driver do the following:

1 Open the Control Panel. For this click the Start system menu, select the Settings item, and then Control Panel.

2 Double click the Display icon to open the Display Properties window.

3 In the Display Properties window select the Settings tab. Then click the Display Type button.

4 In the Display Type window select the Change button.

5 In the Change Display window select the Manufacturers -> Parallels and Display -> Parallels Video Driver. Click OK.

6 In the Third-party Drivers window click Yes.

7 Installing Driver window informs you about successfully completed installation. Click OK.

8 Click the Close button in the Display Type window.

9 Click the Close button in the Display Properties window.

10 Click the Yes button in the System Settings Change window to restart the guest OS.
Note: You must restart the virtual machine after the setup.

**AC'97 Sound Driver Installation**

To install AC'97 Sound Driver do the following:

1. Open the Control Panel. For this click the system **Start** menu. Then select **Settings -> Control Panel**.
2. Double-click the **Multimedia** icon.
3. In the **Multimedia Properties** window select the **Devices** tab. Then select the **Audio Devices** from **Multimedia devices** list. Click the **Add** button.
4. In the **Add** window, select the **Unlisted or Updated Driver** from **List of Drivers**. Click **OK**.
5. In the **Install Driver** window click the **Browse** button and select the path to the sound driver.
   - If you installed Parallels Tools in the default location, select `C:\Program Files\Parallels\Parallels Tools\Sound`.
   - If you installed Parallels Tools in another folder, locate that folder.
   - Click **OK**. Then click **OK** in the **Install Driver** window.
6. In the **Third-party Drivers** window click **Yes**.
7. The **Add Unlisted or Updated Driver** window informs you that you are about to install the AC'97 Audio Driver. Click **OK**.
8. Click **OK** in the **About AC97 Audio Driver** window.
9. Click **OK** in the **System Settings Change** window.
10. Click **Close** button in the **Display Type** window.

**Note:** You must restart the virtual machine to complete the setup.

**Installing Parallels Tools in Linux Guest OS**

Parallels Tools are now available for Linux guest OSes with X.org 6.7 or later.

**Warning**: Before starting Parallels Tools installation, close all applications to prevent data loss during possible X-Server restart. If the X-Server doesn't respond after Parallels Tools installation or update, restart your virtual machine.

**To install Parallels Tools**

1. Start the virtual machine.
2. Press **Control+Option(Alt)** to release the keyboard and mouse input to your primary operating system. From the **VM** menu, choose **Install Parallels Tools**. The ISO image of Parallels Tools installation CD (`vmtools-linux.iso`) will be connected to the virtual machine.
3. Click anywhere in the guest OS window to capture the keyboard and mouse input in the guest OS.
4. Start the terminal.
5  Make sure the CD-ROM is mounted.

6  Change the directory to the CD-ROM and start the installer by entering

```
sh parallels-tools.run
```

**Note.** You must have root privileges to run the command.

Wait while Parallels Tools are being installed.

7  Restart the virtual machine.

**Troubleshooting**

For successful functioning of some of Parallels Tools, the **prluserd** service is needed. The service must be started on the guest OS startup. In most Linux guest OSes, the appropriate command is added to the startup script automatically during the installation of Parallels Tools.

To check that the service is running, enter the following command:

```
ps -A | grep prluserd
```

If the startup scripts in your system are bsd-like (e.g. slackware, zenwalk), you have to run **prluserd** manually or add the command which starts the **prluserd** service to the init script. You must have root privileges to run the service.

**Installing Solaris Network Driver**

Unlike other guest OSes Solaris does not support the RTL8029 network driver emulated in virtual machines. To add RTL8029 support to a Solaris virtual machine you need to install the RTL8029 network adapter driver. We have created the special **network.sh** script that helps you to do this, or you may install and configure the driver manually. Both ways are described below.

**Before Installing the Driver**

Before installing the driver perform the following steps:

1  Make sure that the virtual machine configuration includes a CD/DVD-ROM drive and it is enabled. See CD/DVD-ROM Options (on page 129).

2  Start your guest operating system.

3  Connect the CD image with tools, **vmtools.iso**, to the CD/DVD-ROM drive of the virtual machine:

   - right-click the CD/DVD-ROM icon on the status bar and select the **Connect image** menu item (instead you may select **Devices/CD/DVD-ROM <number>** -> **Connect Image** in the Parallels Workstation menu);

   - browse for **vmtools.iso** in the folder where you installed Parallels Workstation.

Proceed to installing the RTL8029 network driver using the **network.sh** script or manually.

**To install RTL8029 network driver using **network.sh** script:**

1  In the shell, run the
To install RTL8029 network driver manually:

1. In the shell, issue the following command to get root privileges:

```
su
```

Enter the password to the root account when you are asked for it.

2. As a root run the following commands:

```
cd /tmp

gzcat /cdrom/PRLTOOLS/Drivers/Network/RTL8029/SOLARIS/ni0.8.11.tgz|tar
xf -
cd ni-0.8.11
/usr/ccs/bin/make install
./addni.sh
```

3. If IP addresses on your network are managed by the DHCP server issue the following commands:

```
touch /etc/hostname.ni0
touch /etc/dhcp.ni0
```

If the IP addresses on your network are NOT managed by the DHCP server, see the Solaris System Administration Guide.

4. Leave the root account by entering the command:

```
exit
```

5. Restart the guest operating system by issuing the command

```
init 6
```
Installing OS/2 and eComStation Tools

All of the OS/2 and eComStation tools can be installed from the `vmtools.iso` CD image. Network drivers can also be installed from the floppy disk image file `vmtools.fdd` during operating system installation. The latter is easier in most cases.

Before starting the installation you should connect the CD-ROM image with Parallels Tools to your virtual machine's CD-ROM drive. Do the following:

- Select **Install Parallels Tools** in the Parallels Workstation VM menu.

**Mouse Synchronization Tool Installation**

The Mouse Synchronization Tool consists of the mouse driver and the video filter. To install the Mouse Synchronization Tool you should have a VESA video driver installed, such as SDD or GENGRAID. For instructions on how to do this, refer to OS/2 documentation.

To install the Mouse Synchronization Tool:

1. Click the **Drives** icon on the system panel. Select the CD-ROM drive and locate the **Drivers\Mouse\OS2** directory.

   **Note.** When installing the driver on the eComStation, go to the **Drivers\Mouse\ECS12** directory.

2. Launch the `INSTALL.CMD` batch file. The `INSTALL.CMD` copies files and makes necessary modifications to the `CONFIG.SYS` file.

3. Restart the guest OS/2 operating system.

**Clipboard Synchronization Tool Installation**

In OS/2 and eComStation you have to launch the Clipboard Synchronization Tool manually. This tool is an ordinary application, and should be treated as such. If you want the Clipboard Synchronization tool to start automatically when your guest operating system is started:

- include the tool file `PrlClip.exe` into autostart group (**startup.cmd** file or another file used in the guest operating system for similar purposes).

The Clipboard Synchronization Tool is located in the `ClipBrd\OS2` directory on the CD-ROM containing Parallels Tools.

**Sound Driver Installation**

Before installing the Sound Driver, make sure you have multimedia support installed in OS/2 guest OS.

To install the Sound Driver:

1. Click the **System Setup** icon on the system panel.

2. Select **Install/Remove** line, and then select **Multimedia Application Install**.

3. In the IBM Multimedia Presentation Manager/2 - Installation window choose CD-ROM drive, then **Drivers\Sound\OS2** directory. Select the ALC Codec feature and click the **Install** button.
4 Restart the OS/2 guest operating system.

**Network Driver Installation**

To install Realtek RTL8029 driver inside the OS/2 Warp version 4.0:

1 Click the **System Setup** icon on the system panel.

2 Click the **MPTS Network Adapters and Protocol Services** icon to open the **Multi-Protocol Transport Services** window.

3 Click **Configure**.

4 In the window that appears, click **Configure** again.

5 In the **Adapter and Protocol Configuration** window click the **Other adapters** button below the **Network Adapters** section.

6 In the **Copy Additional Network Adapter Drivers** window specify the path to the Parallels driver on CD-ROM disc image. The path will be like the one below:
   
   `<CD-ROM drive>\Drivers\Network\RTL8029\NDIS2OS2`

7 Click **OK**. The Parallels network adapter driver will be copied. After this you can see the name **RTL8029 PCI Ethernet Adapter** included in the **Network Adapters** list. Select this name.

8 Click **Change** in the **Network Adapters** section of the window to replace the current network adapter by the selected one.

9 Click **OK** when the message "Are you sure you want to change this network adapter?" is displayed. After you click OK, the **RTL8029 PCI Ethernet Adapter** appears in the appropriate field of the **Current Configuration** section of the window. Now if you click **Edit** in the **Current Configuration** section of the window, you will see that you do not need to configure any properties for this driver, because it is self-configurable.

10 Click **OK** when finished.

11 Close both the **Configure** and **Multi-Protocol Transport Services** windows.

12 Click **Exit** in the **Update CONFIG.SYS** window.

13 Exit the configuration program and restart the guest OS.

**Upgrading Parallels Tools**

Whenever you upgrade Parallels Workstation, upgrade Parallels Tools in the existing virtual machines.

To upgrade Parallels Tools:

1 Make sure that the virtual machine configuration includes a CD/DVD-ROM drive and it is enabled (the **Enabled** check box is selected). See the CD/DVD-ROM Options (on page 129).

2 Start your guest operating system and log in. In order to install tools properly do not begin the installation until the guest OS completes its startup and you log in.

3 Select **Install Parallel Tools** from the Parallels Workstation VM menu.

4 Parallels Tools Setup wizard starts and informs you that you that Parallels Tools installed in your virtual machine will be updated. Click **Next**.
5 In the **Setup Type** window choose between the *complete* setup and a *custom* one. The *complete* setup installs all of the tools available for your guest OS. If you choose *custom* setup, in the **Select Components** window select the desired tools from the list of the tools available for the guest OS.

6 In the **Ready to Install the Program** window review the installation settings. Click the **Install** button to start the installation.

7 If the Windows guest operating system is configured to warn you every time an unsigned driver is installed, you will receive the following message: "Parallels Tools installation contains a number of unsigned drivers. These drivers are required for proper functioning of Parallels Tools. Currently your system is configured to warn you every time an unsigned driver is installed. Do you want to receive these warnings during Parallels Tools installation?" Click **OK** to disable warnings during Parallels Tools installation. They will be re-enabled later when the installation is complete.

If your system is configured to block the unsigned drivers installation, you receive the similar message prompting you to allow these drivers installation. Click **OK**, otherwise Parallels Tools can not be installed.

8 The wizard copies the files. When finished, the **Update Completed** window appears. You are prompted to restart the virtual machine. Accept the selected option and click **Finish**.

*Note.* Parallels Tools will not function properly until the virtual machine is restarted.

**Windows NT**

In Windows NT guest OS, **readme** files for installation of the video and audio drivers will be open. Close them since re-installation of the drivers is not required.

---

**Uninstalling Parallels Tools in Windows Guest OS**

In all Windows guest operating systems you can uninstall Parallels Tools by using the general program removing procedure.

For example, in Windows XP Professional:

1 Click **Start -> Control Panel - > Add / Remove Program** (or **Start -> Settings -> Add Remove Programs** depending on the selected appearance of the guest OS).

2 Select Parallels Tools from the list of programs installed.

3 Click **Remove**.
Uninstalling Parallels Tools in Linux Guest OS

To uninstall Parallels Tools:

1. Start the virtual machine.

2. Press **Control+Option(Alt)** to release the keyboard and mouse input to your primary OS. Locate the ISO image file (**vmtools-linux.iso**) of Parallels Tools.

3. Connect the image to the CD-ROM drive by clicking the **CD/DVD-ROM** icon on the status bar and selecting **Connect Image** from the shortcut menu.

4. Click anywhere in the guest OS window to capture the keyboard and mouse input in the guest OS.

5. Start the terminal.

6. Mount the CD-ROM to the guest OS file system.

7. Change the directory to the CD-ROM and run the uninstaller by the following command:

   ```
   sh prl-tools-uninstall.sh
   ```

   **Note.** You must have root privileges to run the command.

8. Restart X-Server or the virtual machine.
CHAPTER 8

Running a Virtual Machine

This chapter explains how to start, stop, suspend or pause a virtual machine. It also provides the information on actions you can perform with the virtual machine while the guest operating system is running.

In This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>90</td>
</tr>
<tr>
<td>Selecting and Opening Virtual Machine</td>
<td>91</td>
</tr>
<tr>
<td>Starting a Virtual Machine</td>
<td>91</td>
</tr>
<tr>
<td>Capturing and Releasing the Keyboard and the Mouse</td>
<td>93</td>
</tr>
<tr>
<td>Shutting Down and Resetting Virtual Machine</td>
<td>94</td>
</tr>
<tr>
<td>Pausing Virtual Machine</td>
<td>95</td>
</tr>
<tr>
<td>Suspending and Resuming Virtual Machine</td>
<td>95</td>
</tr>
<tr>
<td>Switching Virtual Machine to Full Screen Mode</td>
<td>96</td>
</tr>
<tr>
<td>Keyboard Shortcuts in Virtual Machine</td>
<td>97</td>
</tr>
<tr>
<td>Running a Virtual Machine in Fullscreen Mode</td>
<td>98</td>
</tr>
<tr>
<td>Changing Configuration at Runtime</td>
<td>98</td>
</tr>
<tr>
<td>Parallels Tools for Windows</td>
<td>104</td>
</tr>
<tr>
<td>Parallels Tools for Linux</td>
<td>112</td>
</tr>
<tr>
<td>Compacting Virtual Disk</td>
<td>113</td>
</tr>
<tr>
<td>Maintaining Virtual Hard Disks</td>
<td>114</td>
</tr>
<tr>
<td>Setting up a Printer in a Virtual Machine</td>
<td>115</td>
</tr>
</tbody>
</table>
Overview

When you start a virtual machine, its Property Page transforms into the virtual machine console and acts as a display of a real computer (refer to Console View (on page 51)). You must capture your keyboard and mouse input in the console window by clicking anywhere in the window; after that you can work in the guest OS. To release the mouse and keyboard input from the guest OS to the primary OS press Ctrl+Alt.

Parallels Workstation controls such as the toolbar and the menu allow you to control the virtual machine when it is running in window mode. You may also run the virtual machine in full screen mode, when Parallels Workstation controls and the primary operating system are not visible.

While working in window mode, Parallels Workstation controls let you to do the following:

- Start, turn off and reset virtual machine.
- Pause or suspend virtual machine.
- Switch between the guest OS and the primary OS.
- Connect and disconnect devices at runtime and change media connected to them.
- Temporarily disable Parallels Tools Center in a Windows guest OS (if you installed Parallels Tools).
- Switch to full screen mode and back.
- View the Property Page of the virtual machine. Configuration Editor is not available while the virtual machine is running.
Selecting and Opening Virtual Machine

When you start Parallels Workstation, the last used virtual machine is opened by default. This option is controlled by the Load recently used VM at startup setting on the Common tab (page 170) of the Preferences window. You may turn this option off to start Parallels Workstation with Startup Options dialog, then the last used virtual machine can be opened via the Recently Used list.

Opening Recently Used VM

The File menu includes the list of recently used configurations. The list contains six last used configuration files. Use this method to open the virtual machine you recently worked with.

If the required virtual machine is not shown in the Recently Used list, you may find it manually browsing the hard disk for the configuration file.

Opening a Virtual Machine When Other is Running

You may open an additional instance of the Parallels Workstation using the menu. To do this:

- Choose New Window from the File menu.
- If Parallels Workstation is configured to load the last used virtual machine on startup, the last used VM is already run by another instance of Parallels Workstation. A new window is opened either with the Startup Options (page 47) dialog (if the Show startup dialog option is selected on the Common tab of the Preferences window), or with a blank virtual machine.
- Select the virtual machine or create a new one.

Starting a Virtual Machine

Note. The virtual machine can be powered on only if you activated your copy of the Parallels Workstation with permanent or trial activation key. See the Activating Parallels Workstation (page 26) section.

To start a virtual machine:

2. Select a virtual machine from the Startup dialog. Open a virtual machine Property Page.
3. Do one of the following:
   - Click the Power On button on the Parallels Workstation toolbar.
- Select **Power On** in the **VM** menu.

The virtual machine will be turned on, and you will see the boot process of the guest OS on the virtual machine console.

**Note.** It is not recommended that you start your virtual machines from an external storage device, this may result in low performance and unsteady operation.

**Troubleshooting**

**In Windows Primary OS**

If, when starting a virtual machine in Windows primary OS, you receive the warning "Parallels Workstation has detected that your primary operating system is running in PAE mode...", this means that your host computer configuration does not conform to Parallels Workstation requirements. The current version of Parallels Workstation supports up to 4 GB PAE only. To bypass this problem:

- Follow Parallels Workstation dialog boxes to create a new configuration with 4 GB PAE.
- Boot into this configuration. When starting the Windows primary OS, in the Please select the operating system to start window choose the configuration with the following comment: "(for Parallels Workstation)".

In the future, boot into the Windows configuration without PAE to work with Parallels Workstation.

**In Linux Primary OS**

When starting or running a virtual machine in Linux primary OS you may receive the following warnings:

- "Parallels Workstation can not be started due to VM memory mapping failure..."
- "Parallels Workstation experience problem when trying to allocate physical memory in PAE mode...",

It means that the currently running kernel supports PAE greater than 4 GB. The current version of Parallels Workstation supports up to 4 GB PAE only.

To fix the problem you have to change the auto-detected PAE value to 4096MB. Do the following:

- Add to the boot loader the kernel option "mem=4096M" (refer to your boot loader documentation for details).
Capturing and Releasing the Keyboard and the Mouse

This section explains how to capture input devices for the guest OS and how to release them to the primary OS.

When you power on a virtual machine, you have to capture the input of such input devices as mouse or keyboard in the virtual machine to work in the virtual machine. To access Parallels Workstation’s menu and toolbar or to work with applications in the primary operating system you have to release their input to the primary OS.

To capture the keyboard and mouse input in the virtual machine window, do one of the following:

- Click anywhere in the guest OS window. When the mouse input is captured, the cursor cannot be moved out of the Parallels Workstation window.
- Select Capture Input in the VM menu.
- Press Ctrl+I on your keyboard.

To release the keyboard and mouse input to your primary OS:

- Press the hot key combination designated for releasing your keyboard and mouse (the default combination is Ctrl+Alt).

The default hot key combination for releasing the keyboard and mouse can be changed on the Hot Key Combinations (page 176) tab of the Preferences window.

After Parallels Tools Installation

Parallels Tools are available for most of the Windows and Linux guest operating systems. See the Parallels Tools Overview (page 77) to learn if this package is available for the specific guest operating system.

After Parallels Tools installation, you can switch the control over mouse and keyboard input more easily:

- to capture - click anywhere in the Guest OS window,
- to release - click anywhere outside the Guest OS window.
Shutting Down and Resetting Virtual Machine

To turn off/reset a virtual machine use the same rules as to turn off/reset a physical computer.

Stopping a Virtual Machine

First, shut down the guest operating system by using the guest OS "shutdown" command (such as Start -> Shut Down or Start -> Turn off Computer in Windows). It is STRONGLY RECOMMENDED that you shut down the machine in this way to ensure safety of your data. Then close the application window.

Only if you are unable to stop the guest OS this way, you may use the Parallels Workstation controls to stop or to reset it.

To stop the virtual machine anyway, do one of the following:

- Click the Power Off button on the Parallels Workstation toolbar.
- Select Power Off from the VM menu.

The virtual machine will be stopped immediately.

Resetting a Virtual Machine

First, restart a guest operating system by using the guest OS "restart" command (such as Start -> Shut Down -> Restart or Start -> Turn off Computer -> Restart in Windows). It is STRONGLY RECOMMENDED that you restart the machine in this way to ensure safety of your data.

Only if you are unable to restart the guest OS this way, you may use the Parallels Workstation controls to stop or to reset it.

To reset the virtual machine, do one of the following:

- Click the Reset button on the Parallels Workstation toolbar.
- Select Reset from the VM menu.
- Press Ctrl+Alt+Insert while the keyboard input is captured inside the virtual machine window.
Pausing Virtual Machine

When a virtual machine is paused, the guest OS is stopped and the virtual machine process is removed from the CPU processes list. The current state of the virtual machine is saved in the .sav file. Guest operating system execution can be continued at any time.

Pausing the guest OS is recommended if you want to leave the virtual machine for a short period of time. If you want to leave it for an extended period, and especially if you need to restart your primary OS, it is best to suspend the VM.

To pause a virtual machine:

- Select Pause from the VM menu.

When a virtual machine is in pause mode its console is dimmed.

To continue running the virtual machine do one of the following:

- Click the Power On button on the toolbar.
- Select Continue in the VM menu.

Suspending and Resuming Virtual Machine

A running virtual machine can be suspended. That means that the current state of the running virtual machine, and its applications can be saved at any time in order to resume working with the guest OS at a later time. The virtual machine will be stopped in a special way and its state will be saved to the hard disk in a .sav file. After that, you may return to the suspended virtual machine at any time and continue running the guest OS from the point where it was stopped.

Suspending a Virtual Machine

To suspend a virtual machine:

1. While the guest OS is running do one of the following:
   - Click the Suspend button,
   - Select Suspend from the VM menu.

2. Progress of saving is displayed in the Please wait while virtual machine is suspending window. When finished, the virtual machine's Property Page is displayed.
Resuming a Suspended Virtual Machine

To resume a suspended virtual machine:

1. Open the virtual machine.
2. Do one of the following:
   - Click the Power On button.
   - Choose Power On from the VM menu.
3. Wait until the guest OS state is resumed. Progress is displayed in the Please wait while virtual machine is resuming window.

After the virtual machine is resumed, its .sav file is deleted.

Switching Virtual Machine to Full Screen Mode

You can run a guest operating system in full screen mode with the guest OS console window occupying the whole screen of your computer. In full screen mode the primary OS and its applications as well as the Parallels Workstation menu, toolbar, and status bar are not visible.

To switch to full screen while running a guest OS, do one of the following:

- Click Fullscreen Mode toolbar button.
- Choose Fullscreen from the View menu.
- Press the hot key combination (Alt+Enter by default, unless you defined another one).

To return to window mode:

- press any of the hot key combinations defined (Ctrl+Alt or Alt+Enter by default).

Hot key combinations are defined on the Hot Key Combinations tab of the Preferences window.

You may adjust resolution of the monitor for full screen mode. See User Interface Preferences (page 174) for more information.

Note: You can configure your virtual machine to start in full screen mode right away. Select the Switch to full screen mode automatically option on the VM Flags (page 121) tab in Configuration Editor.
Keyboard Shortcuts in Virtual Machine

If when working in the virtual machine, you press a special key combination intended for the guest OS (for example, Ctrl+Alt+Del for any of the Windows guest operating systems) the primary operating system may intercept such a command. That is why the standard hot key combinations for using in a virtual machine are replaced according to the rules below.

When the Primary OS is Windows

If your computer is running any of Windows primary OSes, the primary OS will intercept the Ctrl+Alt+Del key combination pressed in the guest OS. To send Ctrl+Alt+Del to the guest OS:

- press Ctrl+Alt+Ins while the keyboard input is captured inside the virtual machine window,
- or select Send Ctrl+Alt+Del from the Parallels Workstation VM menu.

When the Primary and Guest OSes are Linuxes

When both primary and guest operating systems are Linuxes, to send standard hotkey combinations to the guest Linux OS:

- press the Shift key instead of the Alt key in standard key combinations. For example, to send Ctrl+Alt+Backspace to the guest Linux OS, press Ctrl+Shift+Backspace. The primary Linux OS will not intercept this combination while the guest Linux OS will interpret it as Ctrl+Alt+Backspace.

The table below shows how to transform a hotkey combination to use it in the Linux guest OS.

<table>
<thead>
<tr>
<th>Desired Hotkey</th>
<th>Combination to Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Alt+Backspace</td>
<td>Ctrl+Shift+Backspace</td>
</tr>
<tr>
<td>combinations starting Ctrl+Alt+F1 through Ctrl+Alt+F12</td>
<td>Ctrl+Shift+F1 through Ctrl+Shift+F12</td>
</tr>
<tr>
<td>Ctrl+Alt+&lt;&gt; or Ctrl+Alt+&lt;&gt;</td>
<td>Ctrl+Shift+&lt;&gt; or Ctrl+Shift+&lt;&gt;</td>
</tr>
</tbody>
</table>
You can run a guest operating system in full screen mode with the guest OS window occupying the whole screen of your computer. In full screen mode the primary OS and its applications as well as the Parallels Workstation menu, toolbar, and status bar are not visible.

To switch to full screen while running a guest OS, do one of the following:

- Click **Fullscreen Mode** toolbar button.
- Select **View -> Fullscreen** in the menu.
- Press the hot key combination (Alt+Enter by default, unless you defined another one).

To return to window mode:

- press any of the hot key combinations defined (Ctrl+Alt or Alt+Enter by default).

Hot key combinations are defined on the **Hot Key Combinations** tab of the **Preferences** available from the **Edit** menu.

You may adjust resolution of the monitor for full screen mode. See **Setting Parallels Workstation Preferences** (page 169) for more information.

**Note:** You can configure your virtual machine to start in full screen mode right away. Select the **Switch to fullscreen mode automatically** option on the **VM Flags** tab in Configuration Editor.

### Changing Configuration at Runtime

Although Configuration Editor (on page 118) cannot be accessed while a virtual machine is running, you can connect /disconnect certain devices at runtime or change the media they are using.

This section describes how to handle devices at runtime.
Overview

Generally, the following virtual devices can be connected/disconnected at runtime:

- CD/DVD-ROM drives
- Floppy disk drive
- Network adapter
- Parallel ports
- Serial ports
- Sound device
- USB devices

Only the devices that are enabled in the virtual machine configuration can be connected or disconnected at runtime. To enable a device stop the virtual machine, then enable the device in the Configuration Editor and start the virtual machine. After that, the device can be connected or disconnected at runtime.

The devices configurable at runtime can be configured in the following ways:

- by using commands from the Devices menu in the menu bar;
- by clicking a device icon on the status bar and choosing command from the device shortcut menu.

USB Devices

If you start the virtual machine with the USB controller enabled, you may connect various real USB peripherals to the virtual machine. The USB controller itself can not be connected or disconnected.

To Enable a Device

1. Stop the virtual machine.
2. Open Configuration Editor.
3. In the Device Status section select the Enabled option. Click the Save button to save changes in the configuration. Close Configuration Editor.
4. Start the virtual machine. The device can be connected or disconnected at runtime.
Connecting CD/DVD-ROM Drive

When running a virtual machine with a CD/DVD-ROM drive you can:

- Connect or disconnect the CD/DVD-ROM drive temporarily.
- Change the media accessed by the CD/DVD-ROM drive.

If the virtual machine has several CD/DVD-ROM drives in the configuration, the drives are numbered in the following way:

- **Windows primary OS.** The CD/DVD-ROM drives connected to your virtual machine are identified according to their IDE channels (CD/DVD-ROM 00 means connected to IDE 0:0, CD/DVD-ROM 01 means connected to IDE 0:1 and so on).
- **Linux primary OS.** The drives are numbered according to the order they were connected. The first of the connected CD/DVD-ROM drives will be CD/DVD-ROM 1, the second - CD/DVD-ROM 2 and so on.

To Connect / Disconnect CD/DVD-ROM Drive

Do one of the following:

- Choose CD/DVD-ROM <number> from the Devices menu. Select the Connect or Disconnect command from the submenu.
- Enable or disable a CD/DVD-ROM drive using the context menu of the CD/DVD-ROM drive on the status bar.

To Change Media Accessed by the CD/DVD-ROM Drive

Do one of the following:

1. Choose CD/DVD-ROM <number> from the Devices menu. Select Connect to <drive letter> to access the real CD/DVD-ROM drive or Connect image to access an image file.
2. Right-click the CD/DVD-ROM icon on the status bar and choose the command from the device context menu.

Connecting Floppy Drive

If you start a guest operating system with the floppy drive enabled, you may connect or disconnect it and change its options while running the guest OS. Parallels Workstation allows you to:

- connect or disconnect floppy drive,
- change media that floppy drive access.

While the guest OS is using the floppy disk inserted into the floppy drive, the primary OS cannot access the floppy disk.

Connect or Disconnecting Floppy Drive

To connect or disconnect the floppy drive, do the following:

1. Choose Floppy <drive letter> from the Devices menu.
2 Select the Connect or Disconnect command to connect or disconnect the CD/DVD-ROM drive respectively.

**Note.** You may also connect /disconnect a floppy drive using the context menu of the floppy drive icon on the status bar.

### How to Change Media Accessed by Floppy Drive

The floppy drive can use a real floppy disk or an image file. To change the media accessed by the floppy drive:

1. Choose Floppy <drive letter> from the Devices menu.
2. Select Connect to <drive letter> to access the real CD/DVD-ROM drive or Connect image to access an image file.

**Note:** You may also change the media using the commands from the context menu of the floppy drive icon on the status bar.

### Connecting Network Adapter

When running a virtual machine with a network adapter you can:

- connect or disconnect the network adapter,
- switch between different adapters of your host computer and host-only networking mode.

#### Connecting or Disconnecting Network Adapter

To connect or disconnect network adapter, do the following:

1. Choose Network from the Devices menu.
2. Select the Connect or Disconnect command to connect or disconnect network adapter respectively.

**Note.** You may also connect or disconnect a network adapter using the context menu of the network adapter icon on the status bar.

### Switching Between Physical Adapters

To switch a network adapter of the virtual machine for using another physical adapter:

1. Check what network adapter the virtual machine is now using.

   To learn this click the network adapter icon on the status bar. The Mode line shows the type of networking: Bridged Ethernet or Host-Only; the Name line shows the name of the network adapter to which the virtual machine is connected.

2. Set a different network adapter.

   Right-click the network adapter icon on the status bar to display the context menu. Choose the desired adapter from the context menu.
Connecting Serial or Parallel Ports

If a parallel or serial port is enabled in your virtual machine configuration, you can connect or disconnect the port at runtime.

To connect or disconnect serial or parallel port, do the following:

- From the Devices menu, select COM (from 1 to 4 depending on how many serial ports are enabled) or LPT (from 1 to 3 depending on how many parallel ports are enabled).
- Then select the Connect or Disconnect command.

Note: Alternatively, right-click the serial () or parallel () port icon on the status bar (on page 54) to display the context menu, and select the appropriate command.

Connecting Sound Device

If the sound device is enabled in the virtual machine configuration, you can connect or disconnect it at runtime.

To connect or disconnect the sound device:

- Choose Sound from the Devices menu,
- Choose Activate to connect the sound device or choose Mute to disconnect.

Note: Alternatively, right-click the sound device icon () on the status bar (on page 54) to display the context menu and select the appropriate command.
Connecting USB Devices

If the USB controller is enabled in the virtual machine configuration, you can connect or disconnect USB peripherals at runtime.

Parallels Workstation automatically detects all the USB devices connected to your host computer and displays them in the menu: Devices->USB and in the context menu for the USB controller (ﲈ) in the status bar. In the list, the devices currently connected to the virtual machine have check marks.

The primary OS can not access a USB device while it is being used by the virtual machine.

Autoconnect

If the Autoconnect USB devices option in the USB Options (page 138) tab is turned on, you can connect an additional USB device to your virtual machine.

- Simply plug a USB device into your host computer.

If you connect an additional USB device to your host computer while the maximum allowed number of USB devices is already running ( 8 ports for 2.0 and 2 port for 1.1 devices), nothing will happen. However, you will be able to connect a new plugged in device manually after disconnecting any of the currently connected USB devices.

Manual Connect

To connect a USB device to the virtual machine:

- Connect a USB device to your host computer.
- Choose USB from the Devices menu or open the context menu for the USB controller (鼋) on the status bar to display the list of all the USB devices connected to your host computer.
- Click the desired USB device in the list to connect it.

Note. If you receive the "Unable to connect USB device" message while trying to connect an USB device on a computer running Linux primary OS, see Problem with Connecting USB Devices in Linux Primary OS (page 217).
Parallels Tools for Windows

Parallels Desktop allows you to control the status of Parallels Tools in the Windows guest OSes. The Parallels Tools Center, which is installed along with Parallels Tools, allows you to:

- check the status of various tools;
- temporarily disable and enable each tool separately (for those tools that can be stopped without interfering with the guest OS execution);
- configure specific tool (for tools that have options).

**Note.** Parallels Tools Center is available in Windows guest OSes only.

The Parallels Tools Center window contains a set of tabs. Each tab contains settings for one tool. For the specific guest OS, Parallels Tools Center contains tabs only for tools that available for the guest OS.

Parallels Tools Center is launched automatically upon startup of the guest OS, and its icon is placed into the guest OS system tray.

**Installing Parallels Tools Center**

Parallels Tools Center is installed along with Parallels Tools. Refer to the Installing Parallels Tools section (page 76) for details.

**Upgrading**

If you upgraded Parallels Workstation, you have to upgrade Parallels Tools installed in the existing virtual machines. See Upgrading Parallels Tools (page 86).

**Opening Parallels Tools Center**

To open Parallels Tools Center click its icon in the guest OS system tray.

**Restarting Parallels Tools Center**

To restart Parallels Tools Center after it was temporary stopped:

Locate the ParallelsToolsCenter.exe file in the Parallels Tools folder and open it. By default, the file is stored at C:/Program Files/Parallels/Parallels Tools/. 
Clipboard Synchronization Tool Options

Status:
- **Enabled** option shows the current status of the Clipboard Synchronization Tool. To temporarily disable this tool, clear this check box. You can enable the Clipboard Synchronization Tool by selecting this option later.

Current clipboard content:
- The clipboard content is displayed in this field.
- The **Clear** button is used to empty the clipboard.

Description:
- Displays a short description of the tool. For a complete description see the Parallels Tools Overview (page 77).

Saving Changes
After you have made the desired changes on the tab, do one of the following:
- Click the **Apply** button to activate changes and choose another tab for editing.
- Click the **OK** button to activate changes and close Parallels Tools Center.
Time Synchronization Tool Options

Status:

- **Enabled** option shows the current status of the Time Synchronization Tool. To temporarily disable this tool, clear this check box.

**Note:** Before starting the Time Synchronization Tool, please stop all other time synchronization services to avoid potential conflicts.

Advanced options:

- **Synchronization interval, sec.** defines the time interval between two synchronization operations. Use scroll buttons to set the desired value or simply type it into the field. The value must be in the range from 10 to 3600 seconds.

To synchronize the guest OS and the primary OS system times:

1. Select the **Enabled** option.
2. Set the desired value of the synchronization interval in the **Synchronization Interval** field.

- **Keep time difference between primary and guest OS** option allows you to maintain a constant difference between the guest OS and the primary OS system times.

To set the different time in both OSes:

1. Select the **Enabled** option.
2. Select the **Keep Time Difference** option.
3. In the guest OS, set the desired current time.

The Time Synchronization Tool will calculate the difference at the moment when the guest OS time is set and will maintain it.
Description:

- Displays the short description of the tool. For a complete description see the Parallels Tools Overview (page 77).

Saving Changes

After you have made the desired changes on the tab, do one of the following:

- Click the **Apply** button to activate changes and choose another tab for editing.
- Click the **OK** button to activate changes and close Parallels Tools Center.

### Video Driver Options

![Parallels Tools Center](image)

**Status:**

- **Enabled** option shows the tool's current status. Video driver cannot be temporarily disabled.

**Description:**

- Displays a short description of the tool. For a complete description see the Parallels Tools Overview (page 77).
Mouse Synchronization Tool Options

Status:

- **Enabled** check box shows the tool's current status. Mouse Synchronization Tool cannot be temporarily disabled.

Description:

- Displays a short description of the tool. For complete description see the Parallels Tools Overview (page 77).
Network Driver Options

**Status:**

Enabled option shows the current status of the Parallels Network Adapter driver. To use the native Realtek RTL8029 driver clear the Enabled check box. Drivers can be changed without restarting the guest operating system; however, network connection can be temporarily lost.

**Description:**

- Displays a short description of the tool. For complete description see the Parallels Tools Overview (page 77).

**Saving Changes**

After you have made the desired changes on the tab, do one of the following:

- Click the **Apply** button to activate changes and choose another tab for editing.
- Click the **OK** button to activate changes and close Parallels Tools Center.
Disk Compacting Tool Options

Status:

- The field displays the list of volumes located on the expanding virtual hard disks connected to the virtual machine and formatted to Windows file systems. Volumes formatted to other file systems are not displayed even though they can be physically located on an expanding virtual hard disk.
  
  Select the volumes to be processed by the Disk Compacting Tool.

- **Execute all stages at once**. Select this option if you want to perform both stages of the disk compacting at once. See the description of the two stages in the Compacting Virtual Disk topic (page 113).

- **Start** button starts the process of compacting for the selected volumes.

Description:

- Displays a short description of the tool. See the detailed description in the Compacting Virtual Disk topic (page 113).

Saving Changes

After you have made the desired changes on the tab, do one of the following:

- Click the **Apply** button to activate changes and choose another tab for editing.
- Click the **OK** button to activate changes and close Parallels Tools Center.
Shared Folders Options

Status:
- **Enabled** option shows the tool's current status. This tool cannot be disabled.

Advanced Options:
- **Place shortcut on the desktop** option. When selected, shared folders shortcuts are placed to the guest OS desktop.

Description:
Displays a short description of the tool. For a complete description see the Parallels Tools Overview.

Saving Changes
After you have made the desired changes on the tab, do one of the following:
- Click the **Apply** button to activate changes and choose another tab for editing.
- Click the **OK** button to activate changes and close Parallels Tools Center.
Parallels Tools for Linux

To ensure a better integration between your primary and guest OS, Parallels Workstation provides a set of tools for Linux guest OSes that includes Dynamic Resolution Tool, Mouse Synchronization Tool and Time Synchronization Tool.

**Dynamic Resolution Tool**

Dynamic Resolution Tool enables you to work with dynamic resolution. When you switch to Full Screen mode, the guest OS window resolution changes automatically.

**Mouse Synchronization Tool**

Mouse Synchronization Tool provides automatic capture of the mouse input each time the pointer goes over the guest OS window and automatic release of the mouse input when the pointer moves out of the guest OS window. This tool also makes pointer movements smoother.

**Time Synchronization Tool**

Time Synchronization Tool enables you to configure time settings on your guest OS. With this tool you can:

- synchronize time between your host and guest OS
- set up and maintain time difference between your host and guest OS

**Note.** If you installed other time synchronization software, please stop it before installing Parallels Tools in order to avoid potential conflicts.

The table below lists available configuration options for this tool.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-T</td>
<td>Turn off Time Synchronization Tool for this guest OS.</td>
</tr>
</tbody>
</table>
| -d      | Set a certain time difference between your primary OS and your guest Linux OS. The option has the following values:  

  - `<seconds>` - used to set up a positive value, so that the guest OS time goes ahead of the primary OS time.  
  - `n<seconds>` - used to set up a negative value, so that the guest OS time goes behind the primary OS time. |
| -s      | Set the synchronization interval for the guest OS to synchronize its time with the primary OS. The interval is measured in seconds and varies from 1 to 3600 seconds. |
To configure Time Synchronization Tool, you must edit the `prluserd` script. By default, the script is located at `/usr/lib/parallels/prluserd`. Specify the desired option as the `OPTS` parameter and restart your virtual machine. As the `prluserd` script runs at the virtual machine booting, it will automatically adjust the time settings.

**Note.** You must have root privileges to edit the `prluserd` script.

---

## Compacting Virtual Disk

Expanding virtual disks grow in size as you work with them even if you delete unnecessary and temporary files periodically. **Disk Compacting Tool** helps to maintain the actual size of virtual disk files as small as possible.

**Disk Compacting Tool** cleans up the unused disk space on expanding virtual hard disks and cuts off the cleaned free space thus reducing the sizes of virtual disk files in the primary OS. We recommend that you use Disk Compacting Tool on your virtual machines from time to time to save space on the host hard disk.

**Note.** The Disk Compacting Tool does NOT process plain virtual disks.

### Disk Compacting Procedure

In general, the compaction procedure consists of two stages:

1. A preparatory stage, performed in the guest OS. This stage is supported only for Windows 95/98/NT/ME/2000/XP/2003/Vista guest OSes only after Parallels Tools are installed. All types of partitions: FAT 16, FAT 32, and NTFS, can be processed. During this stage, the unused space is being cleaned.

2. A compacting stage performed in the primary OS. This procedure removes clean unused space from the virtual disk file (only space available at the end of the file). This option is available for any guest operating system.

### Two-Stage Disk Compacting in Windows Guest OSes

1. When the virtual machine is running, open the **Parallels Tools Center** by clicking its icon on the status bar.

2. In the Parallels Tools Center, open the **Disk Compacting Tool** tab.

3. On the Disk Compacting Tool tab, the table in the **Status** group displays the list of volumes (disks and partitions) that can be compacted. Select the volumes you want to compact. Note that the compacting will be more efficient, if you select all partitions on the virtual disk.

   * If you want to perform both stages of compacting at once, select the **Execute all stages at once** option.

   * Click **Start**. All the selected disks will be processed one-by-one.

4. The first stage (that is cleaning of unused space) may take a significant time.
5 If you have selected the **Execute all stages at once** option, the second stage starts immediately after the first. The Disk Compacting Tool pauses the virtual machine and processes the virtual disk files in the primary OS. The **Compacting virtual hard disk** dialog box is displayed. Click **Cancel** to stop compacting, in this case, the sizes of virtual disk files will not be reduced.

When the process of compacting is successfully completed, click **OK**.

6 If you have NOT selected the **Execute all stages at once** option:

When the first stage of processing disks is complete, you will see the following message: "You are able either start compacting right now or do it when the virtual machine is powered off". You may select to perform the second stage of compacting later. See **One-Stage Disk Compacting** below.

**One-Stage Disk Compacting**

The one-stage disk compacting is used as a second stage of disk compacting procedure for Windows guest OSes (described above) or as the only one disk compacting procedure available for other guest OSes. This disk compacting procedure is performed in the primary operating system; it doesn't clean the unused space, it only "cuts off" unused space from the image file, thus reducing its size in the primary OS.

To perform disk compacting:

1 When the virtual machine is stopped, click the **Hard Disk** link on the Configuration Page.

2 Then click the **Compact** button on the Advanced tab of the **Hard Disk Options**. While compacting is being performed, the **Compacting virtual hard disk** dialog box is displayed.

3 If there are several hard disks that you want to compact, repeat Steps 1-2 for each expanding virtual disk.

**Maintaining Virtual Hard Disks**

Virtual hard disks require periodic maintenance as physical hard disks do. A file that stores an expanding disk has small size at the beginning of a virtual machine's life cycle and becomes larger as time goes on, because each time writing to the disk is requested, the system allocates new space, and therefore disk size increases. Deleting files does not reduce the size of a virtual disk file in the primary operating system. Eventually, an expanding virtual disk grows up to its maximum size.

Parallels Workstation includes the **Disk Compacting Tool**. For more information please refer to the Compacting Virtual Disk (page 113) topic.
Setting up a Printer in a Virtual Machine

There are three ways of configuring printing in a virtual machine:

- Setting up a network printer.
  
  We recommend that you use this method since it ensures more stable work.

- Connecting a virtual machine's parallel port to a physical parallel port on your computer to which a printer is connected.

  For this, edit the settings on the **Parallel Port Options** tab in Configuration Editor. In Windows primary OS, two options are available: **Use printer** and **Use port**. We recommend that you select the **Use printer** option. Parallels Workstation will create a printer job, and the primary OS will execute it.

  In the Linux primary OS, only the **Use port** option is available. When using this method, Parallels Workstation itself controls the printer job.

- Setting up a USB printer.

  Configuring a virtual machine for each method of printing is described below.

### Setting Up a Network Printer

Before installing a network printer in the guest OS make sure that the following requirements are met:

- Networking in your primary operating system is configured.
- Virtual machine configuration includes the network adapter which is connected to a real network adapter of your computer. See the Network Adapter Options topic (on page 131). Make sure that the **Enabled** and the **Connect at startup** options are selected; in the **Emulation** group the **Bridged Ethernet** option is selected, and the real network interface is chosen.
- Networking in the guest OS is configured.
- You as the primary OS user have permissions to access the network printer.

#### In Linux or FreeBSD Guest Operating System

Make sure that the following components are installed in your guest Linux or FreeBSD system:

- Common UNIX Printing System (CUPS). Installation instructions can be found at CUPS web site (http://cups.org/documentation.php);

- Samba service. Installation instructions can be found at Samba web site (http://us4.samba.org/samba/docs/man/Samba-HOWTO-Collection/install.html);

- A Web browser, since CUPS controlling is performed via web interface;

  Also you have to know the password to **root** account.

To add a network printer in a Linux or FreeBSD guest OS:

1. Start your Linux or FreeBSD guest operating system.
2 Start Common UNIX Printing System.

   In the Terminal, issue the command:

```
/etc/init.d/cups start
```

3 Start a Web browser and open either IP address of your virtual machine or http://127.0.0.1:631.

4 Select Printers in menu. Click the Add printer button below the list of available printers (if any).

5 Enter the root password when prompted.

6 In the Add New Printer window enter the information for easy identification of the printer: a printer name, its location, and description.

7 In the Device for <Printer Name> window select the Windows Printer via Samba.

8 In the Device URI for <Printer Name> window specify the path to network printer in the following format:

```
smb://<computer name>/<printer name>
```

9 In the Model/Driver for <Printer Name> window select the model of your printer.

10 CUPS performs installation. If installation is successful, the "Printer <name> has been added successfully" message is displayed.

**In Windows Guest Operating System**

To add a network printer in a Windows guest OS:

- Start the Windows guest operating system and log in.
- From the Windows Start menu, choose Settings and then the Printers and Faxes (or simply Printers) item.
- Open the Add Printer Wizard:
  - In Windows 95/98/NT/ME/2000/2003 double-click the Add printer icon.
  - In Windows XP click the Add a printer link.
- In the Add Printer Wizard:
  - In Windows 2000/XP/2003: click Next in the window of the wizard,
  - in the Local or Network Printer window, click A network printer, or a printer attached to another computer.
  - In Windows 98/ME: click Next in the window of the wizard,
  - For the following question: How is this printer attached to your computer? - Click the Network printer option.
  - In Windows 95/NT:
  - click Network printer/server.
- Continue the network printer installation as usually.
Setting Up Printing via LPT Port of Real Computer

To set up printing through a parallel port of your physical computer:

1. Make sure that a printer is connected to an LPT port of your real computer.

2. Open the virtual machine configuration in Configuration Editor, make sure that the configuration includes a parallel port, add it if necessary.

3. On the Parallels Port Options tab, the **Enabled** and the **Connect at startup** options are selected.

   Specify the way of emulating the parallel port in the **Emulation** group:

   - In the Windows primary OS, we recommend that you select the **Use printer** method (it is not available in Linux primary OSes). The **Printers** list displays list of printers available in the primary OS. Specify which one you want to use.
   
   - In the Linux primary OS select the **Use port** option and then specify the real port of your physical computer to which the printer is connected in the **LPT-port** list.

4. Save the virtual machine configuration (see Saving Virtual Machine Configuration (page 119)) and start the guest operating system.

5. Install the driver for your printer in the guest OS. We recommend that you use the native driver.

Setting Up a USB Printer

To set up an USB printer:

1. Open the virtual machine configuration in the Configuration Editor (on page 118), and make sure that the configuration includes a USB controller, add it if necessary.

2. Open the USB Options (page 138), and make sure that the **Enabled** option is selected. Select the **Autoconnect at startup** if you want the printer to be automatically captured by the virtual machine.

3. Save the virtual machine configuration (see Saving Virtual Machine Configuration (page 119)) and start the guest operating system.

4. Connect the USB printer as a USB device. See the Connecting USB Devices (page 103) topic.

5. Install the native driver for the printer in the guest OS.
CHAPTER 11

Configuring a Virtual Machine

This chapter provides the information on configuration options available for a virtual machine.

In This Chapter

Editing Virtual Machine Configuration ................................................................. 118
Adding and Removing Devices ........................................................................... 139
Using USB Devices in Virtual Machine ............................................................. 164
Networking in Virtual Machine ......................................................................... 164
Custom Screen Resolutions ............................................................................... 166

Editing Virtual Machine Configuration

The configuration of an existing virtual machine can be changed in Configuration Editor. In this section we consider how to edit the VM’s general settings and the settings of the devices already included in the configuration. Adding and removing devices are discussed in the separate section, Adding New Devices to Virtual Machine (page 139).

Changing Device Settings

To change device settings:

1  Open the virtual machine which configuration you want to change.

2  Open Configuration Editor by clicking the button on the Command Button panel, or choose Edit Configuration from the File menu, or just click a device name in the Resources list.

3  Choose the hardware in the Resources list in the left part of the Configuration Editor window to open the hardware options tab in the right part of the Configuration Editor window.

Note: In Linux primary OS you must have system privileges to connect a real device to the virtual machine. Otherwise, the real device will not appear in the list of available devices even if it is installed on your computer.
Saving Virtual Machine Configuration

After you have changed the settings of the devices in Configuration Editor, you must save the virtual machine configuration to enable the changes:

1. Click OK on the Configuration Editor window, then click the button on the Command Button panel or choose Save from the File menu. The file will be saved in its current location and with the current name.

2. To save the configuration in another location or with another name choose Save As from the File menu. After you have saved the file, its new file name appears in the title bar and the path to it and its new name appear in the File Location field on Property Page (page 49).

General Options

The General Options tab for the Options item in the Resources list in Configuration Editor contains the VM's general settings.
VM Identification:

- **Virtual Machine Name** field displays the name of the machine that was specified when the VM was created. The field is editable. The name must not exceed 50 symbols. This name is also displayed on the Property Page (page 49) of the virtual machine.

Guest OS Type:

- **OS Type** and **OS Version** fields display the type of operating system that was specified when the virtual machine was created (it doesn't matter whether the operating system was installed or not). Please specify the type of OS correctly. If the type of guest OS on this tab does not match the type of operating system actually installed, this may cause problems varying from slow performance to machine failure.

Booting Options

On the **Booting Options** tab you can select the booting sequence that is the order in which the virtual machine will try to boot from different devices. You can choose one of the three predefined sequences - [Floppy, Hard Disk, CD-ROM], [Hard Disk, CD-ROM, Floppy], [CD-ROM, Hard Disk, Floppy]. During startup, the virtual machine checks the first device (or media) of the boot sequence and tries to boot from it. If the media is not found or is not bootable, the virtual machine will proceed with the next device in the boot sequence, and so on.

**Note:** Please make sure that the boot disk (hard disk, CD-ROM, floppy disk) is available and configured correctly. If you don't have any boot device in your virtual machine (in case of a new, blank virtual machine), then after you power it on, you will see the error message. Stop the virtual machine and correct the configuration.
VM Flags

The **VM Flags** tab contains startup and shutdown options and various options that affect the performance of the virtual machine.

**Emulation flags:**

- **Acceleration level.** Acceleration enables a number of the guest OS specific performance optimization options. We recommend that you choose the **High** level. If you notice incorrect guest operating system behaviour while running with high acceleration, shut down the guest OS and lower the acceleration level. After removing the problem restore the acceleration level. Note that without acceleration at all (**Disabled** level) the virtual machine runs very slowly.

- **Enable hardware virtualization support** option is available for editing if your host computer has either an Intel processor with Virtualization Technology support or an AMD processor with the AMD Virtualization technology. By default, the hardware acceleration is enabled. See Intel Virtualization Technology (VT-x) and AMD-V Support (page 11) to learn about hardware virtualization support in Parallels Workstation.

If you run a guest OS with VT-x support enabled, it is indicated in the **About Parallels Workstation** window (see the More Information (page 57) section).
Process priorities:

**Note**: Process priorities options are available in Windows primary OS only.

- **When running in foreground**. This option defines the priority for the virtual machine process when VM is running in the foreground mode, i.e. when the virtual machine window is active.

- **When running in background**. This option defines the priority for the virtual machine process when VM is running in the background mode, i.e. when the virtual machine window is not active.

**Misc flags**:

- **PC speaker support enabled**. If this option is selected, PC speaker sounds will be generated upon certain virtual machine operations.

- **Autostart VM when configuration is loaded**. After you open the virtual machine configuration, the VM will be automatically started.

- **Switch to fullscreen mode automatically**. As soon as the virtual machine is started, it will run in the full screen mode.

- **Exit application on VM shutdown**. If this option is selected, the Parallels Workstation window will be closed automatically after the virtual machine is stopped or suspended. By default, this option is not selected.

**Shared Folders**

**Note**: Options on this tab are available in Windows 2000/XP/2003 guest OSes only. In other guest OSes you will see the message: "Feature is not available for this type of guest operating system".
- **Enable shared folder** option allows using shared folders in the virtual machine.
- The list below displays all the shared folders created for this virtual machine. The **Name** column shows name of the folder in the guest OS, the **Path** column shows the same folder in the file system of your host computer.
- Add button [+] opens the **Shared Folder Properties** dialog box for creating a new shared folder. See the Using Shared Folders (page 184) section for detailed description of this process.
- Delete button [-] removes the selected shared folder.
- Edit button [::] opens the **Shared Folder Properties** dialog box where you can change the shared folder properties. See the Using Shared Folders section.

**Video (Screen Resolutions)**
- **Enable custom screen resolutions** option allows using different screen resolutions for the virtual machine.

- **Screen Resolutions** table displays all the custom resolutions defined for this virtual machine. The check mark near a resolution means that this resolution will be available for selection in the virtual machine. Those resolutions that do not have check marks will not be available for selection. To enable /disable a resolution, open its properties using the **Edit** button.

- Add button + opens the **Resolution Properties** dialog box for creating a new resolution. See the Using Custom Screen Resolutions (page 166) topic for detailed description of this process.

- Delete button - removes the selected screen resolution.

- Edit button ⚙ opens the **Resolution Properties** dialog box where you can change the screen resolution. See the description of this dialog box in the Using Custom Screen Resolutions (page 166) section.

### Memory Options

In the **RAM** field you can set the amount of memory (RAM) that the virtual machine can use. You can choose any value from 4 to 1500 MB, the value should be in multiples of 4. To set this value use the slider, the spin buttons, or type the value directly into the field.

The recommended maximum value is specified below the slider on this tab (this value can be adjusted on the Memory tab (on page 171) in the **Preferences** window).

If the guest OS requires more memory for its operation than it is specified in this field, the swapping to hard disk will be used, thus slowing down both the guest and the primary OSes performance.
Floppy Options

A virtual machine floppy drive can be connected to a real floppy drive as well as to an image of floppy disk. To get information on floppy disk images used by Parallels Workstation read Floppy Disk Images (page 17).

**Device status:**

- To temporary disable floppy drive operations without deleting the drive from configuration, clear the **Enabled** check box.

  **Note:** If you start the virtual machine with the floppy drive disabled, you cannot change this option when the virtual machine is running.

If the floppy drive is enabled, it can be connected or disconnected while the VM is running. Media accessed by the floppy drive can also be changed.

- Select the **Connect at startup** option to start the guest OS with the floppy drive connected.

**Emulation:**

- **Use real floppy** option. If you have one or more physical floppy drives on your computer, select the **Use real floppy** option to use a real floppy disk from inside the virtual machine. All available floppy drives will be shown in the **Floppy Drives** list. You can select one of them (for example, A:).

  **Note:** In Linux primary OS you must have root privileges to connect the real device to the virtual machine floppy drive. Otherwise, real floppy drive will not appear in the list of available devices even if it is installed on your computer.
- **Use image file** option. Select it to use a floppy disk image (the .fdd file). A new field, **Image File**, appears. Specify the path to a disk image file or click the **Browse** button and locate the file.

- **Recreate** button. Click the button to create a blank floppy image. Specify the location and the name of the file in the **Image File** field and click **Recreate** button. The size of a floppy disk image equals 1.44 MB. The default extension for a floppy disk is .fdd.

### Hard Disk Options

The current version of Parallels Workstation supports using only hard disk images in .hdd format as virtual hard disks. Refer to **Hard Disk Images** topic (page 16) to learn about disk formats and other options.

Up to four IDE devices (both hard disks and CD/DVD-ROM drives) can be connected to a virtual machine currently.

![Configuration Editor](image)

**Device status:**

- To temporarily disable operations with this hard drive without deleting it from configuration, clear the **Enabled** check box.

**Emulation:**

- **Image File** field defines the image file that is used as a virtual hard disk. To replace the virtual hard disk choose another image file (with the .hdd extension) in the field.

- **Recreate** button. Click the button to delete the old virtual disk and create a new, blank one.

To replace the current hard disk with a new blank one:

1. Click the **Recreate** button.
2 The **Create HDD** window appears. Select the **Expanding disk** option if you want the hard disk to be expanding. Clear the check box to create a disk in *plain* format.

![Create HDD window](image)

3 Click **Create**.

4 When prompted click **Yes** to confirm that you are going to create a new disk instead of the old one. A new empty disk is now connected to your virtual machine.

**Note:** If when using a hard disk you discover that it is too small, you may increase the disk capacity using the Parallels Image Tool (page 187).

**Hard Disk Advanced Options**

![Configuration Editor](image)
Device Geometry:

- The **Cylinders**, **Heads**, and **Sectors** fields show the parameters of geometry of the virtual hard disk. Note that the parameters in the Device Geometry area describe the virtual disk, not a physical one where the virtual disk is stored.
- **Disk format** field shows format of the virtual hard disk. See the Format of The Virtual Disk (page 16).

Attachment Options:

- **Connect to** field. Displays the IDE channel to which the virtual hard disk is connected. The startup disk must be connected to **IDE 0:0**, while a data disk may be connected to any other channel.

  Note that if you set two startup drives at once - hard disk (IDE 0:0) and CD/DVD-ROM drive (IDE 0:1) - the guest OS will try to boot according to the booting sequence set on the Booting Options tab (page 120).

Optimization:

- **Compact** button. If the selected virtual disk is in **expanding** format, click the **Compact** button to start the process of disk compacting. See the Compacting Virtual Disk topic (page 113) for information on this feature. The **Compact** button is disabled for virtual disks in **plain** format.
CD-ROM options

A virtual machine CD/DVD-ROM drive can be connected to a real CD/DVD-ROM drive of your computer as well as to an ISO image of a disc.

Up to four IDE devices (both hard disks and CD/DVD-ROM drives) can be connected to a virtual machine currently.

**Device Status:**

- To temporary disable a CD/DVD-ROM drive without deleting it from the configuration, clear the **Enabled** check box.

**Note:** If you start the operating system with the CD/DVD-ROM drive disabled, you cannot change this option when the virtual machine is running.

If the CD-DVD-ROM drive is enabled, it can be connected or disconnected at runtime. Media that CD/DVD-ROM drive can access may also be changed.
- **Connect at startup** option. If the CD/DVD-ROM drive is enabled, select this option to start the guest OS with the CD/DVD drive connected.

**Emulation:**

- **Use real CD/DVD-ROM** option. If you have a physical CD/DVD-ROM drive on your computer, you can select the **Use real CD/DVD-ROM** option to use the drive from inside the virtual machine. The name of the physical CD/DVD-ROM (for example, D:) will be shown in the **CD/DVD-ROM drives** drop-down list and available for selection.

**Note:** In Linux primary OS you must have root privileges to connect the virtual machine's CD/DVD-ROM drive to a real CD/DVD-ROM drive. Otherwise, the real CD/DVD-ROM drive will not appear in the list of available devices even though it is installed on your computer.

- **Use image file** option. To use a CD/DVD image (e.g., the .iso file), select this option. Once you selected it, the field where you can specify the CD/DVD image file appears. Specify the path to your CD/DVD image file or click the **Browse** button and locate the CD/DVD image file.

**Attachment Options:**

- **Connect to** field. Choose the IDE channel to connect the CD/DVD-ROM image to. If you want the CD/DVD-ROM drive to be the startup drive select **IDE 0:1**.

Note that if you set two startup drives at once - hard disk (IDE 0:0) and CD/DVD-ROM (IDE 0:1) - the guest OS will try to boot according to the booting sequence set on the Booting Options tab (page 120) of the **General Options**.
Network Adapter Options

The current version of Parallels Workstation supports a RTL8029 (NE2000 compatible PCI card) network adapter.

In a Linux guest OS, to provide an access to external network from inside the virtual machine make sure the Linux kernel includes the `ne2k-pci` driver. In a FreeBSD guest OS you need to have the `if_ed.ko` module loaded.

Device Status:
- If you wish to temporarily disable network support in the virtual machine without deleting the network adapter from configuration, clear the Enabled check box. When the Enabled check box is selected, the options and fields for configuring the network become active.
- If the network adapter is enabled, you can select Connect at startup check box to start the guest OS with network adapter connected.

Emulation:

In the Emulation group, you can select the type of network adapter to be used in your guest OS. There are three options: Bridged Ethernet, Host-only networking and Shared Networking.

- **Bridged Ethernet** networking is used to access local network and the Internet via physical Ethernet adapter of your computer. A virtual machine will get its own IP-address and will appear on the network as a separate computer.
  
  If the Bridge Ethernet option is selected, the Network Adapters drop-down list will show all physical network adapters available on your computer. Choose one of them to connect to your virtual adapter.
The list of available adapters includes the **Default** adapter that is always mapped to the Ethernet adapter. With Default adapter selected you don't have to stop the virtual machine and select the currently active adapter when you switch from using a wired connection to wireless one.

- **Host-only networking** option allows emulating network inside your computer accessible only to the primary OS and the virtual machines running in it. It is helpful in case you don't want to access the network outside your local computer, or when you don't have any physical network interface card. IP addresses for machines in a host-only network are provided by Parallels DHCP server connected to Parallels Host-Guest adapter. DHCP server is started automatically whenever you launch Parallels Workstation. The **Parallels Host-Guest** adapter is installed along with Parallels Workstation.

**Network Adapter Advanced Options**

![Configuration Editor](image)

This tab allows you to specify a network driver to be used in the guest OS. In the current version of the Parallels Workstation a RTL8029 driver for the Ethernet adapter is supported. It is already selected in the **Type** field.

You can find native Realtek RTL8029 drivers for many different guest OSes in the Parallels Tools (page 76) package. See Installing Parallels Tools (page 76).

In Windows 2000/XP/2003 guest operating systems you can improve network performance by installing a specially developed PRLETH driver that can be found in the Parallels Tools (page 76) pack.

A **MAC address** is generated automatically but can be changed manually. If you decide to change it, please make sure that the number is unique inside your network.
Serial Port Options

Parallels Workstation allows up to four serial ports to be connected to a virtual machine.

**Serial Port Options** in Windows primary OS:

![Configuration Editor](image)

**Device status:**

- If you wish to temporarily disable operations with a serial port without deleting it from the configuration, clear the **Enabled** check box.

  **Note:** If you start the operating system with the serial port disabled, it cannot be connected or disconnected at runtime.

- If you have enabled the port, you can select the **Connect at startup** option to start the guest OS with this port connected.

**Emulation:**

Parallels Workstation provides three options of serial port emulation:

- Connect it to a physical device (**Use port** option).
- Connect to an output file (**Use output file** option).
- The third option is different in the Windows and Linux versions of Parallels Workstation.
  - **Use pipe** option - in the Windows primary OS.
  - **Use socket** option - in the Linux primary OS.
These methods are described below:

1. If you have selected **Use port**, the drop-down **COM - Port** list displays the list of available real COM ports. Select one of them to connect to the virtual port.

   **Note:** In Linux primary OS you must have **root** privileges to connect the real device to the virtual machine serial port. Otherwise, the real serial port will not appear in the list of available devices.

2. If you have selected **Use output file**, specify the existing file using the **Browse** button or create a new one. The new file is created in the virtual machine folder.

3. **Windows primary OS.** If you have selected the **Use pipe** option, the **Pipe name** field will contain a default pipe name. Use it or type a new name in the following format: `\\pipe\<name>`.
   
   In the adjacent field select a role at this end of the pipe.

   **Linux primary OS.** If you have selected **Use socket**, the **Socket Name** field will contain a default socket name. Use it or type a new name in the following format: `/tmp/<socket>`.
   
   If incorrect name is specified, you will get a message when the virtual machine is started.

   In the adjacent field select a role at this end of the socket.

### Parallel Port Options

Parallels Workstation allows up to three parallel ports to be connected to a virtual machine.
Device status:

- If you wish to temporarily disable operations with a parallel port without deleting it from configuration, clear the Enabled option. If the parallel port is enabled, it can be connected or disconnected while the VM is running.

  **Note:** If you start the operating system with the parallel port disabled, you cannot change this option when the virtual machine is running.

- If you have enabled a port, you can select the **Connect at startup** option to start the guest OS with this port connected.

Emulation:

Parallels Workstation provides three methods of emulating parallel port in Windows primary OS and two methods in Linux:

- **Use port** option - for connecting to a physical LPT port.
  
  If you select this option, the drop-down LPT - Port list displays the real LPT ports available on your computer. Select one of them to connect to the virtual port.

  **Notes.**
  
  1. In Linux primary OS you must have root privileges to connect the real device. Otherwise, the real parallel port will not appear in the list of available devices even if it is installed on your computer.
  
  2. Running a virtual machine with its parallel port connected to a real LPT port blocks the access to this real LPT port. If a physical printer is connected via this LPT port, other virtual machines and the primary OS will not be able to use this printer. For more information on this issue see Problems with Printing (page 219).

- **Use output file** - for connecting to an output file. If you select this option, you can connect an existing file or create a new one. Click the **Browse** button and locate the file.

- **Use printer** - for connecting to a printer. *(Windows primary OS only.)*
  
  If you select **Use printer** and have a physical printer connected to your computer, **Printers** list displays all the printers connected to your computer. Select one of them to connect to the parallel port. When a document is sent to printer in the VM, Parallels Workstation creates a printer job, and the primary OS executes it.
Sound Options

Parallels Workstation emulates the Realtek AC'97 compatible sound card.

**Device status:**

- **Enable** option allows using the sound device in the virtual machine. If the sound device is enabled, it can be connected or disconnected at runtime. However, if you want to temporarily disable operations with a sound device without deleting it from the configuration, clear the **Enabled** check box.

**Note:** If you start the operating system with the sound device disabled, you cannot change this option at runtime.
To start the guest OS with the sound device connected, select the **Activate sound at startup** option.

**Emulation:**

**Note.** If you are not satisfied with the quality of the sound, install the AC'97 sound driver (page 77) available for Windows 95/98/ME/NT/2000 and for OS/2 and eComStation guest OSes.

**Windows primary OS:**

- **Specify playback sound device** field contains a list of available sound devices. You may select a specific device or use a **Default sound playback device.** To mute the sound select the **Loopback sound device.**

- **Specify recording sound device** contains a list of available devices for sound recording. You may select a specific device or use a **Default sound recording device.** If you don't want to record the sound but need to emulate this process, you can select the **Loopback sound device.**

**Linux primary OS:**

- **Output Device** field contains a list of sound adapters and virtual sound devices available on your real computer. To mute the sound select **loopback.**

**Note:** In Linux primary OS you must have **root** privileges to connect the real sound device to the virtual machine. Otherwise the real sound device will not appear in the list of available devices even if it is installed on your computer.

- **Mixer Device** field contains a list of available mixer devices. If you don't want to use a mixer device but it is required by the guest OS'es applications, select **loopback.**
USB Options

**Device status:**

- **Enable** option allows using USB devices in the virtual machine. If the USB controller is enabled, USB devices can be connected or disconnected to the virtual machine at runtime. However, if you want to temporarily disable USB operations clear the **Enabled** check box.

  **Note:** If you start the operating system with the USB disabled, you cannot change this option when the virtual machine is running.

**Connection Options:**

- **Autoconnect USB devices.** Select this option if you want the running virtual machine to capture new USB devices connected to the host computer.
Adding and Removing Devices

If you want to change the virtual machine configuration, remove virtual devices using Configuration Editor and add new devices to the virtual machine with the help of Add Hardware Wizard.

Virtual machine configuration can include the following devices:

- up to four IDE devices - virtual hard disks and CD/DVD-ROM drives (at least, one is required)
- one floppy drive
- one network adapter
- up to four serial ports
- up to three parallel ports
- a sound device
- a USB controller

Note. If the guest operating systems cannot automatically recognize a new device, use the means of the guest operating system to make a new device visible to it.

Add Hardware Wizard

New devices are added using Add Hardware Wizard. The wizard allows you to add only one device at a time. If the VM configuration already includes the maximum number of devices of a particular type, this type of device will not appear in the Available Hardware list. For instance, only one floppy drive is allowed.

Such devices as CD/DVD-ROM or floppy disk drives can be connected to real drives or to virtual media. If you add a floppy drive, a new blank .fdd image can be created and, at the same time, connected to the drive. When adding a virtual hard disk you can also choose between connecting an existing hard disk image and creating a new one.

Note. In Linux primary OS to connect any virtual device to a real one, you must have root privileges. Otherwise, the real device will not appear in the list of available devices even if it is installed on your computer.

You can add new devices to the virtual machine using Add Hardware Wizard. To add a new device to the virtual machine:

1. Open the virtual machine, then open Configuration Editor by choosing Edit Configuration from the File menu or clicking in the lower part of the Property Page.
2. Click the Add button under the Resources list in the left pane of the Configuration Editor window.
3 The Welcome window of the Add Hardware Wizard appears. To skip the Welcome window next time you run the wizard, select the Skip introduction next time option. Click Next.

4 In the Select hardware dialog box choose the device you want to add to your virtual machine. The Available Hardware list contains the devices available for adding.

Click the Add device instantly button to add the device without configuring it. The new device is added immediately with the default options.
Click the **Next** button to configure the device you are going to add.

5 Follow the wizard windows to configure the new device. For details on configuring specific devices see the topics below in this section. Options for different devices are also described in the Editing Virtual Machine Configuration (on page 118) section.

### Adding Hard Disks

To add one or more virtual hard disks to your virtual machine, use Add Hardware Wizard. You can add a new disk or add an existing hard disk image.

If you are going to add a new blank virtual disk, do not forget to format it as a file system compatible with the guest operating system. If you are going to add an existing virtual disk image as a data disk, make sure the file systems are compatible.

**To add a virtual hard disk**

1 In Configuration Editor click Add to launch Add Hardware Wizard.
2. In the Select hardware dialog box select Hard Disk in the Available Hardware list and click Next.

![Select hardware dialog box](image)

3. The Select action type dialog box appears.
   
   If you want to create a new virtual hard disk, select the Create a new virtual hard disk option.
   
   If you want to use an existing hard disk image, select the Use an existing hard disk image option.
Click Next.

4 If you selected the Use an existing hard disk image option in the previous step, proceed to the next step.

If you selected the Create a new virtual hard disk option, in the Specify hard disk options dialog box specify the size and the format for the new virtual disk. For more information on the formats of virtual disks, see Virtual Disk Formats topic (page 16).
5 In the Select an image file dialog box specify the location for the hard disk image file. For the newly created disk you can use the default folder or choose another one using the [...] button. If you choose to use an existing file in the Step 3, specify the location of the existing image file in this dialog box. Click Finish.

Adding a CD/DVD-ROM Drive

Note. In Linux primary OS you must have root privileges to connect the virtual machine's CD/DVD drive to a real CD/DVD-ROM drive. Otherwise, the real device will not appear in the list of available devices even if it is installed on your computer.

To add a CD/DVD-ROM drive to a virtual machine:

1 In Configuration Editor click Add to launch Add Hardware Wizard.
2 In the Select hardware dialog box select CD/DVD-ROM in the Available Hardware list and click Next.

3 In the Select action type dialog box specify the type of CD/DVD-ROM drive:
   - For a physical drive select the Use a physical CD/DVD-ROM drive option and click Next.
- For an ISO image file select the **Use an ISO image of a CD/DVD disk** option and click **Next**.

4 If you selected the **Use a physical CD/DVD-ROM drive** option, in the next dialog box select the drive to use and specify if you want to have this drive connected at the virtual machine startup.
5 If you selected **Use an ISO image of a CD/DVD disc** option, in the next dialog box click the [...] button to locate the image to be connected to the drive. Specify if you want to have this image connected when the virtual machine starts up.

![Add Hardware Wizard](image)

6 Click **Finish**.

**Adding a Floppy Disk Drive**

Only one floppy disk drive is allowed for each virtual machine. If your virtual machine has already got a floppy disk drive, it will not appear in the **Available Hardware** list.

To add a floppy disk drive:

1 In Configuration Editor click **Add** to launch **Add Hardware Wizard**.
2 In the Select hardware dialog box select Floppy in the Available Hardware list and click Next.

3 In the Select action type dialog box specify the type of floppy disk drive:
   - For a physical drive select the Use a physical floppy drive option and click Next.
   - For an existing image of a floppy disk select the Use an existing image of a floppy disk option and click Next.
For a blank image of a floppy disk select the Create a blank image of a floppy disk option and click Next.

4 If you selected Use a physical floppy drive option in the next dialog box, choose the drive to use and specify if you want to have this drive connected when the virtual machine starts up.
If you selected the **Use an existing image of a floppy disk** option, click the [...] button to locate the image to be connected to the drive and specify if you want to have this drive connected when the virtual machine starts up.

If you selected the **Create a blank image of a floppy disk** option specify the location for the floppy disk image file. You can choose a folder different from the default one using the [...] button.
6 Click Finish.

Adding a Network Adapter

Up to 5 network adapters are allowed for each virtual machine. If your virtual machine has already got a maximum number of them, network adapter will not appear in the Available Hardware list.

Note. Before you start network configuring in a virtual machine with Windows 2003 installed you need to install Parallels Tools. The package includes the PRLETH driver specially designed for virtual adapter, which is the emulated RTL8029 driver.

To add a network adapter:

1 In Configuration Editor click Add to launch Add Hardware Wizard.

2 In the Select hardware dialog box select Network Adapter in the Available Hardware list and click Next.
3 In the **Select a type of networking** dialog box specify the type of networking you want to use in your virtual machine. Refer to description of options to the Network Adapter Options topic (on page 131).

4 If you selected the **Bridged Ethernet** option, in the dialog box select the real network adapter to use and specify if you want to have the adapter connected when the virtual machine starts. If you selected other option, proceed to Step 5. Click **Next**.
5 In the **Specify virtual adapter** dialog box click **Finish**. The **Adapter type** field displays the type of virtual adapter available in the virtual machine.

![Add Hardware Wizard](image)

**Adding a Sound Device**

This topic describes how to add a sound device in Parallels Workstation for Windows.

To add a sound device to a virtual machine:

1 In Configuration Editor click **Add** to launch **Add Hardware Wizard**.
2. In the Select hardware dialog box select Sound Device in the Available Hardware list and click Next.

3. In the Select output device dialog box select the sound and recording devices to use and specify if you want to have these devices connected when the virtual machine is started.

4. Click Finish.
Adding a Serial Port

Using Add Hardware Wizard you can add up to four serial ports to your virtual machine. You can use an output file, a socket or a named pipe for the serial port emulation. For details about serial port options see the Serial Port Options topic (on page 133). This topic describes how to add a serial port in Parallels Workstation for Windows.

To add a new serial port:

1. In Configuration Editor click Add to launch Add Hardware Wizard.
2. In the Select hardware dialog box select Serial Port in the Available Hardware list and click Next.
3. In the Select device type dialog box specify the type of device for emulating a serial port:
   - To emulate with a socket, select the Use a physical serial port option and click Next.
   - To use an output text file, select the Use an output file option and click Next.
To use a named pipe, select the **Use a named pipe** option and click **Next**.

4. If you selected the **Use a physical serial port** option, in the next dialog box you should select the physical serial port to use and specify if you want to have this device connected when the virtual machine starts up.
If you selected the *Use an output file* option, in the next dialog box you should specify the output file location. You can choose a folder different from the default one using the [...] button. If you want the serial port to be connected to the virtual machine upon startup, make sure that the *Connect Serial Port at startup* option is selected.
If you selected the **Use a named pipe** option, you should specify the name of the pipe for the serial port to be connected to and select the role for the virtual machine. If you want the serial port to be connected to the virtual machine upon startup, make sure that the **Connect Serial Port at startup** option is selected.

![Add Hardware Wizard](image)

5. Click **Finish**.

### Adding a Parallel Port

Using Add Hardware Wizard you can add up to three parallel ports to your virtual machine. You can use an output file, a socket or a printer for the parallel port emulation. For details about parallel port options see the Parallel Port Options topic (on page 134). This topic describes how to add a parallel port in Parallels Workstation for Windows.

To add a new parallel port:

1. In Configuration Editor click **Add** to launch **Add Hardware Wizard**.
2 In the **Select hardware** dialog box select **Parallel Port** in the **Available Hardware** list and click **Next**.

3 In the **Select device type** dialog box specify the type of device for emulating a parallel port:
   - To emulate with a socket, select the **Use a physical parallel port** option and click **Next**.
   - To use an output text file, select the **Use an output file** option and click **Next**.
To use a printer, select the **Use a printer** option and click **Next**.

4 If you selected the **Use a physical parallel port** option, in the next dialog box you should select the physical parallel port to use and specify if you want to have this device connected when the virtual machine starts up.
If you selected the **Use an output file** option, in the next dialog box you should specify the output file location. You can choose a folder different from the default one using the [...] button. If you want the parallel port to be connected to the virtual machine upon startup, make sure that the **Connect Parallel Port at startup** option is selected.
If you selected **Use a printer** option, you should specify the name of the printer to be connected to this parallel port. If you want the parallel port to be connected to the virtual machine upon startup, make sure that the **Connect Parallel Port at startup** option is selected.

5 Click **Finish**.

**Adding a USB Controller**

A virtual machine can have only one USB controller. If you removed it for any reason, you can add it back to the configuration.

To add a USB controller to the virtual machine:

1 In Configuration Editor click **Add** to launch **Add Hardware Wizard**.
2 In the **Select hardware** dialog box select **USB Controller** in the **Available Hardware** list and click **Next**.

3 In the **Specify USB options** dialog box specify if you want USB devices to be connected automatically when the virtual machine is running.

4 Click **Finish**.
Removing Devices

Some of the virtual devices can be removed from the configuration. Memory, Options, Shared Folders, and Video items can not be removed.

*Note.* Any device, except the memory, can be disabled in Configuration Editor (on page 118) without removing it from the configuration. Clear the **Enabled** check box for the desired device.

To remove a device:

1. Open the virtual machine.
2. Open Configuration Editor by choosing **Edit Configuration** from the **File** menu or clicking the *Edit* button.
3. Select the device you want to delete in the **Resources** list in the left pane of **Configuration Editor** window. Note that **Options**, **Shared folders**, **Video**, and **Memory** items can not be deleted.
4. Click the **Remove** button.

*Note.* If you accidentally removed the wrong device, close the Configuration Editor window without clicking the **Save** button.

5. Click the **Save** button to save the changes in the virtual machine configuration.

Using USB Devices in Virtual Machine

The current version of Parallels Workstation emulates the 8-port 2.0 and 2-port 1.1 USB controller. This means that up to eight USB 2.0 and 2 USB 1.1 devices can be connected to a virtual machine simultaneously.

Parallels Workstation lets you connect USB devices to virtual machine automatically. See the **USB Options** topic (page 138) to learn how to use this option.

Networking in Virtual Machine

Parallels Workstation allows two types of networking in virtual machine, Bridged Ethernet and Host-only networking. This section describes these types of networking and the ways of configuring them.
Bridged Ethernet Networking

Bridged Ethernet networking allows virtual machines to access a physical network, such as Local Area Network and the Internet. You must have an Ethernet adapter installed on your host computer. This Ethernet adapter should support promiscuous mode, as described in Hardware Requirements (page 18).

To access LAN and the Internet, configure the virtual machine:

- in virtual machine Network adapter options (on page 131) select Bridged Ethernet type of networking in the Emulation group and choose the proper network adapter in the list,
- configure network options in the guest operating system.

Creating Host-Only Network

Parallels Workstation provides virtual network accessible only to the primary operating system and virtual machines running on it. The primary operating system is attached to this network through the Parallels Host-Guest Virtual NIC adapter installed along with Parallels Workstation. For a virtual machine to join such a host-only network, the guest network adapter should be set to host-only networking. IP addresses for the primary operating system and virtual machines may be:

- dynamic (assigned by Parallels DHCP server running on host-only network);
- static (assigned manually).

Configuring Network with Dynamic IP addresses

IP addresses for machines in a host-only network are provided by Parallels DHCP server that is started automatically when you launch Parallels Workstation. The DHCP server is installed along with Parallels Workstation.

Configure network with dynamic IP addresses in the following way:

1. Open Configuration Editor for the virtual machine and on the Network Adapter Options (on page 131) tab select the Host-only networking option.
2. Choose Preferences from the Edit menu. Specify a range of IP addresses to be assigned to the virtual machines on the Network (page 172) tab.

Configuring Network with Static IP addresses

To configure host-only network with static IP addresses you have to manually assign addresses to the primary operating system and to each virtual machine.

The virtual machine should be configured as follows:

1. Open the Configuration Editor for the virtual machine and on the Network Adapter Options (on page 131) tab select the Host-only networking option.
2. Start the virtual machine and specify the IP address by standard means of the guest operating system.
Configuring a static IP address for the primary operating system:

In Windows primary OS:
1. Open Windows Control Panel, select Network Connections.
2. In the Network Connections window right-click the Parallels Host-Guest Virtual NIC to display its context menu and select Properties from it.
3. In the Parallels Host-Guest Virtual NIC Properties window, in This connection uses the following item list, select Internet Protocol (TCP/IP) and click the Properties button.
4. In the Internet Protocol TCP/IP Properties window select the Use the following IP address option, after that other options in this group become accessible. Specify IP address and Subnet mask for the primary operating system.

In Linux primary OS:
1. Open /usr/lib/Parallels/.dhcpd_configuration file.
2. Settings under "[vnic0]" define Parallels network adapter parameters. Find the string "DHCP=1". This setting means that address for the primary operating system is assigned automatically. To allow using a static IP address change the DHCP setting to 0 instead of 1. Set "DHCP=0" and save the file.
3. Launch the Terminal program and run two following commands:
   /etc/init.d/parallels stop
   and after this
   /etc/init.d/parallels start
4. Specify an IP address for the primary system by means of the Linux version installed on your computer.

Custom Screen Resolutions

Like a physical computer, a virtual machine allows changing screen resolutions. In virtual machine you can set non-standard screen resolutions. Use them if you want the virtual machine's console window to occupy a certain part of the computer's screen.

Procedures of setting custom resolution are different in different guest OSes.

In Windows Guest OSes

Parallels Workstation allows you to define up to 10 different resolutions for a Windows virtual machine and switch between them at runtime. Note that the lowest possible resolution is 800x600.

Adding a Screen Resolution
1. Open the virtual machine configuration you want to add a resolution to, click the button.
2 In the **Configuration Editor**, select **Video** in the **Resource** list.

3 On the **Screen Resolutions** tab (see Video (Screen Resolutions) (page 123)), make sure the **Enable custom screen resolutions** option is selected.

4 Click the Add button \( + \) to open the **Resolution Properties** dialog box.

5 In the **Resolution Properties** dialog box:
   - set the desired resolution options in the **Width, pixels** and **Height, pixels** fields. Note that the width value must be specified in multiples of 8;
   - select **Enabled** if you want this resolution to be available for selection in the guest OS;
   - click **OK**.

6 Click **OK** in the **Configuration Editor**.

7 Click \( \mathbb{S} \) to save the virtual machine's configuration.

### Switching Screen Resolutions at Runtime

To change screen resolution for the running virtual machine:

- Select the resolution from the section in the **View** menu that contains the list of available resolutions.

  or

- Right-click the anywhere in the Windows desktop and from the context menu select **Properties -> Settings**. On the **Settings** tab, you will see all the resolutions for which the **Enabled** option is selected. Select the required one.

### In Linux Guest OSes

To run a Linux virtual machine with a non-standard resolution do the following:

1 Make sure `gxf` is installed in your guest system.

2 In the **Terminal**, generate `xorg.conf modeline` by executing:

   \[
   \texttt{gxf <width> <height> <refresh>}
   \]

   **Note.** Do not set the Refresh value more than 60.
3 Paste output of `gtf` to the `Monitor` section of `xorg.conf`.

4 Insert mode name at the beginning of the modes list. The list is located in the `Display` subsection of the `Screen` section and begins with the "Modes" keyword.

**Note.** Make sure that the "Depth" property of the "Display" subsection equals to the value of "DefaultDepth" defined in the "Screen" section.

5 Restart X Server.
This chapter provides the information on setting user preferences that affect the virtual machines of a particular user or all virtual machines on the computer. The chapter also describes how to clone and delete virtual machines.

In This Chapter

Setting Parallels Workstation Preferences ................................................................. 169
Cloning a Virtual Machine ......................................................................................... 178
Deleting a Virtual Machine ......................................................................................... 181
Using Shared Folders .................................................................................................. 184

Setting Parallels Workstation Preferences

To edit user preferences choose Preferences from the Edit menu.

The preferences on the Memory and Network tabs affect all the users that work on the computer and all the virtual machines. The other preferences may be different for each user.
Common Preferences

Settings on this tab can be different for each user of your computer.

![Preferences window]

### Workspace:
- **Default directory for virtual machines.** Use this field to specify a default folder that Parallels Workstation will use to store the new configuration files and hard disk images. It is possible to choose other location when creating a configuration file or a virtual hard disk.
- Two options, **Load recently used VM at startup** and **Show startup dialog**, define what happens at Parallels Workstation startup. By default, both options are selected. In such a case, the application opens the last used virtual machine configuration at startup. If this configuration is already used by another instance of Parallels Workstation, or the configuration file cannot be found (for instance, it was moved to another folder or deleted), then the **Startup Options** dialog will be open.

  If the **Load recently used VM at startup** option is selected while the **Show startup dialog** option is not selected, Parallels Workstation will open a blank virtual machine when it is unable to open the last used virtual machine.

  If the **Load recently used VM at startup** option is not selected while the **Show startup dialog** is selected, Parallels Workstation always starts with the **Startup Options** dialog.

  If both options are not selected, Parallels Workstation starts with a blank virtual machine.

More information on the Parallels Workstation startup can be found in the Selecting and Opening Virtual Machine (on page 91) and Startup Options Dialog (page 47) topics.
- **Automatically check for updates** option defines a time interval for the auto-update feature. Choose one of the values: *Every day*, *Every week*, or *Every month* to perform automatic check for updates with that periodicity. Choose *Never* to disable the auto-update feature. See also the topics: Auto-Updating Parallels Workstation in Windows (page 34) or Auto-Updating Parallels Workstation in Linux (page 39).

**VM shutdown behaviour**

Choose the action to be performed by default when you close the application by choosing the Exit command from the File menu or by clicking the Windows close button.

- **Suspend VM** - to suspend all running virtual machines.
- **Power Off** - to stop all running virtual machines.
- **Ask me what to do** - to be prompted to choose what to do with the running virtual machines.

See the Suspending/Resuming Virtual Machine (page 95) topic to learn about suspending and resuming virtual machines.

**Memory Preferences**

![Preferences](image)

Reserved memory limit: 96 MB

Reserved memory limit defines a maximum RAM size (i.e., a size of part of host physical memory), which the system should be able to reserve for managing all running virtual machines.

IMPORTANT: When changed, this parameter has an effect for all instances of Parallels Workstation which may run on this computer.
On the Memory tab you can select the maximum amount of physical memory (RAM) the system reserves for all simultaneously running virtual machines on your computer. This value affects all virtual machines running on your computer.

The maximum memory depends on physical RAM your computer has. Some memory must be reserved for the primary operating system. From the remainder you can select the maximum RAM allowed for Parallels virtual machines. If you have only one virtual machine running, it may use all the memory specified here. If you have several virtual machines running simultaneously, this memory will be shared between them. Memory for a specific virtual machine is set on the Memory tab (page 124) in Configuration Editor.

Memory amount must be specified in multiples of 4. To set the value use the slider, the spin buttons in the Reserved memory limit field, or type the value directly into the field.

**Network Preferences**

![Network Preferences](image)
Parallels Workstation provides host-only network accessible only to the primary system and virtual machines running in it. Methods of configuring different types of host-only network are discussed in the Creating Host-Only Network (page 165) topic.

The **Network** tab is intended for specifying a range of IP addresses to be assigned to virtual machines by Parallels DHCP server when configuring host-only network with dynamic IP addresses.

The **Scope start address** and **Scope end address** values define the first and the last IP addresses. DHCP server usually assigns the first address of this scope to itself. The second address is usually given to the primary operating system. Other addresses are assigned to the virtual machines. **Scope start address** and **Scope end address** should belong to the same subnet.

Use the **Scope mask** field to set the subnet mask.

**Note.** Before changing DHCP scope settings make sure that there is no virtual machine running in Host-only networking mode.

To check the networking mode of a running virtual machine:

1. Point to the network adapter icon 🌐 in the status bar.
2. Check the **Mode** line in the tooltip.

**Changing Network Preferences in Linux Primary OS**

To edit settings on this tab in Linux primary OS you need *root* privileges. Users with other than *root* privileges can only view them.

To edit settings on the **Network** tab:

1. In the Terminal, run the command
   ```
   su -c parallels
   ```
   to get *root* privileges. Enter the password to the *root* account when prompted.
2. Start Parallels Workstation by entering the command:
   ```
   parallels
   ```
3. In the Parallels Workstation menu, select **Edit -> Preferences -> Network** and enter new settings on the **Network** tab.
5. In the **Terminal**, run the
   ```
   exit
   ```
   command to exit the *root* account.
6. Start Parallels Workstation and log in the guest OS.
User Interface Preferences

User interface preferences can be different for each user of your computer.

The **User Interface** tab in a Windows primary OS is presented on the picture below:
The **User Interface** tab in a Linux primary OS is presented on the picture below:

![User Interface Tab](image)

### Look and feel

- **Dialog font** option is available in Linux primary OSes only. It allows user to select preferable font, its size and other parameters to be used in system dialogs. Click **Browse** button near the field and choose new font if you wish to. To restore the default font and its size use the **Default font** button.

- **Show tooltips** option is available in Linux primary OSes only. If the option is selected, you will see tooltips appearing when you point the toolbar buttons and the command buttons on the Property Page (see **Property Page** (page 49)). This option is selected by default.

- **Allow to change guest resolution in fullscreen mode**. If this option is selected, a virtual machine switched to full screen mode will use the screen resolution as in the primary OS. Available only when the video driver from Parallels Tools (page 76) is installed in the guest OS.

- **Allow to change host resolution in fullscreen mode**. If this option is selected, resolution of your host monitor is changed to the resolution of the guest OS when a virtual machine is in full screen mode. Note that this option has lower priority than the previous one, so if both are selected, this option affects the resolution only when the **Allow to change guest resolution in fullscreen mode** option can not be applied.

### Help browser

**Note.** This group of options is available only in Linux primary OSes.
- **Help Browser Executable** field shows the path to an executable file of a web browser used to display the online help for Parallels Workstation. By default, help is displayed in Mozilla web browser. If it is not installed on your computer, or you prefer another browser, locate its executable file using the **Browse** button.

**Restore hidden messages:**

- Parallels Workstation informs you about certain operations or situations by displaying appropriate messages. As a rule, a message dialog has message text and the **Do not show this message again** check box. If you select this option, next time when the same situation occurs, the message will not be displayed. The **Restore Hidden Messages** button allows you to reactivate all the suppressed messages.

The system does not allow suppressing messages that report potentially dangerous situations.

**Hot Key Combinations**

Hot key combinations can be different for each user of your computer.
You can define two hot key combinations:

- For releasing the keyboard and mouse input to the primary OS. The default hot key is Ctrl+Alt.
- For switching a guest OS window to full screen mode and back. The default hot key is Alt+Enter.

You can set your own hot key combinations for each case. The key combination must include one or more special keys (Ctrl, Alt and Shift) and an ordinary key.

To define new key combination, do the following:

- Select one or more special keys.
- To add an ordinary key select the Custom option, point to the blank button to the right of the Custom option and press the key on the keyboard.

Some keys and key combinations cannot be used as Parallels Workstation hot keys.

**In Windows primary OS:** The Tab and the Pause keys are not allowed as custom keys.

**In Linux primary OS:** It is not allowed to use the Pause key and the following key combinations (since they are Linux OS hot keys):

- Ctrl+Alt+Backspace
- Ctrl+Alt+ any key in the range of F1-F12, i.e. Ctrl+Alt+F1 - Ctrl+Alt+F12

**Notes.** If you install Parallels Tools, you can release the mouse and the keyboard input to the primary OS without pressing the hot key combination. See the Capturing and Releasing the Keyboard and the Mouse (page 93) topic.
Cloning a Virtual Machine

A copy of a virtual machine can be created using the Clone Virtual Machine Wizard. All files of the virtual machine are copied except the media files used by its CD/DVD-ROM drives and by a floppy disk drive. By default, the Wizard places all the files of the cloned virtual machine into a new folder, but you may choose to save them in another location.

The devices of the cloned virtual machine, such as CD/DVD-ROM and floppy disk drives, are connected to the same drives or image files as the devices in the original machine. However, if the original virtual machine uses output files for serial/parallel ports, in the cloned VM they are replaced by new files.

If the original VM has a network adapter in its configuration, the cloned VM will have a new MAC address generated for its new adapter.

A virtual machine can be cloned if the following conditions are met:

- The guest OS is not running. If it is running, the menu command is disabled.
- The virtual machine is not opened by another instance of Parallels Workstation.
- The virtual machine is not blank. Blank virtual machines can not be copied.

To clone a virtual machine:

1. Open the virtual machine you want to clone.
2. Select Clone VM from the VM menu. The Clone VM Wizard starts. Click Next.
3 In the **Specify new virtual machine name and location** window specify a name for the clone and a location for its configuration file. By default, the wizard adds "Clone of" at the beginning of the original virtual machine's file name. You can specify another name and location. Remember that a virtual machine name must not exceed 50 characters.

Select the **Open virtual machine in new window automatically** option to open the cloned VM in a new Parallels Workstation window when the cloning is complete.

Click **Finish** to start copying the virtual machine.

If the specified destination folder does not exist, you will be prompted to confirm its creation. Click **Yes**. A new folder will be created.
The **Copying in progress** window indicates the current state of the process. When the copying is complete, click **Exit** to close the wizard.

The new virtual machine will be opened in Parallels Workstation, if you have selected this option.
Deleting a Virtual Machine

Virtual machines can be deleted manually, however, we recommend that you use the Delete Virtual Machine Wizard that finds all files of the virtual machine and all files connected to it and deletes them.

The wizard locates the following virtual machine files:

- configuration file,
- virtual hard disk drives connected to the virtual machine,
- ISO images of CD/DVD discs connected to the virtual machine (if any),
- floppy disk images (.fdd) connected to the virtual machine (if any),
- output files of serial and parallel ports (if any),
- folders where virtual machine files are stored.

The wizard can delete an open virtual machine that meets the following conditions:

- Its guest OS is not running. If it is running, the Delete command in the File menu item is disabled.
- The virtual machine is not opened by another instance of Parallels Workstation.
- The virtual machine is not blank.

To delete a virtual machine

1. Open the virtual machine that you want to delete.
2. Select **Delete VM** in **VM** menu. The **Welcome to the Delete Virtual Machine Wizard** window opens. Click **Next**.

The wizard finds all files related to the virtual machine and displays the list of them on the **Review files to be deleted** dialog box. The configuration file, virtual hard disk, output files of serial and parallel ports, and the home folder are pre-selected for deleting. However, `.iso` and `.fdd` images are not listed, because they can be used by other virtual machines. If you want to delete them too, select them for deleting in this dialog box.

**Note.** Make sure you are not going to delete the virtual hard disk that is also used by other virtual machine.
Review the selection and click **Finish**.

![Delete Virtual Machine Wizard](image)

**Review files to be deleted**
Which files associated with virtual machine you want to delete?

Please review file resources to be deleted. Click **Finish** to begin deleting or click **Cancel** to abandon the operation.

<table>
<thead>
<tr>
<th>Type</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD output file</td>
<td>C:\Documents and Settings\Lisa\My Documents</td>
</tr>
<tr>
<td>LPT output file</td>
<td>C:\Documents and Settings\Lisa\My Documents</td>
</tr>
<tr>
<td>FDD image</td>
<td>C:\Program Files\Parallels\vmtools.led</td>
</tr>
<tr>
<td>CD ISO image</td>
<td>C:\Images\Win2003EECorp\Win2003EECorp.iso</td>
</tr>
<tr>
<td>HDD image</td>
<td>C:\Documents and Settings\Lisa\My Documents</td>
</tr>
<tr>
<td>VM Configuration file</td>
<td>C:\Documents and Settings\Lisa\My Documents</td>
</tr>
<tr>
<td>VM home directory</td>
<td>C:\Documents and Settings\Lisa\My Documents</td>
</tr>
</tbody>
</table>

4 The wizard removes the selected files from your hard disk and informs you that the operation was completed successfully.

The virtual machine is considered to be successfully deleted if all the selected components or all selected components except the home folder (if it was chosen for deleting) have been removed. If the home folder contains any files, the folder will not be deleted.
Click **Exit** to close the wizard.

After the virtual machine is deleted, a blank VM is opened in the Parallels Workstation window. The deleted machine is be removed from the list of recently used configurations in the **File** menu.

---

### Using Shared Folders

Shared folders are folders in the primary operating system that are visible to the guest OS too. These folders can be used for exchanging files between the primary OS and a virtual machine or between several virtual machines.

In the primary OS shared folders appear as usual folders, while in the guest OS they are objects of the network neighborhood.

Using shared folders is possible for the following guest OSes:


### Setting Up a Shared Folder

Setting up a shared folder requires two steps:

1. Adding one or more shared folders to the virtual machine configuration.
2. Installing Parallels Tools in the guest OS. The Shared Folders tool is required for viewing the shared folders in the guest OS. See Installing Parallels Tools (page 76).
Adding a Shared Folder

1. Open the virtual machine configuration, click the button to open the Configuration Editor.

2. In the Configuration Editor, select the Shared Folders tab (see the Shared Folders (page 122) topic).

3. Select the Enable shared folders option.

4. Click the button to open the Shared Folder Properties window.

5. In the Shared Folder Properties window:
   - in the Name field specify a name for the folder that will appear in the guest OS;
   - in the Path field specify a folder in the primary OS that will be shared;
   - to prohibit writing to this folder from the guest OS, select the Read Only option. You will be able to save files to this folder in the primary OS only;
   - make sure the Enabled option is selected;
   - and click OK.

6. Click OK in the Configuration Editor.

7. Click to save changes in the virtual machine configuration.

If you have not installed Parallels Tools in the virtual machine, install them now.

Power on your virtual machine and view shared folders in your guest OS.
Viewing Shared Folders in Guest OS

There are two ways to view the contents of the shared folders in the guest OS.

Easy Way

The Shared Folders Options tab in Parallels Tools Center contains the Place shortcut on the desktop option. If it is selected, to view the contents of the shared folders:

- Click the Parallels Shared Folders icon on the desktop of the running guest OS.

General Way

1 In the virtual machine, open Windows Explorer.
2 In Explorer, select My Networks Places, then select Entire Network, and find Parallels Shared Folders.
3 Click Parallels Shared Folders to view the list of shared folders available in your virtual machine.

Note. To be able to write to a shared folder inside a virtual machine, clear the Read Only check box for the folder in Configuration Editor.
Virtual machines can handle several types of image files that are used by virtual devices. These are images of hard disks, CD/DVD discs, and floppy disks. Parallels Workstation package includes a special tool for creating and modifying such images - Parallels Image Tool. This utility is automatically installed along with Parallels Workstation.

This chapter provides all the information necessary to use Parallels Image Tool.

In This Chapter

Overview............................................................................................................................187
Starting Parallels Image Tool.............................................................................................188
Creating an Image of a Real Hard Disk ............................................................................189
Modifying an Existing Hard Disk Image........................................................................193
Creating Images of Floppy Disks....................................................................................203
Creating Images of CD/DVD Discs..................................................................................208

Overview

Parallels Image Tool allows you to:

- create an image of a real hard disk;
- modify existing images of virtual hard disks;
- create ISO images of real CD and DVD discs;
- create images of real floppies.

With Image Tool you can perform the following modifying operations on hard disk images:

- Increase the disk size of a hard disk image.
  Both expanding and plain disks can be enlarged.

  Note. The disk size can not be reduced.

- Convert a plain hard disk image to an image in expanding format.
- Convert an expanding hard disk image to an image in plain format.
- Defragment an expanding hard disk image.

Designed as a wizard, Parallels Image Tool guides you through the steps necessary to create or modify the image. Furthermore, the wizard keeps all your previously selected options between sessions in case you perform the same operation regularly.

Note. If in Linux primary OS some Image Tool options are disabled, that means that you do not possess the proper system privileges.
Starting Parallels Image Tool

To start Parallels Image Tool:

**In Windows primary OS:**

1. Choose **Programs** from the Windows **Start** menu.
2. Choose **Parallels Workstation** from the **Parallels** folder and click **Parallels Image Tool**.

**In Linux primary OS:**

Launch the **Terminal** program and enter the command:

```
imagetool
```

in the command line.
Creating an Image of a Real Hard Disk

Using Parallels Image Tool you can create images of real hard disks. Such images can be used as data disks in virtual machines. Even if the operating system was installed on the real hard disk, the image of this disk cannot be used as a startup disk in the virtual machine. Since the virtual machine hardware is different from the hardware of your physical computer, the operating system may function improperly in the virtual machine.

Note. Blank hard disk and floppy disk images can be created using the Recreate button on the Hard Disk Options and Floppy Options tabs of the Configuration Editor.

After you have created a hard disk image, you can connect it to the virtual machine using Configuration Editor. See Managing Virtual Machines (page 169) for information on working with virtual hard disks. See Adding New Devices to Virtual Machine topic (page 139) in Configuring a Virtual Machine (page 118) to learn how to connect a new hard disk image to the virtual machine or see Hard disk options (page 126) to learn how to replace a currently connected hard disk image with the new one.

Note. Some operating systems may fail to recognize newly added hard disks. If such a problem occurs, try to add the device using the guest operating system utilities.

Physical Computer Hardware Requirements

An image of a real hard disk can be created in plain format only. This means that the disk image will have the same size (slightly greater) as the real disk itself, regardless of how much space on the real disk is actually used. See the Format of The Virtual Disk (page 16) in the Hard Disk Images topic for description of the plain format.

So, to create an image of a real hard disk you must have another real hard disk to store the resulting image file, and the size of the additional hard disk must be at least 5% larger than the size of the original source disk.

To Create an Image of a Real Hard Disk

1. Start Parallels Image Tool.
2. In the Welcome dialog box select the Skip Introduction next time option if you want to skip this dialog box next time you run the Image Tool. Click Next.
3 In the Select device type dialog box select the Hard Disk Drive option and click Next.
4 In the Select operation type dialog box select the Create new Hard Disk image option and click Next.

5 In the Specify source and destination folder dialog box select the physical hard disk in the Source list. Specify the name and location for the hard disk image file in the Destination field.
Using Parallels Image Tool

**Note.** The destination folder for the hard disk image should be located on another physical hard disk.

Click Next.

6 In the Review processing options window carefully review the settings. If everything is correct, click the Start button to create an image of the specified real hard disk.

7 After the disk image has been created, click Exit in the Processing is completed dialog box.

---

### Modifying an Existing Hard Disk Image

The modifying operations can be performed only when the source image file is not in use by any of the running virtual machines.

**Checking the Disk Format**

Before modifying the disk, make sure that you know the format of the disk. The format of the disk can be either plain or expanding.

To check the disk’s format:

1 Open the configuration of any virtual machine that includes this virtual hard disk.
2 In Configuration Editor open the Advanced (page 127) tab of the Hard Disk Options.
3 Disk format is specified in the Disk format field.

To learn more about virtual hard disk formats see Virtual Disk Formats (page 16) topic.

Modifying an Existing Hard Disk Image

1 Start Parallels Image Tool.
2 The Welcome dialog box appears. If you want to skip this dialog box next time you run the Image Tool, select the Skip Introduction next time option. Click Next.
3 In the Select device type dialog box select the Hard Disk Drive option and click Next.
4 In the Select operation type dialog box select the Maintain an existing Hard Disk image option. When you select it, the management operation options appear in the lower part of the dialog box.

Four types of operations are available for virtual disks images:

- Increase size of Hard Disk image
- Convert plain Hard Disk image to expanding Hard Disk image
- Convert expanding Hard Disk image to plain Hard Disk image
- Defragment expanding Hard Disk image

Choose the operation you want to perform and click Next.

Refer to the relevant topic below in this section.
Increasing a Hard Disk Image

You can increase the size of an existing virtual hard disk. You cannot decrease the virtual disk size by using Parallels Image Tool.

The added space will appear on the virtual disk as an unpartitioned space. To use this space you will have to create a new partition or extend the existing partition by means of the guest operating system.

**Note.** The source hard disk image should not be in use by a running virtual machine.

To increase the size of an existing virtual hard disk:

1. Start Parallels Image Tool.
2. In the Welcome dialog box select the Skip Introduction next time option if you want to skip this dialog box next time you run the Image Tool. Click Next.
3. In the **Select device type** dialog box select the **Hard Disk Drive** option and click **Next**.
4. In the **Select operation type** dialog box select the **Maintain an existing Hard Disk image** option. On the **Hard Disk actions** pane in the lower part of the dialog box select the **Increase size of Hard Disk image** option and click **Next**.

![Parallels Image Tool](image-url)
5 In the **Specify source and destination folder** dialog box select the physical hard disk in the **Source** list. You may type the path and the file name. Alternatively, click **Choose**, locate the hard disk image. Specify the new size for the hard disk. You may type a new size in the **Image Size** field or use the arrows to set the desired value. Click **Next**.

6 In the **Review processing options** dialog box carefully review the settings. If everything is correct, click the **Start** button to increase the size of the disk.

7 After the disk size has been increased, click **Exit** in the **Processing is completed** dialog box.

**Converting a Plain Disk into an Expanding Disk**

You can convert a plain virtual disk into an expanding one or create an expanding copy of a plain virtual hard disk.

To convert a plain disk image into an expanding one:

1 Start Parallels Image Tool.

2 In the Welcome dialog box select the Skip Introduction next time option if you want to skip this dialog box next time you run the Image Tool. Click Next.

3 In the **Select device type** dialog box select the **Hard Disk Drive** option and click **Next**.
4. In the Select operation type dialog box select the Maintain an existing Hard Disk image option. On the Hard Disk actions pane in the lower part of the dialog box select Convert plain Hard Disk image to expanding Hard Disk image and click Next.

5. In the Specify source and destination folder dialog box select the hard disk in the Source list. You may type the path and the file name. Alternatively, click Choose, locate and select the hard disk image.
Specify the name and location for the expanding copy of the hard disk image file in the Destination field. Click Next.

6 In the Review processing options dialog box carefully review the settings. If everything is correct click the Start button to convert the hard disk.

7 After the disk image has been converted, click Exit in the Processing is completed dialog box.

Converting an Expanding Disk into a Plain Disk

You can convert an expanding virtual disk into a plain one or create a plain copy of an expanding virtual hard disk.

To convert an expanding disk into a plain one:

1 Start Parallels Image Tool.

2 In the Welcome dialog box select the Skip Introduction next time option if you want to skip this dialog box next time you run the Image Tool. Click Next.

3 In the Select device type dialog box select the Hard Disk Drive option and click Next.
4 In the Select operation type dialog box select the Maintain an existing Hard Disk image option. On the Hard Disk actions pane in the lower part of the dialog select Convert expanding Hard Disk image to plain Hard Disk image and click Next.

5 In the Specify source and destination folder dialog box select the expanding hard disk in the Source list. You may type the path and the file name. Alternatively, click Choose, locate and select the expanding hard disk image.
Specify the name and location for the plain copy of the hard disk image file in the Destination field. Click Next.

6 In the Review processing options dialog box carefully review the settings. If everything is correct click the Start button to convert the hard disk.

7 After the disk image has been converted, click Exit in the Processing is completed dialog box.

**Defragmenting an Expanding Disk**

To optimize the file arrangement on an expanding virtual disk and to increase its speed you can defragment the disk.

To defragment an expanding hard disk image:

1 Start Parallels Image Tool.

2 In the Welcome dialog box select the Skip Introduction next time option if you want to skip this dialog box next time you run the Image Tool. Click Next.

3 In the Select device type dialog box select the Hard Disk Drive option and click Next.
4 In the Select operation type dialog box select the **Maintain an existing Hard Disk image** option. In the Hard Disk actions section in the lower part of the dialog box select **Defragment expanding Hard Disk image** and click **Next**.
5 In the **Specify source and destination folder** dialog box select the expanding hard disk in the **Source** field. You may type the path and the file name. Alternatively, click **Browse**, locate and select the expanding hard disk image. Click **Next**.

![Parallels Image Tool](image)

6 In the **Review processing options** dialog box carefully review the settings. If everything is correct, click the **Start** button to defragment the hard disk.

7 After the disk image has been defragmented, click **Exit** in the **Processing is completed** dialog box.

---

**Creating Images of Floppy Disks**

To create a floppy disk image follow these steps:

1 Insert the required floppy disk into the floppy disk drive of your computer.
2 Start Parallels Image Tool.
3 In the Welcome dialog box select Skip Introduction next time if you want to skip this dialog box next time you run the Image Tool. Click Next.
4 In the Select device type dialog box select the Floppy Disk Drive option and click Next.
5 In the Select Operation Type dialog box make sure that the Create new Floppy Disk image option is selected. Click Next.
6 In the Specify source and destination dialog box select the source device (the floppy disk drive), and specify the destination folder and the name for the output floppy disk image file. You may type the path and the file name or locate it using the Browse button. Click Next.
In the Review processing options dialog box carefully review the settings. If everything is correct, click the Start button to create the floppy disk image file.

While the operation is being performed, the Execution in progress dialog box is displayed. After the floppy disk image has been created, click Exit in the Processing is completed dialog box.

To learn how to connect a floppy disk image to the floppy drive of the virtual machine see the Floppy Options (on page 125) topic.

Creating Images of CD/DVD Discs

To create an image of a CD/DVD disc as an ISO file follow these steps:

1. Insert the disc into the CD/DVD-ROM drive of your computer.
2. Start Parallels Image Tool.
3. In the Welcome dialog box select Skip Introduction next time if you want to skip this dialog box next time you run the Image Tool. Click Next.
4 In the **Select Device Type** dialog box select the **CD/DVD-ROM Drive** option and click **Next**.
5 In the **Select Operation Type** dialog box make sure that the **Create new ISO image of CD/DVD** option is selected. Click **Next**.
6 On the **Specify source and destination** dialog box select the source device (the CD/DVD-ROM drive), and specify the destination folder and the name for the output disc image file. You may use the default name and location, type the path and the file name directly into the field, or use the **Browse** button to specify another location. Click **Next**.

![Specify source and destination dialog box](image)

7 In the **Review processing options** dialog box carefully review the settings. If everything is correct, click the **Start** button to create a CD/DVD disc image.

8 While the operation is being performed, the **Execution in progress** dialog box is displayed.
9 After the disk image has been created, click Exit in the **Processing is completed** dialog box.

To learn how to connect an .iso image to the CD/DVD-ROM drive of the virtual machine see the CD/DVD-ROM Options (page 129) topic.
CHAPTER 14
Troubleshooting and Limitations

In This Chapter

Getting Technical Support ........................................................................................................ 213
Reporting a Problem to Parallels Team .................................................................................. 214
Problems with Networking Inside a Virtual Machine .......................................................... 216
Installing Ubuntu Linux 6.0.6 Server .................................................................................. 216
Problem with Connecting USB Devices in Linux Primary OS ............................................ 217
Configuring Display for Full Screen Mode .......................................................................... 218
Third-Party Virtual Machines and Parallels Network Adapter ......................................... 219
Problem with Printing ........................................................................................................... 219
SoftICE Keyboard Problem ................................................................................................. 220
Initializing Swap File Problem ............................................................................................. 220

Getting Technical Support

If you have problems using Parallels Workstation, please first view Parallels Workstation FAQs (http://www.parallels.com/products/workstation/faq/)

Our friendly technical support team is ready to help. Describe your problem and submit a FREE request to Parallels Support Team (www.parallels.com/en/support/).

To discuss your problem online, visit Parallels Forums (http://forums.parallels.com/).

Telephone support is available on a per incident fee basis. Please visit the support team's page of the Parallels web site for details.
To help improve the quality of Parallels Workstation, you may send problem reports to Parallels Software International Inc. In the case of a fatal error inside a virtual machine, Parallels Workstation automatically opens the Report a Problem window prompting the user to send a report. You may also send a report on your own if you notice incorrect virtual machine behavior.

Automatically Generated Reports

When a fatal error occurs in a virtual machine, Parallels Workstation automatically generates a virtual machine status report and attaches a console screen shot to it. After that, the Report a Problem window opens, and you can fill out the form and send the report to Parallels Software International, Inc. The Report a Problem window contains the following elements.
The Technical data field shows the name of the .txt status report file that has been generated for the error. The status report holds information on the product version or build number, product activation data, the primary and guest OSes information, processor status, and so on. You can edit the data if necessary. Click View to open the report in the text editor.

The Session screenshot field holds the name of the .jpg file of console screen shot created at the moment the error occurred. To view the screen shot click the View button.

You may add a short description of the error situation in the Problem description box (the description will be added to the report text file when you click the OK button).

The names of status report and screen shot files have the following format (the same in Windows and Linux operating systems):

```
parallels-yyyy.mm.dd-hh.mm.ss.<txt/jpg>
```

**To send the report to the Parallels Team**

**In Windows primary OS:**

1. To send a report to Parallels, select the Send report to reports@parallels.com option and click OK. This command closes the Report a problem window and opens the default e-mail client application.

2. Create a new letter.

3. Attach two files to it: status report and the session screen shot.

   The status report and the screen shot are saved in the Bugreports folder in the Parallels Workstation folder. By default, it is

   `C:\Program Files\Parallels\Parallels Workstation\Bugreports`.

   **Note.** On Vista primary OS, the default Bugreports folder is located at `C:\Users\<User_Name>\AppData\Local\VirtualStore\Program Files\Parallels\Parallels Workstation\BugReports`.

If you decide not to send a report, clear the Send report to reports@parallels.com check box and click OK.

**In Linux primary OS:**

1. To send a report to Parallels, select the Send report to reports@parallels.com option and click OK.

2. Then start your e-mail client application, open a new email and attach both the status report and the console screen shot to it. The files can be found in the following folder:

   `/usr/lib/parallels/bugreports/`

3. Specify the following e-mail address for the letter:

   `reports@parallels.com`
Creating a report manually

If you notice an unusual virtual machine behavior, create a problem report. For this, select Report a Problem in the Help menu. Parallels Workstation generates a report which contains technical data collected at the moment when the Report a problem command was called. If a guest OS was running at the moment, a screen shot of the guest OS window was created.

Problems with Networking Inside a Virtual Machine

If you encounter any problem with networking inside a virtual machine, varying from inability to access the Internet to host-only network configuring failure, we recommend that you check your primary OS firewall settings. The primary OS firewall may affect Parallels Host-Guest Virtual NIC (page 165) network adapter thus preventing host-only network functioning. It also may interfere with Bridged Ethernet networking.

Installing Ubuntu Linux 6.0.6 Server

Ubuntu Linux 6.0.6 Server when installed in a virtual machine in a standard way can not load the default kernel. You have to perform some additional steps after the guest OS installation is complete.

Perform an initial installation of Ubuntu Linux 6.0.6 Server in a virtual machine, follow these steps:

1. With New Virtual Machine Wizard create a typical virtual machine with Linux as the OS Type and Other Linux Kernel 2.6 or Debian Linux as the OS Version.
2. Insert the installation CD/DVD in the default CD/DVD-ROM drive, or connect its image to the virtual machine.
3. Install the Ubuntu Linux 6.0.6 Server. Do not disconnect the installation CD/DVD or its' image!
4. Shut down the virtual machine.

Additional steps include the following:

1. In Configuration Editor on the Options -> Booting Options tab, set the boot sequence to [CD-ROM, Hard Disk, Floppy]. On the Network Adapter Options tab set the adapter to the Bridged Ethernet mode. Click OK to close Configuration Editor. Save the changes in configuration.
2. Start up the Ubuntu virtual machine. It will boot from the CD/DVD or its image. At the prompt enter the following command:

   ```
   rescue
   ```

   Select language of communication, enter host name to configure network when prompted. Wait until kernel components are loading...
3 In the **Enter rescue mode** dialog select the option: `/dev/discs/disco/part1` (root file system). In case you used for disk partitioning and formatting other than default options, select an option for the partition with root file system.

4 Then on the same dialog, select the option: **execute a shell in** `/dev/discs/disco/part1`. When prompted, click **Continue** to confirm the operation.

5 At the shell prompt enter the following command:

```
arpm install linux-686
```

6 Wait while 686 kernel is being installed. When it is finished, to exit the shell prompt enter the following command:

```
exit
```

7 In the **Enter rescue mode** dialog select the option: **reboot the system** and stop the virtual machine.

8 Disconnect the installation CD/DVD from your virtual machine. Open Configuration Editor and set the boot sequence to [Hard Disk, CD-ROM, Floppy] to let the virtual machine to boot from the virtual hard disk.

9 Start the virtual machine. After booting is complete, log in Ubuntu Linux 6.0.6 Server.

---

**Problem with Connecting USB Devices in Linux Primary OS**

If you receive the "Unable to connect USB device" message while trying to connect an USB device to your virtual machine on a computer running Linux primary OS, the most probable cause is that you do not have permissions to access USB devices. To fix the problem:

1 Check if an usb-operating group exists in your Linux primary OS.

2 If the group exists:
   - In the **Terminal**, issue the command
     
     ```
su
     ```
     
     to gain root privileges. Enter the password to the root account when prompted.
   - Include into the usb-operating group users who have to have an access to USB devices.
   - Run the
     
     ```
exit
     ```
     
     command to leave the root account.
   - Proceed to step 4.

3 If the group does not exist:
   - In the **Terminal**, enter the command
     
     ```
su
     ```
     
     to gain root privileges.
   - Create a group and add users who will have an access to USB devices.
   - In the `/etc/fstab` file edit the string that mounts the usbfs. The Devgid parameter must contain the identifier of the group created in the previous step.
This option works only the compiled kernel has relevant support for USB.

- Run the `exit` command to leave the root account.

4 Restart your Linux primary OS.

---

**Configuring Display for Full Screen Mode**

If you receive a poor picture or incorrect system behavior when switching a guest operating system to full screen mode, this can be fixed by configuring your primary OS settings.

**Windows primary OS:**

When guest OS is running in full screen mode, physical display is switched to guest OS resolution with the highest possible frequency. If your physical video card or physical monitor do not support the resolution or frequency requested by the guest OS, substitute video mode that matches best is set instead. In some cases substitute mode may not work, or you are warned of an inability to switch to full screen mode. To fix the situation, correct primary OS display settings:

1. Open **Display Properties** window by selecting in Windows Start menu the Settings/Control Panel/Display. Make sure that the Hide modes that this monitor cannot display option is selected in the Setting tab. If not, select it and apply the settings.

2. If the option in the previous item is selected but problem remains, make sure that the proper monitor and video card drivers are installed in the primary system. Reinstall them in case of necessity.

**Linux primary OS:**

When a guest OS is running in full screen mode, the physical display is switched to guest OS resolution with the highest possible frequency. If X Window System is not configured for the mode requested by the guest OS, any available mode that matches best will be used instead. The situation is worse if the physical monitor does not support the requested mode while it is configured in X Window System. Parallels Workstation can not know that the monitor does not support the requested mode and will try to switch to it. This may lead to poor picture quality in full screen mode.

If display picture in full screen mode is unusable:

1. Stop the guest OS,

2. Reconfigure X Window System to exclude resolution/frequency inconsistent with your monitor, and restart X Window.
Third-Party Virtual Machines and Parallels Network Adapter

If you have installed on your computer any virtual machine software from other vendors along with Parallels Workstation, there may be problems with a network adapter in a third-party virtual machine. Third-party virtual software may try to use Parallels virtual network adapter, Parallels Host-Guest Virtual NIC, as a real network interface and connect a third-party VM's network adapter to it. This problem is more probable if the third-party virtual machine is configured to choose a network adapter automatically. The problem occurs because Parallels Workstation adds Parallels Host-Guest Virtual NIC network adapter to the list of network adapters in the primary operating system during the installation process. This adapter is required for host-only network (page 165).

If such problem occurs, you will receive an error message when trying to access the Internet from the third-party virtual machine. To solve the problem:

- Open this virtual machine configuration and select one of physical network adapters.

Problem with Printing

If you have a physical printer connected to an LPT port of your computer but can not print from the primary operating system and/or several virtual machines please make sure the printer is properly connected and configured.

If nevertheless, you cannot print, this may be caused by the following reason: the running virtual machine's parallel port is connected to a real LPT port which becomes blocked and cannot be accessed by the primary operating system and other virtual machines.

To solve the problem:

- find a virtual machine from which you can print,
- disconnect its parallel port connected to the real LPT port. See Connecting Serial/Parallel Port (page 102).

Documents that were sent for printing in the primary OS or other virtual machines while the printer was unavailable were spooled, and will be printed in the same order they were sent to the printer. If you run several virtual machines connected to the printer through the same physical LPT port, you may be required to consequently disconnect their parallel ports to print all the documents.
SoftICE Keyboard Problem

If you run Parallels Workstation simultaneously with Compuware SoftICE debugger from Compuware Driver Studio, keyboard problems may arise. Problems usually occur when you start SoftICE from the Windows command line while Parallels Workstation is already running.

Note. Since SoftICE is a Windows application this problem may occur in Windows primary OS only.

To fix the problem:

1. Open SoftICE Settings, select the Troubleshooting option. Choose the Do not patch keyboard driver option.
2. Restart your computer.

Initializing Swap File Problem

If you receive the "Unable to initialize swap file" message when starting a virtual machine, this may be a sign that the virtual machine requires more memory that specified in its configuration re is no more free space on the volume where the virtual machine configuration is stored.

1. Do one of the following:
   - In the Property Page, click the Memory link and decrease the amount of memory used by the virtual machine.
   - Locate the folder where the files of the virtual machine are stored and move the folder to a local hard disk which has enough free disk space.
2. Try to start the virtual machine again.
Index

A
AC’97 sound driver • 12, 81
Activating program • 26, 29
Adding
  custom screen resolution • 166
  devices • 139
  hard disks • 139
  network adapter • 139, 164
  parallel port • 102
  serial port • 102
Address
  IP • 165, 172
  MAC • 131
  MAC in a cloned virtual machine • 178
Automatic starting of virtual machine • 121
Automatic update check • 26, 33, 38
B
Boot sequence
  changing boot sequence • 73, 120
  setting boot sequence • 120
Bridged Ethernet networking • 165
Browser for displaying help in Linux primary OS • 174
C
Capturing keyboard and mouse • 93
CD/DVD images
  CD/DVD images used by virtual machine • 17
  creating images of CD/DVD discs • 208
CD/DVD-ROM drive
  connecting CD/DVD-ROM • 100
  options • 129
Changing
  boot sequence changing • 73, 120
  configuration at runtime • 98
  media • 98
  screen resolution (Linux) • 167
  screen resolution (Windows) • 166
  toolbar position • 54
Clipboard synchronization between primary OS and guest OS • 77, 105
Cloning a virtual machine • 178
Compacting virtual hard disks • 110, 113
Configuration Editor • 118
Configuration of a virtual machine
  creating virtual machine's configuration • 59
  definition • 15
  editing • 118
  connecting CD/DVD-ROM • 100
  CD/DVD-ROM drive connecting • 100
  floppy drive connecting • 100
  microphone (USB) • 103
  Network adapter • 101
  parallel port • 102
  serial port • 102
  sound device • 102
Converting
  expanding disk into plain disk • 199
  plain disk into expanding • 197
CPU
  emulated in virtual machine • 12
  required on host computer • 18
Creating
  a virtual machine • 59
  custom screen resolutions • 166
  custom virtual machine • 65
  images of CD/DVD discs • 208
  new virtual hard disks • 16
  typical virtual machine • 63
  virtual hard disks • 126
Custom virtual machines • 59, 65
D
Default folder • 170
Default key combinations • 176
Defragment an expanding hard disk image • 193
Defragmenting expanding disks • 201
Deleting virtual machines • 181
Devices
  adding to virtual machine • 139
  boot sequence • 120
  configuring in virtual machine • 118
  connecting and disconnecting in a running virtual machine • 98
  emulated in virtual machine • 12
DHCP server • 165, 172
Directory
capturing • 93
releasing • 93
shortcuts • 97

L
Linux
  changing resolution in Linux • 167
  printing in Linux • 115
  supported versions • 13
  updating Parallels Workstation (Linux) • 38
Local Area Network accessing • 165

M
MAC address
  in cloned virtual machine • 178
  in virtual machine • 131
Maintaining virtual hard disks • 114
Making screen shots • 58
Media, changing • 98
Memory
  in virtual machine • 124
  limit for all virtual machines • 171
Memory allocation • 171
Memory tab • 171
Microphone (USB), connecting • 103
Microsoft Windows, supported versions • 13
Mouse
  capturing • 93
  releasing • 93
  synchronization between primary OS and guest OS • 77, 108
Mouse Synchronization Tool • 108
MS-DOS, supported • 13

N
Named pipe • 133
Network adapter • 101
  adding network adapter • 139
  connecting network adapter • 101
  disconnecting network adapter • 101
  Host-Guest Virtual NIC • 165, 219
  in virtual machine • 131
  network adapter options • 131
  removing network adapter • 164
Network driver, Parallels Tools • 77
Network printer • 115
Network tab • 172
Networking
  Bridged Ethernet • 165
  host-only • 165

O
Opening
  Configuration Editor opening • 53
  virtual machine opening • 91
Operating system
  installing in Virtual Machine • 72
  primary OS • 10
  supported guest OSes • 13
  supported Linux primary OSes • 19
  supported Windows primary OSes • 19
OS Window mode • 96
OS/2
  network driver (eComStation) • 85
  Parallels Tools installation (OS/2) • 85
  sound driver (OS/2 and eComStation) • 85
  supported versions • 13
Overview
  Parallels Image Tool overview • 187
  Parallels Tools overview • 77
  Virtual Machine technology overview • 10

P
PAE • 19, 91
Parallel ports
  parallel port • 102
  parallel port options • 134
  Parallels Image Tool • 187
Parallels Tools
  Parallels Tools Center • 104
  Parallels Tools overview • 77
  updating Parallels Tools • 86
Parallels Workstation
  activating (in Linux) • 29
  activating (in Windows) • 26
  installing (in Linux) • 27
  installing (in Windows) • 20
  starting (in Linux) • 29
  starting (in Windows) • 26
  uninstalling (in Linux) • 32
  uninstalling (in Windows) • 27
  updating • 33
Parallels Workstation preferences
  Booting Options • 120
  CD/DVD-ROM Options • 129
  floppy options • 125
  General options • 119
  hard disk options • 126
  memory options • 124
  network adapter options • 131
  parallel port options • 134
  serial port options • 133
  sound options • 136
  USB Options • 138
  video (screen resolutions) • 123
Pausing virtual machines • 95
Pipe • 133
Plain disks • 16
Preferences for Parallels Workstation • 169
Primary operating system
  supported (Linux) • 19
  supported (Windows) • 19
Printer, connecting to virtual machine • 115
Process priorities in Windows primary OS • 121
Processor
  emulated in Virtual Machine • 12
  required on host computer • 18
PVS • 15

R
RAM
  in virtual machine • 124
  limit for all the virtual machines • 171
  RAM options • 124
Reducing disk size • 113
Releasing keyboard and mouse • 93
Removing devices • 164
Resetting virtual machine • 94
Resolution changing
  in Linux OS • 167
  in Windows OS • 166
Restarting Parallels Tools Center • 104
Restore hidden messages • 174
Resuming virtual machines • 95
Running virtual machines • 89
Runtime, changing at • 98

S
SAV • 15, 95
Screen resolutions • 166
Screen shots
  for bug reports • 214
  of guest operating system screen • 58
Serial ports
  adding a serial port • 139
  connecting a serial port • 102
  serial port options • 133
Setting preferences • 118
Shared folders
  setting up a shared folder • 184
  shared folders options • 122
  Shared Folders tool • 77
  using shared folders • 184
  viewing in guest OS • 186
sharing files • 122
Shut down virtual machine • 94
Socket • 133
Solaris network driver installation • 83
Sound devices
  connecting a sound device • 102
  disconnecting a sound device • 102
Sound driver
  AC’97 sound driver • 12, 81
  installing sound driver (in OS/2 and eComStation) • 85
  installing sound driver (in Windows 98) • 80
  installing sound driver (in Windows NT) • 81
sound options • 136
Starting Virtual Machine • 91
Startup options • 47, 170
Status bar
  connecting devices in a running Virtual Machine • 98
  general description • 54
  hiding of • 46
Sun Solaris, supported versions • 13
Supported guest operating systems • 13
Suspending virtual machines • 95
Switching to
  Full screen • 96
  OS Window mode • 96
System requirements • 18

T
Technical support • 213
Time Synchronisation tool • 77, 106
Toolbar
  buttons • 51, 91, 94, 96
  changing position of • 54
  general description • 46
  hiding of • 46
Toolips for buttons in Linux primary OS • 174
Troubleshooting • 213
  when installing Tools • 79
Turning off virtual machine • 94
Typical virtual machines • 59, 63

U
Uninstalling Parallels Workstation
  in Linux primary operating system • 32
  in Windows primary operating system • 27
Updating Parallels Workstation • 33
  in Linux primary operating system • 38
  in Windows primary operating system • 33
USB devices
  connecting USB devices • 103
  setting up a USB printer • 117
  USB Options • 138
  using USB devices • 164
USB printers • 117
V
Video driver • 77, 107
Virtual hard disk
  compacting • 113
  converting expanding virtual hard disk into plain • 199
  converting plain virtual hard disk into expanding • 197
  creating a blank virtual hard disk • 126
  creating an image of a real hard disk • 189
  defragmenting an expanding virtual hard disk • 201
  expanding virtual hard disk • 16
  file type and format of a virtual hard disk • 16
  hard disk in virtual machine • 126
  increasing the size of a virtual hard disk • 196
  plain virtual hard disk • 16
Virtual machine • 15
  adding new devices • 139
  configuration • 15
  creating custom configuration • 59, 65
  creating typical configuration • 59, 63
  editing options of current devices • 118
  folder for storing • 65, 170
  pausing • 95
  resetting • 94
  running • 89
  shutting down • 94
  starting • 91
  virtual machine opening • 91
Virtual Machine technology overview • 10
VT-x • 11
W
Window mode of the guest OS screen • 96
Windows
  changing resolution • 166
  installing Parallels Tools in • 79
  setting up a network printer in • 115
  supported versions • 13
  uninstalling Parallels Tools • 87
Windows 98
  sound driver installation • 80
Windows NT
  Tools installation in • 81
Wizard
Add new hardware • 139
Clone virtual machine • 178
Delete virtual machine • 181
New virtual machine • 59
X
X Window System in FreeBSD • 75, 218